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Section 1
Notice
MICROSOFT SOFTWARE LICENSE TERMS 
WINDOWS 10 IOT ENTERPRISE & MOBILE (ALL EDITIONS)

Last updated July 2016
IF YOU LIVE IN (OR IF YOUR PRINCIPAL PLACE OF BUSINESS IS IN) THE 

UNITED STATES, PLEASE READ THE BINDING ARBITRATION CLAUSE 

AND CLASS ACTION WAIVER IN SECTION 9. IT AFFECTS HOW DISPUTES 

ARE RESOLVED.

Thank you for choosing Microsoft! 

Depending on how you obtained the Windows software, this is a license 
agreement between (i) you and the device manufacturer or software installer that 
distributes the software with your device; or (ii) you and Microsoft Corporation 
(or, based on where you live or if a business where your principal place of 
business is located, one of its affiliates) if you acquired the software from a 
retailer. Microsoft is the device manufacturer for devices produced by Microsoft 
or one of its affiliates, and Microsoft is the retailer if you acquired the software 
directly from Microsoft. 
This agreement describes your rights and the conditions upon which you may 
use the Windows software. You should review the entire agreement, including 
any supplemental license terms that accompany the software and any linked 
terms, because all of the terms are important and together create this agreement 
that applies to you. You can review linked terms by pasting the (aka.ms/) link 
into a browser window.
By accepting this agreement or using the software, you agree to all of 

these terms, and consent to the transmission of certain information during 

activation and during your use of the software as per the privacy statement 

described in Section 3. If you do not accept and comply with these terms, 

you may not use the software or its features. You may contact the device 
manufacturer or installer, or your retailer if you purchased the software directly, 
to determine its return policy and return the software or device for a refund or 
credit under that policy. You must comply with that policy, which might require 
you to return the software with the entire device on which the software is 
installed for a refund or credit, if any.
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1.	 Overview.

a.	 Applicability. This agreement applies to the Windows software that is 
preinstalled on your device, or acquired from a retailer and installed by 
you, the media on which you received the software (if any), any fonts, 
icons, images or sound files included with the software, and also any 
Microsoft updates, upgrades, supplements or services for the software, 
unless other terms come with them. It also applies to Windows apps 
developed by Microsoft that provide functionality such as mail, calendar, 
contacts, music and news that are included with and are a part of 
Windows. If this agreement contains terms regarding a feature or service 
not available on your device, then those terms do not apply. 

b.	 Additional terms. Depending on your device’s capabilities, how it is 
configured, and how you use it, additional Microsoft and third party 
terms may apply to your use of certain features, services and apps. 

(i)	� Some Windows apps provide an access point to, or rely on, online 
services, and the use of those services is sometimes governed by 
separate terms and privacy policies, such as the Microsoft Services 
Agreement at (aka.ms/msa). You can view these terms and policies 
by looking at the service terms of use or the app’s settings, as 
applicable; please read them. The services may not be available in all 
regions. 

(ii)	  �The manufacturer or installer may also preinstall apps, which will 
be subject to separate license terms.

(iii)	  �The software may include third party software such as Adobe Flash 
Player that is licensed under its own terms. You agree that your use 
of Adobe Flash Player is governed by the license terms for Adobe 
Systems Incorporated at (aka.ms/adobeflash). Adobe and Flash 
are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and/or other countries.

(iv)	  �The software may include third party programs that are licensed to 
you under this agreement, or under their own terms. License terms, 
notices and acknowledgements, if any, for the third party program 
can be view at (aka.ms/thirdpartynotices). 

2.	 Installation and Use Rights.

a.	 License. The software license is permanently assigned to the device with 
which you acquired the software. You many only use the software on that 
device.

b.	 Device. In this agreement, “device” means a physical hardware system) 
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with an internal storage device capable of running the software. A 
hardware partition or blade is considered to be a device. 

c.	 Restrictions. The manufacturer or installer and Microsoft reserve all 
rights (such as rights under intellectual property laws) not expressly 
granted in this agreement. For example, this license does not give you any 
right to, and you may not: 

(i) 	� use or virtualize features of the software separately; 

(ii) 	� publish, copy (other than the permitted backup copy), rent, lease, or 
lend the software; 

(iii) 	� transfer the software (except as permitted by this agreement); 

(iv) 	� work around any technical restrictions or limitations in the software; 

(v) 	� use the software as server software, for commercial hosting, make 
the software available for simultaneous use by multiple users over a 
network, install the software on a server and allow users to access it 
remotely, or install the software on a device for use only by remote 
users; 

(vi) 	� reverse engineer, decompile, or disassemble the software, or attempt 
to do so, except and only to the extent that the foregoing restriction 
is (a) permitted by applicable law; (b) permitted by licensing terms 
governing the use of open source components that may be included 
with the software; or (c) required to debug changes to any libraries 
licensed under the GNU Lesser General Public License which are 
included with and linked to by the software; and

(vii)	  �when using Internet-based features you may not use those features 
in any way that could interfere with anyone else’s use of them, or to 
try to gain access to or use any service, data, account, or network, in 
an unauthorized manner.

d.	 Multi use scenarios. 

(i)	� Multiple versions. If when acquiring the software, you were 
provided with multiple versions (such as 32-bit and 64-bit versions), 
you may install and activate only one of those versions at a time.

(ii) 	� Multiple or pooled connections. Hardware or software you use to 
multiplex or pool connections, or reduce the number of devices or 
users that access or use the software, does not reduce the number of 
licenses you need. You may only use such hardware or software if 
you have a license for each instance of the software you are using.

(iii)	  �Device connections. You may allow up to 20 other devices to 
access the software installed on the licensed device for the purpose 
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of using the following software features: file services, print services, 
Internet information services, and Internet connection sharing 
and telephony services on the licensed device. The 20 connection 
limit applies to devices that access the software indirectly 
through “multiplexing” or other software or hardware that pools 
connections. You may allow any number of devices to access the 
software on the licensed device to synchronize data between 
devices. This section does not mean, however, that you have the 
right to install the software, or use the primary function of the 
software (other than the features listed in this section), on any of 
these other devices.

(iv)	 �Remote access. Users may access the licensed device from another 
device using remote access technologies, but only on devices 
separately licensed to run the same or higher edition of this software.

(v)	 �Remote assistance. You may use remote assistance technologies to 
share an active session without obtaining any additional licenses for 
the software. Remote assistance allows one user to connect directly 
to another user’s computer, usually to correct problems.

(vi)	  �POS application. If the software is installed on a retail point of 
service device, you may use the software with a point of service 
application (“POS Application”). A POS Application is a software 
application which provides only the following functions: (i) process 
sales and service transactions, scan and track inventory, record and/
or transmit customer information, and perform related management 
functions, and/or (ii) provide information directly and indirectly 
to customers about available products and services. You may use 
other programs with the software as long as the other programs: (i) 
directly support the manufacturer’s specific use for the device, or 
(ii) provide system utilities, resource management, or anti-virus or 
similar protection. For clarification purposes, an automated teller 
machine (“ATM”) is not a retail point of service device. 

(vii) 	�Cloud Computing Devices. If your device uses Internet browsing 
functionality to connect to and access cloud hosted applications: 
(i) no desktop functions may run locally on the device, and (ii) any 
files that result from the use of the desktop functions may not be 
permanently stored on the system. “Desktop functions,” as used 
in this agreement, means a consumer or business task or process 
performed by a computer or computing device. This includes but 
is not limited to email, word processing, spreadsheets, database, 
scheduling, network or internet browsing and personal finance.

(viii)	�Desktop Functions. If your system performs desktop functions, 
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then you must ensure that they: (i)    are only used to support the 
application, and (ii) operate only when used with the application.

e.	 Specific Use. The manufacturer designed the licensed device for a 
specific use. You may only use the software for that use.

f.	 Backup copy. You may make a single copy of the software for backup 
purposes, and may also use that backup copy to transfer the software if it 
was acquired as stand-alone software, as described below. 

3.	 Privacy; Consent to Use of Data. Your privacy is important to us. Some of 
the software features send or receive information when using those features. 
Many of these features can be switched off in the user interface, or you can 
choose not to use them. By accepting this agreement and using the software 
you agree that Microsoft may collect, use, and disclose the information as 
described in the Microsoft Privacy Statement available at (aka.ms/privacy), 
and as may be described in the user interface associated with the software 
features.

4.	 Transfer  

a.	 Software preinstalled on device. If you acquired the software 
preinstalled on a device, you may transfer the license to use the software 
directly to another user, only with the licensed device. The transfer 
must include the software and, if provided with the device, an authentic 
Windows label including the product key. Before any permitted transfer, 
the other party must agree that this agreement applies to the transfer and 
use of the software.

b.	 Stand-alone software. If you acquired the software as stand-alone 
software, you may transfer the software to another device that belongs to 
you. You may also transfer the software to a device owned by someone 
else if (i) you are the first licensed user of the software and (ii) the new 
user agrees to the terms of this agreement. You may use the backup copy 
we allow you to make or the media that the software came on to transfer 
the software. Every time you transfer the software to a new device, you 
must remove the software from the prior device. You may not transfer the 
software to share licenses between devices. 

5.	 Authorized Software and Activation. You are authorized to use this software 
only if you are properly licensed and the software has been properly activated 
with a genuine product key or by other authorized method. When you connect 
to the Internet while using the software, the software will automatically 
contact Microsoft or its affiliate to confirm the software is genuine and the 
license is associated with the licensed device. You can also activate the 
software manually by Internet or telephone. In either case, transmission 
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of certain information will occur, and Internet, telephone and SMS service 
charges may apply. During activation (or reactivation that may be triggered 
by changes to your device’s components), the software may determine that 
the installed instance of the software is counterfeit, improperly licensed or 
includes unauthorized changes. If activation fails the software will attempt 
to repair itself by replacing any tampered Microsoft software with genuine 
Microsoft software. You may also receive reminders to obtain a proper license 
for the software. Successful activation does not confirm that the software is 
genuine or properly licensed. You may not bypass or circumvent activation. 
To help determine if your software is genuine and whether you are properly 
licensed, see (aka.ms/genuine). Certain updates, support, and other services 
might only be offered to users of genuine Microsoft software. 

6.	 Updates. You may obtain updates only from Microsoft or authorized sources, 
and Microsoft may need to update your system to provide you with those 
updates. The software periodically checks for system and app updates, and 
may download and install them for you. To the extent automatic updates are 
enabled on your device, by accepting this agreement, you agree to receive 
these types of automatic updates without any additional notice. 

7.	 Geographic and Export Restrictions. If your software is restricted for use 
in a particular geographic region, then you may activate the software only in 
that region. You must also comply with all domestic and international export 
laws and regulations that apply to the software, which include restrictions on 
destinations, end users, and end use. For further information on geographic 
and export restrictions, visit (aka.ms/georestrict) and (aka.ms/exporting).

8.	 Support and Refund Procedures. For the software generally, contact the 
device manufacturer or installer for support options. Refer to the support 
number provided with the software. For updates and supplements obtained 
directly from Microsoft, Microsoft may provide limited support services for 
properly licensed software as described at (aka.ms/mssupport). If you are 
seeking a refund, contact the manufacturer or installer to determine its refund 
policies. You must comply with those policies, which might require you to 
return the software with the entire device on which the software is installed 
for a refund.

9.	 Binding Arbitration and Class Action Waiver if You Live in (or if a 

Business Your Principal Place of Business is in) the United States.

We hope we never have a dispute, but if we do, you and we agree to try for 
60 days to resolve it informally. If we can’t, you and we agree to binding 

individual arbitration before the American Arbitration Association 
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(“AAA”) under the Federal Arbitration Act (“FAA”), and not to sue in 

court in front of a judge or jury. Instead, a neutral arbitrator will decide and 
the arbitrator’s decision will be final except for a limited right of appeal under 
the FAA. Class action lawsuits, class-wide arbitrations, private attorney-

general actions, and any other proceeding where someone acts in a 

representative capacity aren’t allowed. Nor is combining individual 

proceedings without the consent of all parties. “We,” “our,” and “us” 
includes Microsoft, the device manufacturer, and software installer.

a.	 Disputes covered—everything except IP. The term “dispute” is as 
broad as it can be. It includes any claim or controversy between you 
and the manufacturer or installer, or you and Microsoft, concerning the 
software, its price, or this agreement, under any legal theory including 
contract, warranty, tort, statute, or regulation, except disputes relating 

to the enforcement or validity of your, your licensors’, our, or our 

licensors’ intellectual property rights.

b.	 Mail a Notice of Dispute first. If you have a dispute and our customer 
service representatives can’t resolve it, send a Notice of Dispute by U.S. 
Mail to the manufacturer or installer, ATTN: LEGAL DEPARTMENT. If 
your dispute is with Microsoft, mail it to Microsoft Corporation, ATTN: 
LCA ARBITRATION, One Microsoft Way, Redmond, WA 98052-6399. 
Tell us your name, address, how to contact you, what the problem is, and 
what you want. A form is available at (aka.ms/disputeform). We’ll do the 
same if we have a dispute with you. After 60 days, you or we may start an 
arbitration if the dispute is unresolved.

c.	 Small claims court option. Instead of mailing a Notice of Dispute, and 
if you meet the court’s requirements, you may sue us in small claims 
court in your county of residence (or if a business your principal place of 
business) or our principal place of business–King County, Washington 
USA if your dispute is with Microsoft. We hope you’ll mail a Notice of 
Dispute and give us 60 days to try to work it out, but you don’t have to 
before going to small claims court. 

d.	 Arbitration procedure. The AAA will conduct any arbitration under 
its Commercial Arbitration Rules (or if you are an individual and use 
the software for personal or household use, or if the value of the dispute 
is $75,000 USD or less whether or not you are an individual or how you 
use the software, its Consumer Arbitration Rules). For more information, 
see (aka.ms/adr) or call 1-800-778-7879. To start an arbitration, submit 
the form available at (aka.ms/arbitration) to the AAA; mail a copy to 
the manufacturer or installer (or to Microsoft if your dispute is with 
Microsoft). In a dispute involving $25,000 USD or less, any hearing will 
be telephonic unless the arbitrator finds good cause to hold an in-person 
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hearing instead. Any in-person hearing will take place in your county 
of residence (of if a business your principal place of business) or our 
principal place of business—King County, Washington if your dispute 
is with Microsoft. You choose. The arbitrator may award the same 
damages to you individually as a court could. The arbitrator may award 
declaratory or injunctive relief only to you individually to satisfy your 
individual claim.

e.	 Arbitration fees and payments.

(i)	 �Disputes involving $75,000 USD or less. The manufacturer 
or installer (or Microsoft if your dispute is with Microsoft) will 
promptly reimburse your filing fees and pay the AAA’s and 
arbitrator’s fees and expenses. If you reject our last written settlement 
offer made before the arbitrator was appointed, your dispute goes 
all the way to an arbitrator’s decision (called an “award”), and 
the arbitrator awards you more than this last written offer, the 
manufacturer or installer (or Microsoft if your dispute is with 
Microsoft) will: (1) pay the greater of the award or $1,000 USD; (2) 
pay your reasonable attorney’s fees, if any; and (3) reimburse any 
expenses (including expert witness fees and costs) that your attorney 
reasonably accrues for investigating, preparing, and pursuing your 
claim in arbitration. The arbitrator will determine the amounts 
unless you and we agree on them.

(ii)	 �Disputes involving more than $75,000 USD. The AAA rules will 
govern payment of filing fees and the AAA’s and arbitrator’s fees and 
expenses.

(iii)	 �Disputes involving any amount. If you start an arbitration we 
won’t seek our AAA or arbitrator’s fees and expenses, or your 
filing fees we reimbursed, unless the arbitrator finds the arbitration 
frivolous or brought for an improper purpose. If we start an 
arbitration we will pay all filing, AAA, and arbitrator’s fees and 
expenses. We won’t seek our attorney’s fees or expenses from you in 
any arbitration. Fees and expenses are not counted in determining 
how much a dispute involves.

f.	 Must file within one year. You and we must file in small claims court 
or arbitration any claim or dispute (except intellectual property disputes 
— see Section 9.a.) within one year from when it first could be filed. 
Otherwise, it’s permanently barred.

g.	 Severability. If the class action waiver is found to be illegal or 
unenforceable as to all or some parts of a dispute, those parts won’t 
be arbitrated but will proceed in court, with the rest proceeding in 
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arbitration. If any other provision of Section 9 is found to be illegal or 
unenforceable, that provision will be severed but the rest of Section 9 still 
applies.

h.	 Conflict with AAA rules. This agreement governs if it conflicts with the 
AAA’s Commercial Arbitration Rules or Consumer Arbitration Rules.

i.	 Microsoft as party or third-party beneficiary. If Microsoft is the device 
manufacturer or if you acquired the software from a retailer, Microsoft 
is a party to this agreement. Otherwise, Microsoft is not a party but is 
a third-party beneficiary of your agreement with the manufacturer or 
installer to resolve disputes through informal negotiation and arbitration.

10.	Governing Law. The laws of the state or country where you live (or if a 
business where your principal place of business is located) govern all claims 
and disputes concerning the software, its price, or this agreement, including 
breach of contract claims and claims under state consumer protection laws, 
unfair competition laws, implied warranty laws, for unjust enrichment, and 
in tort, regardless of conflict of law principles. In the United States, the FAA 
governs all provisions relating to arbitration. 

11.	Consumer Rights, Regional Variations. This agreement describes certain 
legal rights. You may have other rights, including consumer rights, under the 
laws of your state or country. You may also have rights with respect to the 
party from which you acquired the software. This agreement does not change 
those other rights if the laws of your state or country do not permit it to do 
so. For example, if you acquired the software in one of the below regions, or 
mandatory country law applies, then the following provisions apply to you: 

a.	 Australia. References to “Limited Warranty” are references to the express 
warranty provided by Microsoft or the manufacturer or installer. This 
warranty is given in addition to other rights and remedies you may have 
under law, including your rights and remedies in accordance with the 
statutory guarantees under the Australian Consumer Law.

In this section, “goods” refers to the software for which Microsoft or the 
manufacturer or installer provides the express warranty. Our goods come 
with guarantees that cannot be excluded under the Australian Consumer 
Law. You are entitled to a replacement or refund for a major failure and 
compensation for any other reasonably foreseeable loss or damage. You 
are also entitled to have the goods repaired or replaced if the goods fail 
to be of acceptable quality and the failure does not amount to a major 
failure.

b.	 Canada. You may stop receiving updates on your device by turning off 
Internet access. If and when you re-connect to the Internet, the software 
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will resume checking for and installing updates.

c.	 European Union. The academic use restriction in Section 12.d(i) 
below does not apply in the jurisdictions listed on this site: (aka.ms/
academicuse).

d.	 Germany and Austria. 

(i)	 �Warranty. The properly licensed software will perform substantially 
as described in any Microsoft materials that accompany the software. 
However, the manufacturer or installer, and Microsoft, give no 
contractual guarantee in relation to the licensed software.

(ii)	 �Limitation of Liability. In case of intentional conduct, gross 
negligence, claims based on the Product Liability Act, as well as, 
in case of death or personal or physical injury, the manufacturer or 
installer, or Microsoft is liable according to the statutory law.

Subject to the preceding sentence, the manufacturer or installer, or 
Microsoft will only be liable for slight negligence if the manufacturer 
or installer or Microsoft is in breach of such material contractual 
obligations, the fulfillment of which facilitate the due performance of 
this agreement, the breach of which would endanger the purpose of this 
agreement and the compliance with which a party may constantly trust 
in (so-called "cardinal obligations"). In other cases of slight negligence, 
the manufacturer or installer or Microsoft will not be liable for slight 
negligence.

e. 	Other regions. See (aka.ms/variations) for a current list of regional 
variations

12.	Additional Notices.

a.	 Networks, data and Internet usage. Some features of the software 
and services accessed through the software may require your device 
to access the Internet. Your access and usage (including charges) may 
be subject to the terms of your cellular or internet provider agreement. 
Certain features of the software may help you access the Internet more 
efficiently, but the software’s usage calculations may be different from 
your service provider’s measurements. You are always responsible for 
(i) understanding and complying with the terms of your own plans and 
agreements, and (ii) any issues arising from using or accessing networks, 
including public/open networks. You may use the software to connect to 
networks, and to share access information about those networks, only if 
you have permission to do so. 

b.	 H.264/AVC and MPEG-4 visual standards and VC-1 video standards. 

The software may include H.264/MPEG-4 AVC and/or VC-1 decoding 
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technology. MPEG LA, L.L.C. requires this notice:

THIS PRODUCT IS LICENSED UNDER THE AVC, THE VC-1, AND THE 
MPEG-4 PART 2 VISUAL PATENT PORTFOLIO LICENSES FOR THE 
PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER TO (i) 
ENCODE VIDEO IN COMPLIANCE WITH THE ABOVE STANDARDS 
(“VIDEO STANDARDS”) AND/OR (ii) DECODE AVC, VC-1, AND MPEG-
4 PART 2 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED 
IN A PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR 
WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE 
SUCH VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED 
FROM MPEG LA, L.L.C. SEE WWW.MPEGLA.COM

c.	 Malware protection. Microsoft cares about protecting your device 
from malware. The software will turn on malware protection if other 
protection is not installed or has expired. To do so, other antimalware 
software will be disabled or may have to be removed.

d.	 Limited rights versions. If the software version you acquired is marked 
or otherwise intended for a specific or limited use, then you may only 
use it as specified. You may use other programs with the software as long 
as the other programs directly support the manufacturer’s specific use 
for the device, or provide system utilities, resource management, or anti-
virus or similar protection.

(i)	 �Academic. For academic use, you must be a student, faculty or staff 
of an educational institution at the time of purchase.

(ii)	 �Evaluation. For evaluation (or test or demonstration) use, you may 
not sell the software, use it in a live operating environment, or use 
it after the evaluation period. Notwithstanding anything to the 
contrary in this Agreement, evaluation software is provided “AS IS”.

(iii)	� NFR. You may not sell software marked as “NFR” or “Not for 
Resale”.

13.	Entire Agreement. This agreement (together with the printed paper license 
terms or other terms accompanying any software supplements, updates, and 
services that are provided by the manufacturer or installer, or Microsoft, and 
that you use), and the terms contained in web links listed in this agreement, 
are the entire agreement for the software and any such supplements, updates, 
and services (unless the manufacturer or installer, or Microsoft, provides 
other terms with such supplements, updates, or services). You can review this 
agreement after your software is running by going to (aka.ms/useterms) or 
going to Settings - System - About within the software. You can also review 
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the terms at any of the links in this agreement by typing the URLs into a 
browser address bar, and you agree to do so. You agree that you will read the 
terms before using the software or services, including any linked terms. You 
understand that by using the software and services, you ratify this agreement 
and the linked terms. There are also informational links in this agreement. The 
links containing notices and binding terms are:

•	Windows 10 Privacy Statement (aka.ms/privacy)
•	Microsoft Services Agreement (aka.ms/msa)
•	Adobe Flash Player License Terms (aka.ms/adobeflash)

 
********************************************************************************************

NO WARRANTY

THE SOFTWARE ON YOUR DEVICE (INCLUDING THE APPS) IS LICENSED 
“AS IS.” TO THE MAXIMUM EXTENT PERMITTED BY YOUR LOCAL LAWS, 
YOU BEAR THE ENTIRE RISK AS TO THE SOFTWARE’S QUALITY AND 
PERFORMANCE. SHOULD IT PROVE DEFECTIVE, YOU ASSUME THE 
ENTIRE COST OF ALL SERVICING OR REPAIR. NEITHER THE DEVICE 
MANUFACTURER NOR MICROSOFT GIVES ANY EXPRESS WARRANTIES, 
GUARANTEES, OR CONDITIONS FOR THE SOFTWARE. TO THE EXTENT 
PERMITTED UNDER YOUR LOCAL LAWS, THE MANUFACTURER AND 
MICROSOFT EXCLUDE ALL IMPLIED WARRANTIES AND CONDITIONS, 
INCLUDING THOSE OF MERCHANTABILITY, QUALITY, FITNESS FOR A 
PARTICULAR PURPOSE, AND NON-INFRINGEMENT. YOU MAY HAVE 
ADDITIONAL CONSUMER RIGHTS OR STATUTORY GUARANTEES UNDER 
LOCAL LAWS THAT THESE TERMS CANNOT CHANGE.
IF YOUR LOCAL LAWS IMPOSE A WARRANTY, GUARANTEE, OR 
CONDITION EVEN THOUGH THIS AGREEMENT DOES NOT, ITS TERM 
IS LIMITED TO 90 DAYS FROM WHEN THE FIRST USER ACQUIRES THE 
SOFTWARE. IF THE MANUFACTURER OR MICROSOFT BREACHES SUCH 
A WARRANTY, GUARANTEE, OR CONDITION, YOUR SOLE REMEDY, AT 
THE MANUFACTURER’S OR MICROSOFT’S ELECTION, IS (I) REPAIR OR 
REPLACEMENT OF THE SOFTWARE AT NO CHARGE, OR (II) RETURN 
OF THE SOFTWARE (OR AT ITS ELECTION THE DEVICE ON WHICH THE 
SOFTWARE WAS INSTALLED) FOR A REFUND OF THE AMOUNT PAID, IF 
ANY. THESE ARE YOUR ONLY REMEDIES FOR BREACH OF A WARRANTY, 
GUARANTEE, OR CONDITION YOUR LOCAL LAWS IMPOSE.
TO THE EXTENT NOT PROHIBITED BY YOUR LOCAL LAWS, IF YOU HAVE 
ANY BASIS FOR RECOVERING DAMAGES, YOU CAN RECOVER FROM 
THE MANUFACTURER OR MICROSOFT ONLY DIRECT DAMAGES UP TO 
THE AMOUNT YOU PAID FOR THE SOFTWARE (OR UP TO $50 USD IF YOU 
ACQUIRED THE SOFTWARE FOR NO CHARGE). YOU WILL NOT, AND 
WAIVE ANY RIGHT TO, SEEK TO RECOVER ANY OTHER DAMAGES OR 
REMEDY, INCLUDING LOST PROFITS AND DIRECT, CONSEQUENTIAL, 
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SPECIAL, INDIRECT, OR INCIDENTAL DAMAGES, UNDER ANY PART OF 
THIS AGREEMENT OR UNDER ANY THEORY. THIS LIMITATION APPLIES 
TO (I) ANYTHING RELATED TO THIS AGREEMENT, THE SOFTWARE 
(INCLUDING THE APPS), THE DEVICE, SERVICES, CORRUPTION OR 
LOSS OF DATA, FAILURE TO TRANSMIT OR RECEIVE DATA, CONTENT 
(INCLUDING CODE) ON THIRD PARTY INTERNET SITES OR THIRD PARTY 
PROGRAMS, AND (II) CLAIMS FOR BREACH OF CONTRACT, WARRANTY, 
GUARANTEE, OR CONDITION; STRICT LIABILITY, NEGLIGENCE, OR 
OTHER TORT; VIOLATION OF A STATUTE OR REGULATION; UNJUST 
ENRICHMENT; OR UNDER ANY OTHER THEORY.
THE DAMAGE EXCLUSIONS AND REMEDY LIMITATIONS IN THIS 
AGREEMENT APPLY EVEN IF YOU HAVE NO REMEDY (THE SOFTWARE 
IS LICENSED “AS IS”), IF REPAIR, REPLACEMENT, OR A REFUND (IF 
REQUIRED BY YOUR LOCAL LAW) DOES NOT FULLY COMPENSATE YOU 
FOR ANY LOSSES, IF THE MANUFACTURER OR MICROSOFT KNEW OR 
SHOULD HAVE KNOWN ABOUT THE POSSIBILITY OF THE DAMAGES, OR 
IF THE REMEDY FAILS OF ITS ESSENTIAL PURPOSE.
Check with your device manufacturer to determine if your device is covered by a 
warranty.
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Section 2
Overview

Overview
T2 is multi-channel video disk recorder with IO modes such as “4K 1 input”, 
“4K 1 output”, and “HD/SD 1 input/2 output”, which allows simultaneous 
video recording and playing.
Video and audio data are saved in the built-in data drive.
T2 has pre-installed software that performs recording/editing/playing of 
video and creating or playing of playlists. The following two operation 
modes are available depending on the environment.

¾¾Front panel mode
You can operate this mode by tapping the display on the touch screen LCD 
on the T2 front panel. The operation is available under minimum network 
environment.
The basic operations can be performed only on the front panel mode.

¾¾Workstation mode
You can connect and use a PC monitor, mouse, and keyboard to T2 in this 
mode.
All functions are available in this mode.
Operations in Workstation Mode►P133 

The operating instructions on this manual mainly describe procedures in 
the front panel mode and [[HD/SD] 1 in 2 out] mode.

TIP •	The model name of your T2 can be confirmed by version 
information.
Checking the model name and software version►P40 

•	For IO modes available on your T2, see the IO mode list.
IO mode list►P263 

NOTE •	The actual screen display or operation procedure may differ 
from that described in this manual, depending on the T2 
model you use or the IO mode to be set.
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About this manual
The indications and the meanings are as follows.

Displaying media file in removable media

NOTE • 

Operation-ensured driver versions for XDCAM/XDCAM EX/XAVC/
XAVC S P256 
Operation-ensured driver version for P2 P256 

TIP • 
Supported Formats P257 

• 

Displaying media files in network drive P178 

1 

Media card reader (T2 4K Elite/T2 4K Elite Plus only) P28 

2 

NOTE • 

3 
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(1)

(3)

(2)

** The illustration on this page is only for explanation purpose. It differs 
from the actual page on this manual.

(1) NOTE
Describes cautions and restrictions for 
operations.

(2) TIP Describes important points for operations.

(3) Reference page Indicates related pages.
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Section 3
Part Names and Functions

Front panel

Front panel

POWER 1 POWER 2

AC IN PSU FAN AC IN PSU FAN

(3)(2)(1)

(4) (5) (6) (7) (8)

** This illustration is an example of T2 4K Elite.

(1)
Indicators for 
redundant power 
supply

Indicates the status of the redundant power 
supply.
Indicators for redundant power supply (T2 4K 
Elite/T2 4K Elite Plus only)►P27  

(2) Media card reader
Various types of media cards can be inserted.
Media card reader (T2 4K Elite/T2 4K Elite Plus 
only)►P28 

(3) Touch screen LCD
Operates T2 by tapping the display on the 
screen.

(4) Power switch Turns on T2.

(5) USB 3.0 ports Used to connect USB 3.0 removable devices.

(6) Volume control Used to adjust the headphone volume.
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(7) Headphone jack

Used to connect a headphone.
Audio level detail display (Recorder 
channel)►P147  
Audio level detail display (Player 
channel)►P160 

(8) Control buttons
Performs channel selection or playing back 
and recording of video.
Control buttons►P29 

Indicators for redundant power supply (T2 4K Elite/T2 4K 
Elite Plus only)

POWER 1 POWER 2

AC IN PSU FAN AC IN PSU FAN

(1) (2) (3) (4) (5) (6)

(1)
AC IN
(Power failure 
detection indicator)

The indicator lights in green when the 
main power of the power unit 1 is turned 
on. If it blinks in red, the power cable may 
be disconnected or a power failure has 
occurred.

(2)

PSU
(Power unit 
malfunction 
indicator)

The indicator lights in green when the 
main power of the power unit 1 is turned 
on. If it blinks in red, the power unit may 
be malfunctioning or may be attached 
incorrectly. When the power failure 
indicator lights in green and the power unit 
malfunction indicator blinks in red, contact 
the support.

(3)
FAN
(FAN abnormality 
detection indicator)

The indicator lights in green when the main 
power of the power unit 1 is turned on.
If it blinks in red, the fan may be 
malfunctioning.

(4)
AC IN
(Power failure 
detection indicator)

The indicator lights in green when the 
main power of the power unit 2 is turned 
on. If it blinks in red, the power cable may 
be disconnected or a power failure has 
occurred.
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(5)

PSU
(Power unit 
malfunction 
indicator)

The indicator lights in green when the 
main power of the power unit 2 is turned 
on. If it blinks in red, the power unit may 
be malfunctioning or may be attached 
incorrectly. When the power failure 
indicator lights in green and the power unit 
malfunction indicator blinks in red, contact 
the support.

(6)
FAN
(FAN abnormality 
detection indicator)

The indicator lights in green when the main 
power of the power unit 2 is turned on.
If it blinks in red, the fan may be 
malfunctioning.

Media card reader (T2 4K Elite/T2 4K Elite Plus only)

(1) (2) (3) (4)

(1) Exclusive SSD drive 
slot

Used to read and write data in an inserted 
SSD.

(2) Compact Flash card 
slot

Used to read and write data in an inserted 
Compact Flash card.

(3) SD card slots

Used to read and write data in an inserted 
SD card.
Only the SD card slot on the right supports 
UHS-II/microP2.

(4) SxS memory card 
slot

Used to read and write data in an inserted 
SxS memory card.

** Any card other than SxS memory card 
such as an ExpressCard will not operate.

NOTE •	While any of the indicators for media cards blinks in green, 
data is being read or written. Do not insert or remove a media 
card.
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Control buttons

R1

SHTL
JOG VAR

P1

P2

(1)

(2)

(3)

(4) (5) (6) (7) (8)

(9)

(10)

(11)

(1) [R1] button
Switches to 1ch view of the R1 channel. Makes the 
R1 channel active.

(2) [P1] button
Switches to the 1ch view of P1 channel. Makes the 
P1 channel active.

(3) [P2] button
Switches to the 1ch view of P2 channel. Makes the 
P2 channel active.

(4) [Rew] button
By every press, moves back frame by frame. 
Holding on the button will rewind by 32 times speed.

(5) [Play] button Starts playback.

(6) [FF] button
By every press, moves forward frame by frame. 
Holding on the button will fast-forward by 32 
times speed.

(7) [Stop] button Stops playback or recording.

(8) [Rec] button Starts recording.

(9) [SHTL/JOG] 
button

Switches to the jog/shuttle mode.
Playing back in jog/shuttle mode►P98 

(10) [VAR] button

Switches to the variable speed mode.
Displays the speed controller and allows to change 
the playback speed.
Playing back in variable speed mode (variable 
playback)►P97 

(11) Jog/Shuttle

When the [SHTL/JOG] button is on, executes jog/
shuttle playback operations.
When the [VAR] button is on, executes variable 
speed playback.

NOTE •	When [[HD/SD] 0 in 3 out] is selected, the [R1], [P1], and [P2] 
buttons control P1, P2, and P3 channels respectively.
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[Rew] + [Stop] 
buttons

While playing a clip, moves to the previous In/
Out point or to the top of the clip.
While playing a playlist, moves to the previous event.
It allows to include the position of the previous 
marker as a moving destination. In the [Marker] 
dialog box, check [Show marker icons on the 
scrub bar], click [When moving to edit point :] list 
and select [Cue up on Markers].
[Marker] dialog box►P124 

[FF] + [Stop] buttons

While playing a clip, moves to the next In/Out 
point or to the end of the clip.
While playing a playlist, moves to the next event.
It allows to include the position of the next 
marker as a moving destination. In the [Marker] 
dialog box, check [Show marker icons on the 
scrub bar], click [When moving to edit point :] list 
and select [Cue up on Markers].
[Marker] dialog box►P124 

Rear panel

Rear panel

(1) (2) (3)

(8) (9) (10)(7) (11) (12)

(4) (5) (6)

(1) AC Power inlet 
(3-pin)

Used to connect to the AC power outlet 
with the supplied power cable.

(2) Main power switch Turns on/off the main power.

(3) LAN port Used to connect a LAN cable.
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(4) LTC/Monitor audio 
interface board

Used for LTC (timecode) input/output and 
audio monitor.
LTC/Monitor audio interface board►P32 

(5) Video I/O board

Used for input to the Recorder channel and 
output from the Player channel.
Video I/O board (Elite/Pro/Express)►P32 
Video I/O board (Elite Plus/Pro Plus/Express 
Plus)►P32 

(6) Remote interface 
board

Used for remote control of Recorder 
channel or Player channel.
Remote interface board►P33 

(7)

Power unit 2 (left) 
(T2 4K Elite/T2 4K 
Elite Plus only), 
Power unit 1 (right)

T2 4K Elite/T2 4K Elite Plus has redundant 
power supply composed of power unit 1 
and power unit 2.
Other T2 4K Series products have single 
power supply of the power unit 1.

(8) Monitor (DVI-D) port
Used to connect a PC monitor. An analog 
monitor can not be used.

(9) Monitor 
(DisplayPort) port

Used to connect a PC monitor.

(10) USB 2.0 port Used to connect a keyboard, mouse, and so on.

(11) USB 3.0 port Used to connect USB 3.0 removable devices. 

(12) Sound Not used.

NOTE •	In the workstation mode, you cannot use T2 with the monitor 
ports (DVI-D/DisplayPort) connected simultaneously. 
(Exclusive use only)

•	Be sure to turn off your T2 before connecting/disconnecting 
the cable to/from the monitor port or turning on/off the 
display.
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LTC/Monitor audio interface board
LTC IN CH 1 CH 2

AUDIO / LTC OUT

(2)(1)

(1) LTC IN Used for LTC (timecode) input.

(2) AUDIO / LTC OUT
(CH1/CH2)

Used for LTC (timecode) output or audio 
monitor.
From the setting screen, go to [General] 
-> the [Hardware] tab, and set the output 
details for each connector using [Audio / 
LTC Output (CH1/CH2):].
General – Hardware settings►P189 

Video I/O board (Elite/Pro/Express)

SDI1 SDI2 SDI3 SDI4 REF IN

(1) (2)

(1) SDI 1/SDI 2/
SDI 3/SDI 4

The connector to be used varies depending 
on the selection for [IO Mode].
IO mode list - T2 4K Series (Elite/Pro/
Express)►P263 

(2) REF IN Used to input REF signal.

Video I/O board (Elite Plus/Pro Plus/Express Plus)

(2) (3)(1)

(1) Terminal not to be used Not used.

(2) Upper: SDI 5/SDI 6/SDI 7/SDI 8
Lower: SDI 1/SDI 2/SDI 3/SDI 4

Available terminals differ according 
to the selection for [IO Mode].
IO mode list - T2 4K Series (Elite 
Plus/Pro Plus/Express Plus)►P264 

(3) REF Used for REF signal input.
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Remote interface board

REMOTE
IN 1

REMOTE
IN 2

REMOTE
IN 3

REMOTE
OUT GPIO

(2) (3)

(1)

(1)
REMOTE IN 1 /
REMOTE IN 2 /
REMOTE IN 3

Used to control R1 channel for REMOTE 
IN 1, P1 channel for REMOTE IN 2, and P2 
channel for REMOTE IN 3, using RS422 
signal (Sony 9-Pin Protocol).
When [[HD/SD] 0 in 3 out] is selected, use 
REMOTE IN 1 to control the P1 channel, 
REMOTE IN 2 to control the P2 channel, 
and REMOTE IN 3 to control the P3 
channel.

(2) REMOTE OUT
Used to control external VTR or other 
devices using RS422 signal (Sony 9-Pin 
Protocol).

(3) GPIO Used for GPI input/output.

TIP •	The IO modes available on your T2 differ depending on the T2 
model type.
IO mode list►P263 
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Section 4
Connection/Start-up/Exit

This section describes how to connect peripheral devices to T2, start-up and exit 
procedures, and switching procedures of front panel mode and workstation mode.

Connecting peripheral devices
The procedure to connect peripheral devices such as external input/output 
device to T2 is described in this part.

1	 Connect a device for Recorder channel input to T2.

Connect a device to the video I/O board or LTC/Monitor audio interface 
board on the T2 rear panel.
Video I/O board (Elite/Pro/Express)►P32 
Video I/O board (Elite Plus/Pro Plus/Express Plus)►P32 
LTC/Monitor audio interface board►P32 

2	 Connect a device for Player channel output to T2.

Connect a device to the video I/O board or LTC/Monitor audio interface 
board on the T2 rear panel.
Video I/O board (Elite/Pro/Express)►P32 
Video I/O board (Elite Plus/Pro Plus/Express Plus)►P32 
LTC/Monitor audio interface board►P32 

3	 If you wish to operate T2 in the workstation mode, connect a 
mouse, keyboard, and PC monitor to T2.

Connect the mouse and keyboard to the USB port, and connect the PC 
monitor to the monitor port.
Rear panel►P30 
If you wish to operate T2 in the front panel mode, you do not need to 
connect a mouse, keyboard, and PC monitor.

TIP •	A mouse, keyboard, and PC monitor are not included in the 
product package.

4	 Insert the power cable to the inlet of T2.

For T2 4K Elite/T2 4K Elite Plus, insert the cables to the power unit 1 and 
power unit 2.
For other T2 4K Series products, insert the cable to the power unit 1.
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5	 Use the power cable fixing clamps to secure the power cables.

6	 Connect the power cable to the AC power outlet.

Starting up and exiting T2

Starting up T2
1	 Turn on the main power switch on the T2 rear panel.

2	 Turn on the main power switch on the T2 front panel.

POWER 1 POWER 2

AC IN PSU FAN AC IN PSU FAN

When starting up for the first time, T2 will start up in the front panel mode. 
The display appears in the 3ch view on the touch screen LCD.
Other than the first time, T2 will start up in the previously used operation 
mode (front panel mode or workstation mode).

TIP •	To start up T2 in the workstation mode, start up T2 in the front 
panel mode, and then switch to the workstation mode.
Switching from the front panel mode to the workstation mode►P37 
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Exiting T2 in the front panel mode

NOTE •	Do not forcibly exit T2 by holding down the power switch or 
turning off the main power switch on the T2 rear panel. A 
malfunction may occur.

1	 Press one of the [R1], [P1], or [P2] button.

You can also perform the operation by tapping [1ch View] or [Bin] on the 
touch screen LCD.

2	 Tap [Menu], and then tap [Tools] -> [Exit].

3	 Select [Shut Down] from the list and tap [OK].

To restart T2, select [Restart].

NOTE •	If you do not use T2 for a long time, turn off the main power 
switch on the T2 rear panel and unplug the power cord.

Exiting T2 in workstation mode

NOTE •	Do not forcibly exit T2 by holding down the power switch or 
turning off the main power switch on the T2 rear panel. A 
malfunction may occur.

1	 Click [System] on the menu bar, and click [Exit].

2	 Select [Shut Down] from the list and click [OK].

To restart T2, select [Restart].
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NOTE •	If you do not use T2 for a long time, turn off the main power 
switch on the T2 rear panel and unplug the power cord.

Switching front panel mode/workstation mode

Switching from the front panel mode to the workstation 
mode
1	 On the PC monitor, click [System] on the menu bar, and click 

[Switch to Workstation mode].

Switching from the workstation mode to the front panel 
mode
1	 Tap the touch screen LCD.

You can also switch the mode on the PC monitor, by clicking [System] on 
the menu bar, and then clicking [Switch to Front Panel mode].

Locking front panel
You can lock the front panel to disable the operations.

1	 On the PC monitor, click [System] on the menu bar, and click 
[Lock Front Panel].

[Lock Front Panel] box is checked while the front panel is being locked.
To unlock it, press the [R1], [P1], [P2], and [SHTL/JOG] buttons on the T2 
front panel at the same time.
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Switching IO mode
This section describes the procedure to switch the input/output mode of T2.

TIP •	The IO modes available on your T2 differ depending on the T2 
model type.
IO mode list►P263 

1	 Tap [Config.].

From the setting screen, [General] -> the [Hardware] tab appears.

2	 Tap [Settings...] of [IO Mode:].

3	 Set IO mode in the [IO Mode Setting] dialog box, and tap [OK].

[IO Mode Setting] dialog box►P142 

38 T2 User Manual	 January 1, 2020

Section 4  ― Connection/Start-up/Exit



4	 Tap [OK].

TIP •	In the workstation mode, you can switch the IO mode using the 
status bar on the lower part of the screen.
Status bar►P162 

Assigning a channel for monitor output from the SDI terminal
You can use the SDI terminal on the video I/O board for monitor output.
This section describes the procedure to assign an output channel to the SDI 
terminal to be used for monitor output.

1	 Perform steps 1 and 2 of “Switching IO mode”.

Switching IO mode►P38 

2	 In the [IO Mode Setting] dialog box, tap [Settings...].

The IO mode detailed settings dialog box appears.
IO mode detailed settings dialog box►P191 

3	 From the list of SDI terminal setting, select an SDI terminal for 
which [Monitor output] is indicated as [Type].

TIP •	SDI terminal available for monitor output varies depending on 
the model type or IO mode of your T2.
IO mode list►P263 
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4	 Select a channel for monitor output from the list of [Channel:], 
and then select ON/OFF of on-screen display from the list of 
[OSD:].

TIP •	On-screen display is not available on R1 channel.
Terminal types and available settings►P192 

5	 Tap [OK] on the IO mode detailed settings dialog box.

6	 Tap [OK].

Checking the model name and software version
You can check the model name and software version of your T2.

1	 Press one of the [R1], [P1], or [P2] button.

You can also perform the operation by tapping [1ch View] or [Bin] on the 
touch screen LCD.

2	 Tap [Menu] on the touch screen LCD, and tap [Tools] -> [About 
T2].

The version information of T2 is displayed.
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Section 5
Recording

This section describes the recording procedure in the Recorder channel.

Displaying Recorder channel in 1ch view
In the 1ch view of the Recorder channel, various operations for recording 
are available.

1	 Press the [R1] button.

The display switches to the 1ch view of the Recorder channel, and the [R1] 
button lights in green.
You can also switch by tapping [1ch View] and then tapping the Recorder 
channel tab.
You can use the operation buttons on the lower part of the touch screen 
LCD, to start and end of recording.

¾¾Recorder channel – 1ch view

(2) (8) (9) (10)(4) (6)(3) (5) (7)(1)

(11) (12) (19)(13) (15) (17)(18)(16)(14)

(1) Recorder channel 
tab

By tapping, selects and highlights the 
Recorder channel.

(2) Status Indicates the recording progress status.

41January 1, 2020	 T2 User Manual

Displaying Recorder channel in 1ch view



(3) [Locked]

Locks Recorder channel operations.
While the operations are locked, [Locked] 
and [R1] buttons light in red.
Tapping it again releases the lock.

(4) Preview
Displays the video currently inputted.
Tapping the preview displays in the full 
screen view.

(5) [Cur:] Indicates the current timecode inputted.

(6) Scrubbing bar Indicates the recording progress status.

(7) [Elap:]
Indicates the elapsed time of recording by 
timecode display.

(8) Audio level display Displays the audio playback level.

(9) [Menu]
Displays menu such as properties of clip 
and rename, unload, set the clip name for 
next ingest file, etc.

(10) Recording mode
Switches the recording mode (Recorder-
live mode /Recorder-VTR mode/Recorder-
remote mode).

(11) Operation buttons
Operation buttons of Recorder 
channel►P43 

(12) [Clip:]
Displays the name of the clip currently 
recorded.

(13) [Saving destination]

Sets the saving destination of the recorded 
clip.
The destination bin name is displayed in 
the right. If the saving destination is an 
external storage, it changes to green.

(14) [Length:]
If [Fixed Length] is on, sets the time length 
(duration) from the start point to the end 
point of recording by tapping the timecode.

(15) [In:]/[Out:]/[Dur:]

Indicates the timecode of In/Out points and 
duration.
In the Recorder-VTR mode, you can set In 
or Out point by tapping the timecode of 
[In:] or [Out:].
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(16) [Schedule]

In the Recorder-live mode, automatically 
starts recording operation at a specified 
time, and ends it at a specified time. In the 
front panel mode, allows to switch on/off of 
schedule and to display the schedule list. 
To add, edit, or delete schedules, use the 
workstation mode.
Recorder-live mode / schedule mode►P137 

(17) [Format:]
Displays the video size, frame rate, input 
settings, port used for input, source TC (TC 
(LTC)/SDI (VITC)/INT), etc.

(18) [Fixed Length]
By tapping to set it on, automatically ends 
recording after the duration specified in 
[Length:] has passed.

(19)
1ch view/3ch view/
bin/transfer screen 
common area

1ch view/3ch view/bin/transfer screen 
common area►P44 

¾¾Operation buttons of Recorder channel
(2) (4) (6)(3) (5)(1)

(1) [Clear (In/Out)] Clears set In/Out points.

(2) [Cue(In)]*1 Moves the VTR to the In point.

(3) [Mark(In)] Sets In point to the current position. 

(4) [Mark(Out)] Sets Out point to the current position.

(5) [Cue(Out)]*1 Moves the VTR to the Out point.

(6) [Create Subclip]*2

Creates a sub clip between In-Out points 
set while recording, and saves it as 
highlight.

*1	 Only for Recorder-VTR mode.
*2	 Only for Recorder-live mode. However, if the video being recorded is 

saved to an external media/storage, a sub clip cannot be created.

43January 1, 2020	 T2 User Manual

Displaying Recorder channel in 1ch view



¾¾1ch view/3ch view/bin/transfer screen common area

(2)

(8)

(4)

(6)

(3)

(5)

(7)

(1)

(1) [Bin]
Display the bin view.
Managing contents in the bin►P76 

(2) [1ch View]
Switches the currently selected channel to 
1ch view.

(3) [3ch View] Switches to 3ch view.

(4) [Config.]
Displays the setting screen.
Displaying the setting screen►P188 

(5) [Transfer]
Display the transfer screen.
Checking the transfer status►P59 

(6) Remaining HDD 
(remaining time)

Displays the estimated recording time 
available on HDD.
When the remaining capacity reduces, the 
icon is displayed in red.

(7) [Remove Device]

Displayed when a removable drive such as 
USB removable media, XDCAM, P2, etc. is 
connected.
By tapping, disconnects the removable 
media.
Removing removable media►P61 

(8) Time

Displays the current time. Tapping this part 
displays the date and time setting dialog 
box that enables to change the set time.
Date and time setting dialog box►P206 

NOTE •	If the  icon appears in 1ch view/3ch view/bin/transfer 
screen common area, there is a problem with the data drive. 
Consult the support.
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Selecting Recorder channel in 3ch view
When [[HD/SD] 1 in 2 out] is selected in 3ch view, you can view the R1, P1, 
and P2 channels simultaneously.
In 3ch view of the Recorder channel, you can use the operation buttons on 
the lower part of the touch screen LCD, to start and end of recording.

1	 Tap [3ch View].

The display switches to 3ch view.

2	 Tap the Recorder channel tab.

Recorder channel is selected and highlighted.

¾¾Recorder channel – 3ch view

(2) (8)(4) (6)(3) (5) (7)(1)

(1) Recorder 
channel tab

By tapping, selects and highlights the Recorder 
channel.

(2) Status Indicates the recording progress status.

(3) [Locked]

Locks Recorder channel operations.
While the operations are locked, [Locked] and 
[R1] buttons light in red.
Tapping it again releases the lock.

(4) Preview Displays the video currently inputted.

(5) Audio level 
display

Displays the audio playback level.

(6) [Clip:] Indicates the name of the clip.
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(7) [Cur:] Indicates the current timecode inputted.

(8) [Elap:]
Indicates the elapsed time of recording by 
timecode display.

Recording by VTR control (Recorder-VTR mode)
The procedure to control VTR from your T2 and perform recording is 
described in this part.
Set the connection information of the VTR used for recording or the video 
format for capturing beforehand.
General – Hardware settings►P189 
Recorder settings►P207 
Transfer – common settings►P219 
If necessary, make settings in the setting screen according to the environment 
in use.
Settings►P188 

TIP •	In the workstation mode, you can import the batch capture list 
to your T2 and record sources at once.
Recording sources at once (batch capturing)►P176 

•	The VTR can be controlled by using your T2 as a controller and 
via AMP command or BVW command.
Controlling an external device from T2 with AMP/BVW (Recorder-
VTR mode)►P238  
AMP command list►P265 
BVW command list►P278 

1	 Press the [R1] button.

Recorder channel is displayed in 1ch view. The video from the external 
input device is displayed in the preview.
Recorder channel – 1ch view►P41 

2	 Tap [VTR].

The mode switches to the Recorder-VTR mode.

3	 Tap [Saving destination], select the saving destination of the clip 
to record, and then tap [OK].

Saving destination dialog box►P212 

4	 Play back the video to record and tap [Mark(In)] and [Mark(Out)] 
to specify the recording range (In/Out points).

Playing back video►P97 
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TIP •	You can also specify the timecode by tapping the entry area of 
[In:] and [Out:].

•	You can also specify the time lapse from the start point of 
recording (duration) to automatically end the recording. Tap 
[Fixed Length], tap the entry area of [Length:], and enter the 
timecode.
Recorder channel – 1ch view►P41 

5	 Press the [Rec] button.

The recording starts at the specified In point. The recording automatically 
ends at the specified Out point.
You can set the clip name by tapping the entry area of [Clip:] while recording.
To end the recording in the middle, press the [Stop] button.
After the recording ends, the recorded clip is saved in the bin selected in 
step 3.

TIP •	The video currently recorded in the Recorder channel can be 
loaded and played on the Player channel.
Loading and playing back video currently recorded (chasing 
playback)►P99 

•	The video currently recorded on the Recorder channel can be 
output from P1/P2 channel with active-through output.
Outputting currently recorded video with active through (E to E 
mode)►P100 

•	To check the properties of the clip currently recorded, tap 
[Menu] and then tap [Properties] on the 1ch view of the 
Recorder channel.

•	To change the name of the clip currently recorded, tap [Menu] 
and then tap [Rename] on the 1ch view of the Recorder 
channel.

•	Markers can be added on a clip being recorded.
Adding marker►P125 

•	To unload the video after recording, tap [Menu] and then tap 
[Unload] on the 1ch view of the Recorder channel.

•	To set the clip name for next ingest file, tap [Menu] and then 
tap [Set the clip name for next ingest file...] on the 1ch view of 
the Recorder channel. If the name of the clip to be recorded 
next has been set in the Recorder channel, the clip name 
setting for the next recorded clip is prioritized.
Setting of ingesting dialog box►P145 
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Recording live video (Recorder-live mode)
The procedure to record live video from an external device is described in 
this part.
Set the connection information of the external device used for recording or 
the video format for capturing beforehand.
General – Hardware settings►P189 
Recorder settings►P207 
Transfer – common settings►P219 
If necessary, make settings in the setting screen according to the environment 
in use.
Settings►P188 
You can also set to automatically start recording operation at a specified 
time and end it at a specified time. (Only available in the workstation mode.)
Recorder-live mode / schedule mode►P137 

TIP •	The name of the clip to be recorded can be specified. You can 
set the naming rule and specify the name of the clip to be 
recorded in the next.
Recorder channel – 1ch view►P41 
Setting of ingesting dialog box►P145 

•	You can also record video from a device that cannot allow deck 
control in the same procedure. Find the start point of the video 
for recording beforehand.

1	 Press the [R1] button.

Recorder channel is displayed in 1ch view. The video from the external 
input device is displayed in the preview.
Recorder channel – 1ch view►P41 

2	 Tap [Live].

The mode switches to the Recorder-live mode.

3	 Tap [Saving destination], select the saving destination of the clip 
to record, and then tap [OK].

Saving destination dialog box►P212 

4	 If necessary, play the video from the external device and press 
the [Rec] button on T2.

The recording starts.
You can set the clip name by tapping the entry area of [Clip:] while recording.
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TIP •	An important part in the recorded video can be saved in 
another clip as highlight. Tap [Mark(In)] and [Mark(Out)], and 
then tap [Create Subclip]. However, if the video being recorded 
is saved to an external storage, a sub clip cannot be created.

•	You can also specify the time lapse from the start point of 
recording (duration) to automatically end the recording. Tap 
[Fixed Length], tap the entry area of [Length:], and enter the 
timecode.

•	The video currently recorded in the Recorder channel can be 
loaded and played on the Player channel.
Loading and playing back video currently recorded (chasing 
playback)►P99 

•	The video currently recorded on the Recorder channel can be 
output from P1/P2 channel with active-through output.
Outputting currently recorded video with active through (E to E 
mode)►P100 

•	To check the properties of the clip currently recorded, tap 
[Menu] and then tap [Properties] on the 1ch view of the 
Recorder channel.

•	To change the name of the clip currently recorded, tap [Menu] 
and then tap [Rename] on the 1ch view of the Recorder 
channel.

•	Markers can be added on a clip being recorded.
Adding marker►P125 

5	 After recording the necessary video, press the [Stop] button on T2.

After stopping recording, the recorded clip is saved in the bin selected in 
step 3.

TIP •	To unload the video after recording, tap [Menu] and then tap 
[Unload] on the 1ch view of the Recorder channel.

•	To set the clip name for next ingest file, tap [Menu] and then 
tap [Set the clip name for next ingest file...] on the 1ch view of 
the Recorder channel. If the name of the clip to be recorded 
next has been set in the Recorder channel, the clip name 
setting for the next recorded clip is prioritized.
Setting of ingesting dialog box►P145 
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Section 6
Import/Export

This section describes the procedure to import a media file from a removable 
media or network drive and to export contents edited in your T2.

Importing a media file

Displaying the [Browse] tab
Import of media files from a removable media such as USB removable 
device, XDCAM, P2, and from a network drive to your T2 is performed 
from the [Browse] tab.

1	 Tap [Bin].

The bin view appears.

2	 Tap the [Browse] tab.

¾¾ [Browse] tab

(2)

(7) (8) (9)

(4)(3) (5)(1) (6)

(10)

(1) [Preview] Switches on/off of the preview (filmstrip).

(2) View switching tab
Switches between [Bin] tab/[Browse] tab/
[Recycle Bin] tab.
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(3) [New connection]
When a removable media is connected to 
T2, you can select a folder to display in the 
[Browse] tab.

(4) [Import] Imports the selected media file to T2 as a clip.

(5) [>Px]

Loads the selected media file to the Player 
channel.
You can play and check the video without 
importing to T2 as a clip. However, the 
playback speed depends on the specifications 
of the connected removable media.

(6) [Menu] Displays the related menu.

(7) Removable media 
list

Displays the media or folders in the 
removable media connected to T2.
The selected folder is highlighted in blue.

(8) Filmstrip display
By tapping [Preview] and set it on, displays 
the contents in the media file in filmstrip 
with six frames.

(9) Media file list
Displays the list of media files in the drive 
selected from the removable media list.
The selected media file is highlighted in blue.

(10)
1ch view/3ch view/
bin/transfer screen 
common area

1ch view/3ch view/bin/transfer screen 
common area►P44 

TIP •	The IO modes available on your T2 differ depending on the T2 
model type.
IO mode list►P263 
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Displaying media file in removable media
Media files in a removable media such as USB removable device, XDCAM, 
P2, etc. can be displayed without importing to T2.

NOTE •	When using XDCAM, XDCAM EX, XAVC, XAVC S, or P2 
device, install the driver in the maintenance mode before 
connecting the device to T2. For more information about the 
maintenance mode, refer to the T2 Service Manual.
Operation-ensured driver versions for XDCAM/XDCAM EX/XAVC/
XAVC S►P256 
Operation-ensured driver version for P2►P256 

TIP •	For details on the supported formats, see “Appendix”.
Supported Formats►P257 

•	If you make settings of the network drive in the workstation 
mode, you can display media files in the network drive from 
the [Browse] tab.
Displaying media files in network drive►P178 

1	 Connect a removable media to your T2 and insert medium.

For T2 4K Elite/T2 4K Elite Plus, cards can be directly inserted into the 
slots of the media card reader. When the media is recognized by T2, the 
indicator on the left of the card slot lights up in green.
Media card reader (T2 4K Elite/T2 4K Elite Plus only)►P28 

2	 Tap [Import].

The screen switches to the [Browse] tab.

NOTE •	If it does not switch to the [Browse] tab, switch manually.

3	 Tap [New connection] and select a medium type.
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4	 Select a drive, and then tap [OK].

Media file list including media files appears.

TIP •	To update information in the removable media, tap [Menu], 
and then tap [Refresh].

Playing media file in removable media
You can load media files in a removable media to T2 and play them.

NOTE •	The system is under heavy load during playback of clips in 
removable media. It is recommended that you import the file 
to your T2 and play it.

1	 Select a drive in the [Browse] tab and display the media file.

Displaying media file in removable media►P52 

2	 Select a media file and tap [>Px].

While another clip is loaded, a confirmation message appears. Tap [Yes] to 
unload the clip.
The media file is loaded to the Player channel.

TIP •	You can also load the file to the selected channel by tapping 
the media file two times.

3	 Press the [Play] button.

Playing back video►P97 

TIP •	The following operation are available on the media files loaded 
to the Player channel.

-- Playback operation using the T2 front panel control buttons
-- Setting of In and Out points and moving to In or Out point
-- Setting markers, moving to markers

NOTE •	Depending on the specifications of the connected removable 
media, playback operation may not catch up.

•	The following operations are not available on the media files 
loaded to the Player channel.

-- Import of video between set In-Out points
-- Import of added markers
-- Gain adjustment of audio level
-- Tag editing (workstation mode only)
-- Sync playback (pairing)
-- Adding to playlist
-- Creating sub clips

If you add files to playlist, create sub clips or create still clip, 
import the media file before you perform the operation.
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Checking the properties of media file
The procedure for checking the properties of media file is described in this 
part.

1	 Select a drive in the [Browse] tab and display the media file.

Displaying media file in removable media►P52 

2	 Select a media file, tap [Menu], and then tap [Properties].

The properties of media file is displayed.

¾¾Properties of media file

[Clip Info] tab

Displays the clip information.
You can check the clip name, format, In/Out 
points timecode, length, alpha channel presence, 
date of creation, bitrate, etc.
Tapping the entry area allows to change the clip 
name.
Checking [Locked] locks the clip from editing.

[Media Info] tab

The information of media file is displayed.
You can check the file path, number of clips and 
playlists linked to the media file, size, In/Out 
points timecode, etc.
Tapping [Details...] allows to check the details of 
the clips linked to the media file.

[Timecode] tab

Specifies start timecode.
To use the start timecode of a media file, select 
[Source].
To specify a start timecode, select [Specify Start 
Time], tap the entry area, and enter timecode.

3	 Tap [OK].
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Changing media file list display
You can switch the display of the media file list between icon display and 
text display.

1	 Tap [Menu], and then tap [View].

2	 Tap [Icon View] or [Text View].

Importing a media file
The procedure for importing media file to T2 is described in this part.
At the time of import, you can set whether to import the file in the native 
format or in a converted format such as Grass Valley HQX AVI. The import 
operation will be easier if the format for the imported file and other setting 
items have been set beforehand.
Transfer settings►P219 
If necessary, make settings in the setting screen according to the environment in use.
Settings►P188 

TIP •	For more information about the file formats that can be 
imported, see “Appendix”.
Supported Formats►P257 

•	If data is imported as the native format, XDCAM, XDCAM EX, 
XAVC, XAVC S, and P2 sources will be copied with folders and 
files that are necessary for native format playback on T2.

•	You can convert a file to Grass Valley HQX AVI after importing 
it as the native format.
Converting contents to other formats►P82 

•	Still image files are converted to Grass Valley HQX AVI and 
imported.

•	The system will import files that contain transparency 
information after converting them to Grass Valley HQX AVI.

•	If a file that contains the following settings in the metadata 
of XDCAM or P2 source is imported, it will be imported as 
markers for T2.

-- Essence marks in the metadata of XAVC or XAVC S
-- Essence marks in the metadata of XDCAM or XDCAM EX
--Memo list in the metadata of P2

Note that the markers set with T2 cannot be reflected in the 
original media file.

1	 Select a drive in the [Browse] tab and display the media file.

Displaying media file in removable media►P52 
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2	 Select a media file, tap [Import], and then tap [Import...].

The Import dialog box appears.

TIP •	Dragging on the media file selects multiple media files.

¾¾ Import dialog box

(2) (4)(3)

(5) (7)(6) (8) (9)

(1)

(1) [Delete]
Deletes the selected file from the import 
list.

(2) [UP] Moves up the selected file.

(3) [DOWN] Moves down the selected file.

(4) [Config.]
Displays the setting screen. Sets the file 
format after imported.

(5) Import list
Displays the list of the files to be imported.
[Format] shows the formats of files to be 
imported.

(6) [Bin:]
Displays the saving destination bin for the 
imported media files.

(7) [Select Import 
Destination Bin]

Selects the saving destination bin for the 
imported media files.

(8) [Start] Starts import.

(9) [Cancel] Closes the import dialog box.
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3	 Tap [Config.].

If conversion of the format of the file to import is not necessary, you do not 
need to change the settings in the setting screen. Proceed to step 6.

4	 Tap the tab of the format of the media file.

For example, if the media file to import is XDCAM format, tap the [XDCAM] 
tab. If it is an MXF single file, tap the [MXF] tab.

5	 From the [File format after import:] list, select a post-import 
format and then tap [OK].

6	 In the import dialog box, tap [Select Import Destination Bin], 
select a bin, and tap [OK].

7	 Tap [Start].

Import starts. You can check the progress in the transfer screen.
Checking the transfer status►P59 

NOTE •	By default, the system will pause any transfer and conversion 
during a recording or playback. If you want transfer and 
conversion to be performed even during a recording or 
playback, change the setting by [Transfer] -> [Common] on 
the setting screen. Unchecking [Pause file transfers while 
recording or playing out.] enables transfer and conversion 
even during a recording or playback. However, if this option 
is unchecked, the recording/playback operations may not be 
performed normally, therefore, we recommend that you use 
the system with this option checked.
Transfer – common settings►P219 
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Importing still images with serial numbers as a 
sequence clip
Still images with serial numbers can be imported as a single sequence clip 
(in Grass Valley HQX AVI).
If necessary, make settings in the setting screen according to the environment 
in use.
Settings►P188 

NOTE •	If a file has a name that has characters followed by numerics, 
such as Clip1234.jpg, it will be recognized as a still image file 
with a sequential number.

•	If some of the files have different extensions, or if files with 
added alpha channel and those without alpha are mixed, 
the import of the still images with serial numbers will be 
canceled.

1	 Select a drive in the [Browse] tab and display the media file.

Displaying media file in removable media►P52 

2	 Select the first file in the serial numbers, tap [Import], and then 
tap [Import (Sequence)...].

The Import dialog box appears.
Import dialog box►P56 

3	 Tap [Config.].

4	 In [Configure import of image and images in a sequence format], 
select a post-import format and then tap [OK].

5	 In the import dialog box, tap [Select Import Destination Bin], 
select a bin, and tap [OK].

6	 Tap [Start].
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Import starts. You can check the progress in the transfer screen.
Checking the transfer status►P59 

NOTE •	By default, the system will pause any transfer and conversion 
during a recording or playback. If you want transfer and 
conversion to be performed even during a recording or 
playback, change the setting by [Transfer] -> [Common] on 
the setting screen. Unchecking [Pause file transfers while 
recording or playing out.] enables transfer and conversion 
even during a recording or playback. However, if this option 
is unchecked, the recording/playback operations may not be 
performed normally, therefore, we recommend that you use 
the system with this option checked.
Transfer – common settings►P219 

Checking the transfer status
You can check the status of file transfer or conversion (jobs) in the transfer 
screen.

1	 Tap [Transfer].

¾¾Transfer screen
(2) (3) (4)(1)
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(1) Job list

Displays the list of jobs.

[Clip]
Indicates the name of the clip.

[Status]
Indicates the job progress status.

[Bin]
Indicates the bin name.

[Path]
Indicates media file path and file name.

(2) [Delete]
Deletes selected jobs. If you tap [Delete] 
while executing a job, the job will be 
canceled.

(3) [Clear] Deletes all jobs from the job list.

(4)
1ch view/3ch view/
bin/transfer screen 
common area

1ch view/3ch view/bin/transfer screen 
common area►P44 

Removing medium in removable media
The procedures to remove a medium in the removable media connected to 
your T2 (such as XDCAM professional disc, SxS memory card, and P2 card), 
and to disconnect the folder in the USB removable device are described in 
this part.

1	 Select a drive in the [Browse] tab.

2	 Tap [Menu], and then tap [Disconnect].

3	 A message appears. Tap [OK].

4	 Remove the medium (XDCAM professional disc, SxS memory 
card, or P2 card) from the removable media.

If you want to disconnect your T2 from the removable media, disconnect 
the removable media.
Removing removable media►P61 
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Removing removable media
The procedure to remove a removable media such as USB removable device, 
XDCAM, XDCAM EX, XAVC, XAVC S, P2, etc. from T2 is described in this 
part.
Before removing the removable media you need to disconnect the medium 
or file in the media.
Removing medium in removable media►P60 

1	 Tap [Remove Device].

You can operate it from the bin view, 1ch view, 3ch view, and transfer screen.

2	 Select a removable media, and then tap [Remove].

3	 A message appears. Tap [Yes].

4	 Remove the removable media from T2.

For T2 4K Elite/T2 4K Elite Plus, be sure that the indicator on the left of the 
card slot is turned off before removing the media card from the media card 
reader slot.

TIP •	If the media indicates a status that it is being used and you 
cannot remove it even after tapping [Remove], turn off the T2 
and remove the removable media.

Importing a media file on WatchFolder
A specified folder can be monitored as a WatchFolder (shared folder), 
and when a media file is placed on the WatchFolder, importing starts 
automatically. Folders not only in the internal storage but also in an external 
media/storage can be monitored as a WatchFolder.
The import operation will be easier if the format for the imported file and 
other setting items have been set beforehand.
Transfer settings►P219 
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If necessary, make settings in the setting screen according to the environment 
in use.
Settings►P188 

1	 Tap [General], and then tap the [Share Folder] tab in the setting 
screen.

General – Share Folder settings►P199 

2	 Select a imported bin from list of [Destination].

3	 Specify the folder to be monitored as a WatchFolder.

To specify a folder in the internal storage as a WatchFolder, check [Set folder 
in local storage as watch folder]. A folder named “WatchFolder” will be 
created and shared as a WatchFolder.
To specify a folder in an external media or storage as a WatchFolder, check 
[Set external folder in external media / storage as watch folder.] and specify 
a folder.

4	 Tap [OK].

The WatchFolder will be enabled.

5	 Access the WatchFolder from another PC.

To access a WatchFolder in the internal storage, IP address setting and user 
account are required. To set an IP address, follow steps 1 to 8 in “Uploading 
files to T2/downloading files from T2”.
Uploading files to T2/downloading files from T2►P69 
General – Share Folder settings►P199 

6	 Copy a media file that you wish to import to the WatchFolder.

After copying of the media files has completed, import starts.
Media files copied to the WatchFolder will be deleted after the import 
operation.
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NOTE •	If you copy files that cannot be imported to the WatchFolder in 
the internal storage, the files that cannot be imported will be 
deleted.

•	If you copy files that cannot be imported to the WatchFolder in 
the external storage, the files that cannot be imported will not 
be deleted.

•	If you copy media files to the WatchFolder of the internal 
storage, recording or playback may be affected.

•	If writing does not catch up with importing, recording will stop.

Exporting a file

Exporting contents to a file
The procedure to export a clip or playlist registered in the bin of your T2 to 
a file is described in this part.
At the time of export, you can set whether to export the file in the native 
format or in a converted format.
The export operation will be easier if the format for the exported file and 
other setting items have been set beforehand.
Transfer settings►P219 
If necessary, make settings in the setting screen according to the environment 
in use.
Settings►P188 

NOTE •	For XDCAM, XDCAM EX, XAVC, XAVC S, and P2 sources, 
only the files in each folder that are related to the selected files 
to be imported will be copied. If a file imported as its native 
format is exported with no conversion, the exported file may 
not be properly handled depending on the device.

TIP •	For important notes on exporting, see “Appendix”.
Notes on export and growing clip editing►P260 

•	When exporting a Grass Valley HQX AVI or Grass Valley HQX 
MXF file (including the case when a Grass Valley HQX AVI 
file is converted to Grass Valley HQX/XDCAM/Apple ProRes/
Avid DNxHD MXF file and output), the exported file contains 
the video trimmed between the set In and Out points. When 
exporting other format files, the whole file is exported.
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TIP •	You can convert Grass Valley HQX AVI files to some specific 
formats to export.
Transfer – AVI settings►P223 

•	When exporting a playlist to a file, the file is converted with 
the following features.

-- If several formats are contained, they are converted in one file.
-- A timecode set in a playlist or event properties can be 
retained in each frame of the converted file.

--When exporting files in Grass Valley HQX AVI format, the 
profile (size and frame rate) of the converted file is same as 
the profile of the playlist.

--When exporting files in MXF or MOV, files are converted 
according to the settings of [Advanced AVI transcoding 
settings] in [Transfer] -> [AVI] on the setting screen.
Transfer – AVI settings►P223 

-- The audio gain set for the event in the playlist is maintained 
in the converted clip.

-- Audio is converted into PCM 48kHz 24bit 8ch.
•	You cannot export a playlist that includes a place holder event.
•	If you export (or convert) a Grass Valley HQX AVI file, Grass 

Valley HQX MXF file, or playlist, the marker information set 
with T2 will be recorded to the exported data.

1	 Display the contents in the [Bin] tab.

Displaying the [Bin] tab►P76 

2	 Select an item, tap [Export], and then tap [Export Media Files...].

A message related to export appears. Read the message, and then tap [OK].
The Export dialog box appears.
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¾¾Export dialog box

(2) (4)(3)

(5) (7)(6) (8) (9)

(1)

(1) [Delete] Deletes the selected file from the export list.

(2) [UP] Moves up the selected file.

(3) [DOWN] Moves down the selected file.

(4) [Config.]
Displays the setting screen. Sets the file 
format and others after exported.

(5) Export list
Displays the list of the files to be exported.
[Format] shows the formats of files to be 
exported.

(6) [Export Path:]
Displays the saving destination of the files 
to be exported.

(7) [Select Export 
Folder]

Selects the saving destination of the files to 
be exported.

(8) [Start] Starts export.

(9) [Cancel] Closes the export dialog box.

TIP •	If you export to XDCAM drive (SONY PDW-U1, PDW-U2), you tap 
[Export], and then tap [Export Media Files to XDCAM Drive...].

3	 If necessary, tap [Config.] to set the file format after conversion.

•	If conversion is not necessary, you do not need to change the settings 
in the setting screen. Proceed to step 4.
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•	To convert a Grass Valley HQX AVI file to a specific format to export, 
tap the [AVI] tab and check [Execute transcoding when exporting AVI 
file.]. Make settings in [Advanced AVI transcoding settings], and tap [OK].
Transfer – AVI settings►P223 

•	To export a playlist, tap the [Playlist] tab. From the [File format after 
export:] list, select a post-import format and then tap [OK].
Transfer – Playlist settings►P229 

4	 In the export dialog box, tap [Select Export Folder], select a 
folder, and tap [OK].

5	 Tap [Start].

Export starts. You can check the progress in the transfer screen.
Checking the transfer status►P59 

NOTE •	By default, the system will pause any transfer and conversion 
during a recording or playback. If you want transfer and 
conversion to be performed even during a recording or 
playback, change the setting by [Transfer] -> [Common] on 
the setting screen. Unchecking [Pause file transfers while 
recording or playing out.] enables transfer and conversion 
even during a recording or playback. However, if this option 
is unchecked, the recording/playback operations may not be 
performed normally, therefore, we recommend that you use 
the system with this option checked.
Transfer – common settings►P219 

Exporting contents in T2 format
If you export playlists or clips to the T2 format (TWF file), you can import 
them to another T2 with the playlist or clip information (In/Out points, 
markers, effect, event list, ancillary data, etc.) retained.

TIP •	For important notes on exporting, see “Appendix”.
Notes on export and growing clip editing►P260 

•	TWF file is a file in the ZIP format. If you change the extension 
of the TWF file to “*.zip” and extract it with software for ZIP, 
you can extract it as a media file.

•	You can send/receive playlists and clips directly from T2 to 
other T2 via FTP.
Transferring a file to other T2►P67 

1	 Display the contents in the [Bin] tab.

Displaying the [Bin] tab►P76 
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2	 Select an item, tap [Export], and then tap [Export in T2 Format 
(TWF Files)...].

A message related to export to other T2 appears. Read the message, and 
then tap [OK].
The Export dialog box appears.
Export dialog box►P65 

3	 In the export dialog box, tap [Select Export Folder], select a 
folder, and tap [OK].

4	 Tap [Start].

Export starts. You can check the progress in the transfer screen.
Checking the transfer status►P59 

Transferring a file to other T2

Overview of file transfer function from T2 to T2
You can transfer media files from T2 to other T2 via FTP. If you export 
media files from source T2 to the FTP server of target T2, you can use the 
files from the [Bin] tab on target T2 without import operations.

Registering the FTP server connection settings
Register the FTP server connection setting of the transfer target T2 on the 
transfer source T2.

TIP •	Set target T2 to be used as the FTP server beforehand. Perform 
steps 1 to 8 in “Uploading files to T2/downloading files from 
T2” on target T2.
Uploading files to T2/downloading files from T2►P69 

1	 Tap [Config.].

You can operate it from the bin view, 1ch view, 3ch view, and transfer screen.

2	 Tap [General], and then tap the [FTP] tab.

3	 Tap [Add...].

The FTP destination setting dialog box appears.
FTP destination setting dialog box►P198 

4	 Configure the FTP server settings of T2 (destination), and then 
tap [OK].

In the export dialog box, you can tap [Select Export Folder] to select the FTP 
server of T2 (destination).
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Exporting a file from T2 to T2
Configure the FTP server settings of T2 (destination) before you perform 
export operation.
Registering the FTP server connection settings►P67 
The export operation will be easier if the format for the exported file and 
other setting items have been set beforehand.
Transfer settings►P219 
Make settings in the setting screen according to the environment in use.
Settings►P188 

TIP •	For important notes on exporting, see “Appendix”.
Notes on export and growing clip editing►P260 

1	 Display the contents in the [Bin] tab.

Displaying the [Bin] tab►P76 

2	 Select an item and tap [Export], and then tap [Export Media 
Files...] or [Export in T2 Format (TWF Files)...].

NOTE •	Playlists or clips composed of multiple files cannot be exported 
as the original formats. Export them in the T2 format.

A message related to export or a message related to export to other T2 
appears. Read the message, and then tap [OK].
The Export dialog box appears.
Export dialog box►P65 

3	 If necessary, tap [Config.] to set the file format after conversion.

•	If conversion is not necessary, you do not need to change the settings 
in the setting screen. Proceed to step 4.

•	To convert a Grass Valley HQX AVI file to a specific format to export, 
tap the [AVI] tab and check [Execute transcoding when exporting AVI 
file.]. Make settings in [Advanced AVI transcoding settings], and tap 
[OK].
Transfer – AVI settings►P223 

•	To export a playlist, tap the [Playlist] tab. From the [File format after 
export:] list, select a post-convert format and then tap [OK].
Transfer – Playlist settings►P229 

4	 In the export dialog box, tap [Select Export Folder].

5	 Tap [FTP Server], select the FTP server of T2 (destination), and 
then tap [OK].
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6	 Tap [Start].

Export starts. You can check the progress in the transfer screen.
Checking the transfer status►P59 

Uploading files to T2/downloading files from T2
You can use FTP server to connect devices or edit terminals to your T2 and 
upload/download files.

NOTE •	For the following format files, only single files can be 
uploaded/downloaded.

-- XDCAM: MXF file
-- XDCAM EX: *.mp4 file
-- XAVC: MXF file
-- XAVC S: MP4 file
-- P2 AVC-ULTRA: MXF (OP-1a, OP-Atom) file

•	When uploading files to T2 via FTP, if [File format after 
import:] is set to [AVI (HQX)] for the transfer setting of each 
format, the files will be converted to Grass Valley HQX AVI 
after uploaded.
Transfer settings►P219 

•	If you want to use Japanese for file names, you must set 
the character set of file names to UTF-8  on the FTP client 
side beforehand. Correct file names cannot be displayed if 
the character sets do not match. The configuration method 
depends on your software. Refer to the help etc.

1	 Tap [Config.].

You can operate it from the bin view, 1ch view, 3ch view, and transfer
screen.

2	 Tap [General], and then tap the [Network-1] tab or [Network-2]
tab.

3	 Configure the IP address and DNS server address.

General – Network-1/Network-2 settings►P194 

4	 Tap the [FTP] tab.

69January 1, 2020	 T2 User Manual

Uploading files to T2/downloading files from T2



5	 Tap [Settings...].

The dialog box for FTP setting of T2 appears.
FTP setting dialog box for T2►P198 

6	 Configure the FTP server settings of T2, and then tap [OK].

7	 Tap [Start].

8	 Tap [OK].

9	 Access your T2 from a client.

Enter the IP address you configured in [Network-1] or [Network-2] and the 
user name and password you configured in the dialog box for FTP setting 
of T2, and connect to your T2 via FTP.

10	Upload or download file.

NOTE •	When using the FTP client where disconnection cannot be 
made explicitly such as Windows Explore, connection may 
be terminated due to the restriction of the simultaneous 
connection of clients. In such a case, tap [General] -> the [FTP] 
tab on the setup screen, and tap [Stop], and then tap [Start] 
again.
[FTP] tab►P197 
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NOTE •	Depending on the FTP client, files may be transferred with 
multiple connections simultaneously. When using such an FTP 
client, make sure that the simultaneous connection of clients 
does not exceed the [Max Clients:] value set in the FTP setting 
dialog box of T2.
FTP setting dialog box for T2►P198 

•	By default, the system will pause any transfer and conversion 
during a recording or playback. If you want transfer and 
conversion to be performed even during a recording or 
playback, change the setting by [Transfer] -> [Common] on 
the setting screen. Unchecking [Pause file transfers while 
recording or playing out.] enables transfer and conversion 
even during a recording or playback. However, if this option 
is unchecked, the recording/playback operations may not be 
performed normally, therefore, we recommend that you use 
the system with this option checked.
Transfer – common settings►P219 

Loading and editing T2 contents to editing software
You can load T2 contents to Grass Valley EDIUS, Adobe Premiere Pro, Apple 
Final Cut Pro and Avid Technology Media Composer to edit the data. 

NOTE •	If you want to use Japanese for file names, you must set 
the character set of file names to UTF-8  on the FTP client 
side beforehand. Correct file names cannot be displayed if 
the character sets do not match. The configuration method 
depends on your software. Refer to the help etc.

•	Grass Valley EDIUS is recommended for the editing software.

TIP •	Markers set on T2 clips can be used on EDIUS.
Setting marker►P122 

Downloading and loading a recorded clip
Clips in the bin can be converted to different formats such as MXF (XDCAM 
format) and the converted clips can be downloaded from a client via FTP.
Notes on FTP download and growing clip editing►P261 
Transfer – AVI settings►P223 

1	 Perform steps 1 to 8 in “Uploading files to T2/downloading files 
from T2”.

Uploading files to T2/downloading files from T2►P69 
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2	 Display the contents in the [Bin] tab.

Displaying the [Bin] tab►P76 

3	 Select an item, tap [Menu], and then tap [Convert] -> [Convert to 
(Format after conversion)].

POINT •	To set the format for conversion, go to the setting screen, select 
[Transfer] -> [AVI], and configure the settings in [Advanced 
AVI transcoding settings].
Transfer – AVI settings►P223 

4	 Tap [Yes].

The conversion starts. You can check the progress in the transfer screen.
The new converted clips will be saved in the same bin as their original 
ones.
Checking the transfer status►P59 

5	 Download the converted clip(s) via FTP from a client PC.

6	 Load the downloaded clips to the editing software on the client 
PC.

Downloading and loading a growing clip
Clips can be ingested to MXF format and the growing clips can be 
downloaded from a client via FTP.
Notes on export and growing clip editing►P260 
Notes on record of external device and growing clip editing►P261 
Notes on FTP download and growing clip editing►P261 

NOTE •	Grass Valley EDIUS is recommended for the editing software.

1	 Perform steps 1 to 8 in “Uploading files to T2/downloading files 
from T2”.

Uploading files to T2/downloading files from T2►P69 

2	 Tap [Config.].

72 T2 User Manual	 January 1, 2020

Section 6  ― Import/Export



3	 Tap [R1] and set the compression codec to [(Recorded format)].

4	 Tap [OK].

5	 A message appears. Tap [OK].

A clip being recorded will become available to download on FTP.

6	 Start recording.

7	 Download the clip being recorded via FTP from a client PC.

8	 Load the downloaded clips to the editing software on the client 
PC.

The clip being recorded can be viewed on K2 (FTP) in the EDIUS source browser. 
For the setting procedure of the source browser, refer to the EDIUS manual.
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Directly loading a clip recorded or being recorded (T2 
4K Elite/T2 4K Elite Plus only)
For T2 4K Elite/T2 4K Elite Plus, you can access the direct access folder (the 
media folder in T2 4K Elite/T2 4K Elite Plus) from the client to load clips 
recorded or being recorded.

NOTE •	Only available for T2 4K Elite/T2 4K Elite Plus.
•	Grass Valley EDIUS is recommended for the editing software.
•	Only AVI and MXF format media files can be accessed. 
•	The direct access folder is read-only. Moving and deleting of 

media files on the direct access folder cannot be performed 
from a client. To import media files from a client, use 
WatchFolder, FTP, etc.
Importing a media file on WatchFolder►P61 
Uploading files to T2/downloading files from T2►P69 
General – Share Folder settings►P199 

1	 Perform steps 1 to 3 in “Uploading files to T2/downloading files 
from T2”.

Uploading files to T2/downloading files from T2►P69 

2	 Tap [Config.] and then tap [Share Folder] tab.

3	 Tap [Share a T2 media storage as share folder] in the direct access 
folder to check it..

4	 Tap [OK].

To enable the direct access folder setting, you must restart your T2.
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5	 Access T2 from a client PC and load a clip.

Access the address set as [Network-1] or [Network-2] from the client. The 
media folders are located under the Share folder of T2, and include the 
Default folder and a folder with the same name as the created bin.

NOTE •	A clip with which a sub clip has been created between In-Out 
points is loaded as the original clip that does not have In-Out 
points.
Creating a sub clip between In-Out points (highlight)►P109 

•	The user account used to access the direct access folder can be 
set in [General] -> [Share Folder] in the setting screen.
General – Share Folder settings►P199 
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Section 7
Contents Management

This section describes the operations for contents management using the 
bin.

Managing contents in the bin

Displaying the [Bin] tab
In the [Bin] tab, you can manage the contents loaded to T2 and export 
contents edited with T2.

1	 Tap [Bin].

The bin view appears.

2	 Tap the [Bin] tab.

¾¾ [Bin] tab

(2)

(8) (9) (10)

(6)(3) (7)(1) (4) (5)

(11)

(1) [Preview] Switches on/off of the preview (filmstrip).

(2) View switching tab
Switches between [Bin] tab/[Browse] tab/
[Recycle Bin] tab.

(3) [New Bin] Creates a new bin.
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(4) [Export] Exports the selected contents.

(5) [Delete] Deletes the selected contents.

(6) [>Px]
Loads the selected contents to the Player 
channel.

(7) [Menu] Displays the related menu.

(8) Bin list
Displays the list of bins.
The selected bin is highlighted in blue.

(9) Filmstrip display
By tapping [Preview] and set it on, displays 
the contents in filmstrip with six frames.

(10) Contents list
Displays the list of contents selected in the 
bin list.
The selected item is highlighted in blue.

(11)
1ch view/3ch view/
bin/transfer screen 
common area

1ch view/3ch view/bin/transfer screen 
common area►P44 

TIP •	The IO modes available on your T2 differ depending on the T2 
model type.
IO mode list►P263 

Changing bin name
You can change the name of the bin.

1	 Select a bin in the [Bin] tab.

Displaying the [Bin] tab►P76 

2	 Tap [Menu], and then tap [Rename Folder].

3	 Enter a name for the bin and tap [OK].

Software keyboard►P130 
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Deleting a bin
You can delete a bin and the contents in the bin. The deleted bins are moved 
to the recycle bin.

1	 Select a bin in the [Bin] tab.

Displaying the [Bin] tab►P76 

2	 Tap [Menu], and then tap [Delete Folder].

A message appears and the list of contents in the bin is displayed.

3	 Tap [Yes].

Contents types and icons
The icons that indicate the contents types and common icons, and icons 
displayed regardless of the contents types are described in this section.

¾¾Video clip

¾¾Still image clip

¾¾Playlist

78 T2 User Manual	 January 1, 2020

Section 7  ― Contents Management



¾¾Common icons

(3) (4) (5) (6)

(1) (2)

(7)

(1) Pairing Indicates that pairing is set.

(2) Used in playlist
Indicates that the content is used in the 
playlist.

(3) Lock Indicates that the item is locked.

(4) Available number of 
times of recording

Indicates the number of video that can be 
recorded on the Recorder channel at the 
same time.

(5)

Available number 
of times of 
simultaneous 
playing

Indicates the number of contents that can be 
played back on the Player channels at the 
same time.

(6) Containing alpha 
channel

Indicates that the contents have 
transparency information.

(7) Recording
Indicates that the contents is being 
recorded. The sub clip of recording contents 
is not shown this icon. 

Moving contents to another bin
You can move the contents in the bin to another bin.

1	 Select the bin in the [Bin] tab and display the contents.

Displaying the [Bin] tab►P76 

2	 Select an item, tap [Menu], and then tap [Move].
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3	 Select the destination bin and tap [OK].

Changing the display of contents list
You can switch the display of the contents list between icon display and 
text display.

1	 Tap [Menu], and then tap [View].

2	 Tap [Icon View] or [Text View].

Checking the properties of the contents
The procedure to check the properties of the clips or playlists in the bin is 
described in this part.

1	 Select the bin in the [Bin] tab and display the contents.

Displaying the [Bin] tab►P76 

2	 Select an item, tap [Menu], and then tap [Properties].

The properties of contents are displayed.

¾¾Clip properties

[Clip Info] tab

Displays the clip information.
You can check the clip name, format, In/Out 
points timecode, length, alpha channel presence, 
date of creation, bitrate, etc.
Tapping the entry area allows to change the clip 
name and audio gain. (For still images, the length 
can be changed.)
Checking [Locked] locks the clip from editing.
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[Media Info] tab

The information of media file is displayed.
You can check the file path, clips referenced to 
the media file, and the number of reference clips, 
size, In/Out points timecode, etc.
Tapping [Details...] displays the list of clips 
referenced to the media file and the number of 
reference clips.

[Timecode] tab

Specifies start timecode.
To use the start timecode of a media file, select 
[Source].
To specify a start timecode, select [Specify Start 
Time], tap the entry area, and enter timecode.

¾¾Playlist properties

[Playlist Info] tab

Displays the playlist information.
You can check the playlist name, bin name 
where the playlist is stored, format, length, alpha 
channel presence, date of creation, etc.
Tapping the entry area allows to change the 
playlist name and audio gain.
Checking [Locked] locks the playlist from editing.
To change the playlist type, switch to the 
workstation mode, and then change it.
Changing the playlist type►P180 
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[Timecode] tab

Specifies start timecode.

[Source]
Uses the start timecode of the media file.

[Specify Start Time]
Specifies a desired start timecode. Tap the entry 
area and enter a desired timecode.

[According to event setting]
Uses the timecode set in each event in the playlist.

[All Events] tab

Updates the settings of effect for event starting 
(start effects) and actions or effects for event 
ending (end effects) of all events in the playlist.
Updating playlist effect settings►P116 

3	 Tap [OK].

Releasing pairing of contents
You can release the pairing of contents.
For pairing of contents, refer to “Sync playback of contents (Sync mode)”.
Sync playback of contents (Sync mode)►P101 

1	 Select the bin in the [Bin] tab and display the contents.

Displaying the [Bin] tab►P76 

2	 Select an item, tap [Menu], and then tap [Unpairing].

Converting contents to other formats
You can convert contents to other formats.
A playlist can be converted to a single clip (media file).

NOTE •	If a playlist is converted to a single clip, the effect set to the 
playlist is disabled.
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TIP •	You can convert Grass Valley HQX AVI files to some specific 
formats.
Transfer – AVI settings►P223 

•	Playlists are converted with the following features.
-- If several formats are contained, they are converted in one file.
-- A timecode set in a playlist or event properties can be 
retained in each frame of the converted file.

--When exporting files in Grass Valley HQX AVI format, the 
profile (size and frame rate) of the converted file is same as 
the profile of the playlist.

--When exporting files in MXF or MOV format, files are 
converted according to the settings of [Advanced AVI 
transcoding settings] in [Transfer] -> [AVI] on the setting 
screen.

--When converting playlists to export, files are converted 
according to the settings of [Advanced AVI transcoding 
settings] in [Transfer] -> [AVI] on the setting screen.
Transfer – AVI settings►P223 

-- The audio gain set for the event in the playlist is maintained 
in the converted clip.

-- Audio is converted into PCM 48kHz 24bit 8ch.
•	You cannot convert a playlist that includes a place holder 

event.

1	 Select the bin in the [Bin] tab and display the contents.

Displaying the [Bin] tab►P76 

2	 Select an item, tap [Menu], and then tap [Convert] -> [Convert to 
(converted format)].

3	 Tap [Yes].

The conversion starts.
The new converted clips will be saved in the same bin as their original 
ones.
You can check the progress in the transfer screen. 
Checking the transfer status►P59 
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NOTE •	By default, the system will pause any transfer and conversion 
during a recording or playback. If you want transfer and 
conversion to be performed even during a recording or 
playback, change the setting by [Transfer] -> [Common] on 
the setting screen. Unchecking [Pause file transfers while 
recording or playing out.] enables transfer and conversion 
even during a recording or playback. However, if this option 
is unchecked, the recording/playback operations may not be 
performed normally, therefore, we recommend that you use 
the system with this option checked.
Transfer – common settings►P219 

Checking the recycle bin

Displaying the [Recycle Bin] tab
In the [Recycle Bin] tab, you can restore the deleted contents and completely 
delete the files in the recycle bin.

1	 Tap [Bin].

The bin view appears.

2	 Tap the [Recycle Bin] tab.

¾¾ [Recycle Bin] tab

(2)

(6) (7) (8)

(3)(1) (4) (5)

(9)

(1) [Preview] Switches on/off of the preview (filmstrip).

(2) View switching tab
Switches between [Bin] tab/[Browse] tab/
[Recycle Bin] tab.
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(3) [Empty Recycle Bin]
Deletes all files in the recycle bin.
Note that the deleted contents cannot be 
restored.

(4) [Restore]

Restores contents to the original bin.
When restoring a playlist, if clips linked to 
the playlist are also in the recycle bin, the 
clips are restored at the same time.

(5) [Menu] Displays the related menu.

(6) Recycle bin folder 
list

Displays the list of folders in the recycle 
bin.

(7) Filmstrip display
By tapping [Preview] and set it on, displays 
the contents in filmstrip with six frames.

(8) Contents list
Displays the list of contents in the folder 
selected in the recycle bin folder list.

(9)
1ch view/3ch view/
bin/transfer screen 
common area

1ch view/3ch view/bin/transfer screen 
common area►P44 

Backing up all data to other T2 (full sync backup)

Overview of full sync backup function
T2 data (media files and database) can be synchronized to other (multiple) 
T2 on the network. T2 (slave) data on the sync destination is initialized and 
they are completely synchronized to T2 (master) data.
To synchronize data, set the sync destination T2 (slave) to the slave mode 
(step 1), and then set the sync source T2 (master) to the master mode. (step 2)

Step 1: Setting T2 on the sync destination to the slave 
mode

NOTE •	Set the remote mode to off on both T2 (master and slave) 
beforehand. (You cannot switch the remote mode to on and off 
while transferring files.)

•	Synchronization is not available between T2 devices that have 
different database versions. Database version will be changed 
by such an event as software update.

1	 On the sync destination T2, tap [Bin] or [1ch View].
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2	 Tap [Menu], and then tap [Tools] -> [T2 to T2 Sync backup...].

If contents are being captured or loaded in the Recorder channel or the 
Player channel, a message appears asking whether to unload the contents. 
Tap [OK] to unload the clip.

3	 In [Operating mode] on the [T2 to T2 Sync backup] dialog box, 
select [Slave mode].

Do not close the [T2 to T2 Sync backup] dialog box until the backup 
operation completes.
T2 on the sync destination (slave) is set to the slave mode.
To sync data to multiple T2 (slave), repeat steps 1 to 3 on all of the T2 (slave).

Step 2: Setting T2 on the sync source to the master 
mode for data sync
1	 On the sync source T2, tap [Bin] or [1ch View].

2	 Tap [Menu], and then tap [Tools] -> [T2 to T2 Sync backup...].

If contents are being captured or loaded in the Recorder channel or the 
Player channel, a message appears asking whether to unload the contents. 
Tap [OK] to unload the clip.

3	 In [Operating mode] on the [T2 to T2 Sync backup] dialog box, 
select [Master mode] and tap [Slave configuration...].

T2 on the sync source (master) is set to the master mode.
The number of T2 set to the slave mode is displayed in [Slave count:].

4	 In the [Slave configuration...] dialog box, set the IP address of T2 
set to the slave mode.

•	Tap [Auto Search...] to search for T2 set to the slave mode on the 
network. Select an IP address on the  [Search Results] dialog box, and 
then tap [Add ALL].

•	To set an IP address manually, tap [Add] and enter an IP address.

5	 Tap [Close].

6	 In the [T2 to T2 Sync backup] dialog box, tap [Start Sync].
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7	 A message appears. Tap [OK].

The synchronization starts. You can check the file transfer status on the 
upper progress bar, and the whole status on the lower progress bar.
If you stop synchronization in the middle, tap [Stop]. You can also stop 
synchronization from T2 set to the slave mode.

8	 After the synchronization has completed, click [Close] on the [T2 
to T2 Sync backup] dialog box.

TIP •	If data synchronization has been stopped forcibly by such an 
event as the power off of T2, contents may be displayed with 
the following thumbnail. Such contents cannot be used.

•	If synchronization has been stopped and started again, files 
that are already transferred will be skipped.
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Section 8
Playing/Editing

This section describes operations to play contents in the Player channel and 
to edit playlists.

Displaying Player channel in 1ch view
In the 1ch view of the Player channel, you can perform operations regarding 
contents editing.

1	 Press the [P1] button (or [P2] button).

The display switches to the 1ch view of the Player channel and the [P1] 
button (or [P2] button) lights in green.
You can also switch by tapping [1ch View] and then tapping the Player 
channel tab.
If the clip is loaded to the Player channel, clip view is displayed. And if a 
playlist is loaded, playlist view is displayed.
You can use the operation buttons and jog/shuttle on the lower part of the 
touch screen LCD, to play or to switch playback modes.

¾¾Player channel (clip view) – 1ch view

(2) (8)(9) (10)(4) (6)(3) (5) (7)(1) (11) (12)

(18)

(13)

(15) (16) (17)(14)

** (2) to (18) are common in P2 channel.
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(1) Player channel tab
By tapping, selects and highlights the 
Player channel.

(2) Playback mode

Indicates the current playback mode (sync 
mode, E to E mode, loop playback mode) of 
the Player channel in white characters.
While the Recorder channel is played back 
in E to E mode, the E to E indication is 
shown in blue text.
By tapping, also switches the playback 
mode.
Switching playback mode►P100 

(3) Status Indicates the playback progress status.

(4) [Locked]

Locks Player channel operations.
While the operations are locked, [Locked] 
and [P1] (or [P2] button) buttons light in red.
Tapping it again releases the lock.

(5) Preview

Displays the video currently played back.
Tapping the preview displays in the full 
screen view.
If a clip is not loaded, displays the output 
profile of the channel on the upper left.

(6) [Cur:] Indicates the current timecode.

(7) Playback speed
Indicates the current playback speed 
(times).

(8) Scrubbing bar
Indicates the playback progress status and 
icons/markers for the set In/Out points.

(9) [Rem:]
Indicates the timecode of the remaining 
time.

(10) [Zoom]

Switches the display scale of the scrubbing 
bar.
Tapping it displays [Zoom] in red, and 
displays the In-Out points of the clip as the 
whole scale.
Tapping it again returns the display to the 
original scale and displays the whole clip.

(11) Audio level display Displays the audio playback level.

(12) [Menu] Displays the related menu.

(13) [Playlist View] Switches to the playlist view.
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(14) Operation buttons
Operation buttons of Player channel (clip 
view)►P90 

(15) [Clip:]

Indicates the name of the loaded clip.
Tapping the entry area allows to change the 
clip name.
Software keyboard►P130 

(16) [In:]/[Out:]/[Dur:]

Indicates the timecode of In/Out points and 
duration.
Tapping the entry area allows to set the In 
and Out points or duration.
Software keypad – Timecode►P131 

(17) [Format:]
Indicates the video size of the clip and 
frame rate.

(18)
1ch view/3ch view/
bin/transfer screen 
common area

1ch view/3ch view/bin/transfer screen 
common area►P44 

¾¾Operation buttons of Player channel (clip view)

(2) (4) (6) (7)(3) (5)(1)

(1) [Clear (In/Out)] Clears In/Out points set on the clip.

(2) [Cue(In)] Moves to the In point of the clip.

(3) [Mark(In)]
Sets In point to the current position. After 
In point has been set, the In point icon 
appears on the scrubbing bar.

(4) [Mark(Out)]
Sets Out point to the current position. 
After Out point has been set, the Out point 
icon appears on the scrubbing bar.

(5) [Cue(Out)] Moves to the Out point of the clip.

(6) [Create Subclip]

Creates a sub clip between the set In-Out 
points.
Creating a sub clip between In-Out points 
(highlight)►P109 
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(7) [Set]

Trims the clip between the set In-Out 
points.
Trimming a clip between the set In-Out 
points►P108 

¾¾Player channel (playlist view) – 1ch view

(2) (8) (9) (10)(4) (6)(3) (5) (7)(1) (11) (12)

(20)

(13) (14)(15)

(17) (18) (19)(16)

** (2) to (20) are common in P2 channel.

(1) Player channel tab
By tapping, selects and highlights the 
Player channel.

(2) Playback mode

Indicates the current playback mode (sync 
mode, E to E mode, loop playback mode) in 
white characters.
While the Recorder channel is played back 
in E to E mode, the E to E indication is 
shown in blue text.
By tapping, also switches the playback 
mode.
Switching playback mode►P100 

(3) Status Indicates the playback progress status.

(4) [Locked]

Locks Player channel operations.
While the operations are locked, [Locked] 
and [P1] (or [P2] button) buttons light in red.
Tapping it again releases the lock.
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(5) Preview

Displays the video currently  mounted.
Tapping the preview displays in the full 
screen view.
If a playlist is not loaded, displays the 
output profile of the channel on the upper 
left.

(6) [Cur:]
Indicates the current timecode of the 
playlist.

(7) Playback speed
Indicates the current playback speed 
(times).

(8) Scrubbing bar
Indicates the playback progress status and 
icons/markers for the set In/Out points.

(9) [Rem:]
Indicates the timecode for the remaining 
time of event.

(10) [Add Event]
Adds an event to the playlist.
Creating a playlist►P110 

(11) [Delete Event] Deletes the event selected in the event list.

(12) [Move Up]
Moves up the event selected in the event 
list.

(13) [Move Down]
Moves down the event selected in the event 
list.

(14) [Menu] Displays the related menu.

(15) [Clip View] Switches to the clip view.

(16) Operation buttons
Operation buttons of Player channel (playlist 
view)►P93 

(17) [P.List] / [T.Line]

Indicates the name of the loaded playlist.
Tapping the entry area allows to change the 
playlist name.
Software keyboard►P130 
[P.List]
Playlist in the normal format.
[T.Line]
Playlist in the timeline format.
Changing the playlist type►P180 
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(18) [Current Event:]

Displays the information of the event being 
played.

[In:]/[Out:]/[Dur:]
Indicates the timecode of In/Out points and 
the length of the event (duration).

[Format:]
Indicates the video size and frame rate.

(19) Event list

Displays the list of events in the playlist.
The selected event is displayed with a blue 
frame.
The event being played is highlighted in 
blue.

(20)
1ch view/3ch view/
bin/transfer screen 
common area

1ch view/3ch view/bin/transfer screen 
common area►P44 

¾¾Operation buttons of Player channel (playlist view)

(2) (4) (6)(3) (5)(1)

(1) [Clear (In/Out)]
In the TRIM mode, clears In/Out points set 
on the event to cancel the TRIM mode.

(2) [Cue(In)] Moves to the In point of the event.

(3) [Mark(In)]

In the TRIM mode, sets In point to the 
current position. After In point has been 
set, the In point icon appears on the 
scrubbing bar.

(4) [Mark(Out)]

In the TRIM mode, sets Out point to the 
current position. After Out point has been 
set, the Out point icon appears on the 
scrubbing bar.

(5) [Cue(Out)] Moves to the Out point of the event.

(6) [TRIM]

Switches to the TRIM mode. You can edit 
the In/Out points of the event selected in 
the event list.
Trimming an event►P113 
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Selecting Player channel in 3ch view
When [[HD/SD] 1 in 2 out] is selected in 3ch view, you can view the R1, P1, 
and P2 channels simultaneously.
In 3ch view of Player channel, you can use the operation buttons and jog/
shuttle on the lower part of the touch screen LCD, to play or to switch 
playback modes.

1	 Tap [3ch View].

The display switches to 3ch view.

2	 Tap the Player channel tab.

Player channel is selected and highlighted. The playback operation to the 
selected channel becomes valid.
If the clip is loaded to the Player channel, clip view is displayed. And if a 
playlist is loaded, playlist view is displayed.

¾¾Player channel (clip view) – 3ch view

(2) (8) (9)(4) (6)(3) (5) (7)(1)

** (2) to (9) are common in P2 channel.

(1) Player channel 
tab

By tapping, selects and highlights the Player 
channel.
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(2) Playback mode

Indicates the current playback mode (sync 
mode, E to E mode, loop playback mode) of the 
Player channel in white characters.
While the Recorder channel is played back in 
E to E mode, the E to E indication is shown in 
blue text.
By tapping, also switches the playback mode.
Switching playback mode►P100 

(3) Status Indicates the playback progress status.

(4) [Locked]

Locks Player channel operations.
While the operations are locked, [Locked] and 
[P1] (or [P2] button) buttons light in red.
Tapping it again releases the lock.

(5) Preview
Displays the video currently played back.
If a clip is not loaded, displays the output 
profile of the channel on the upper left.

(6) Audio level 
display

Displays the audio playback level.

(7) [Clip:]

Indicates the name of the loaded clip.
Tapping the entry area allows to change the 
clip name.
Software keyboard►P130 

(8) [Cur:] Indicates the current timecode.

(9) [Rem:] Indicates the timecode of the remaining time.

¾¾Player channel (playlist view) – 3ch view

(2) (8) (9) (10) (11)(4) (6)(3) (5) (7)(1)

** (2) to (11) are common in P2 channel.

(1) Player channel 
tab

By tapping, selects and highlights the Player 
channel.
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(2) Playback mode

Indicates the current playback mode (sync 
mode, E to E mode, loop playback mode) of the 
Player channel in white characters.
While the Recorder channel is played back in 
E to E mode, the E to E indication is shown in 
blue text.
By tapping, also switches the playback mode.
Switching playback mode►P100 

(3) Status Indicates the playback progress status.

(4) [Locked]

Locks Player channel operations.
While the operations are locked, [Locked] and 
[P1] (or [P2] button) buttons light in red.
Tapping it again releases the lock.

(5) Preview
Displays the video currently played back.
If a playlist is not loaded, displays the output 
profile of the channel on the upper left.

(6) Audio level 
display

Displays the audio playback level.

(7) [P.List:]/[T.Line]

Indicates the name of the loaded playlist.
Tapping the entry area allows to change the 
playlist name.
Software keyboard►P130 
[P.List]
Indicates a playlist in the standard format.

[T.Line]
Indicates a playlist in the timeline format.
Changing the playlist type►P180 

(8) [Now:] Indicates the name of the current event.

(9) [Next:] Indicates the name of the next event.

(10) [Cur:] Indicates the current timecode of the playlist.

(11) [Rem:]
Indicates the timecode of the remaining time of 
event.
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Loading contents to Player channel
The procedure to load the contents in the bin to the Player channel is 
described in this part.
Contents loaded to the Player channel can be performed playback or editing 
of In/Out points.

1	 Select the bin in the [Bin] tab and display the contents.

Displaying the [Bin] tab►P76 

2	 Select an item and tap [>Px].

The item is loaded to the Player channel.
If the clip is loaded to the Player channel, clip view is displayed. And if a 
playlist is loaded, playlist view is displayed.
Player channel (clip view) – 1ch view►P88 
Player channel (playlist view) – 1ch view►P91 

TIP •	To unload contents, display the Player channel in 1ch view, tap 
[Menu], and then tap [Unload].

Playing back video

Playing back with operation buttons
You can play the video of the selected channel using the operation buttons.

1	 Press the [Play] button.

Control buttons►P29 
During the playback, the [Play] button lights up.

Playing back in variable speed mode (variable playback)
You can play the video of the selected channel in the variable speed mode.

1	 Press the [VAR] button.

Control buttons►P29 
The mode switches to the variable speed mode and VAR speed control is 
displayed.
While in the variable speed mode, the [VAR] button lights up.
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¾¾VAR speed control
(2)

(4)(3)

(1) (1)

(1) [<]/[>]
By every tap, increases or decreases the 
playback speed by 0.1 time.

(2) Speed control bar
By tapping on the speed control bar, 
specifies the playback speed within the 
range of -2 to +2 times.

(3) [Play Speed:] Indicates the current playback speed.

(4) [Close]

Closes the VAR speed control.
Even after closing the VAR speed control, 
you can perform variable speed playback 
by operating the jog/shuttle.

2	 Press the [Play] button.

3	 Tap the speed control bar and move it.

Steps 2 and 3 can also be operated by the jog/shuttle.

Playing back in jog/shuttle mode
You can fast forward or rewind the video of the selected channel using jog/
shuttle operations.
The playback speed changes by the operating angle of jog/shuttle.

1	 Press the [SHTL/JOG] button.

Control buttons►P29 
The mode switches to the jog/shuttle mode and the [SHTL/JOG] button 
lights up.

2	 Turn the jog/shuttle.

Turn to the right to fast forward, and turn to the left to rewind.
Depending on the angle to turn the jog/shuttle, the speed can be switched 
from 0.13 to 32 times (7 levels) for the right side, and from -0.13 to -32 times 
(7 levels) for the left side.

TIP •	The maximum speed of the shuttle (16 times/32 times) can be 
changed.
Miscellaneous – Jog/Shuttle settings►P233 
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Loading and playing back video currently recorded (chasing 
playback)

The video currently recorded in the Recorder channel can be loaded and 
played on the Player channel.
If you only want to load the currently recorded video and do not want to 
play it back, you do not need to perform steps 1 to 4.

NOTE •	Chasing playback of video while being recorded is enabled 
only in the [[HD/SD] 1 in 2 out] mode.

1	 Tap [Config.].

You can operate it from the bin view, 1ch view, 3ch view, and transfer screen.

2	 Tap [P1] (or [P2]), and then tap [Video].

Player – Video settings►P213 

3	 In [Auto play mode:], tap and check [Auto Play].

4	 Tap [OK].

5	 Press the [P1] button (or [P2] button).

6	 Switch to the clip view.

If the playlist view is displayed, tap [Clip View] to switch the display.

7	 Tap [Menu], and then tap [Now recording].

The video currently recorded in the Recorder channel are loaded to the 
Player channel and played back automatically.

TIP •	Clicking the [Move to next edit point] button during chasing 
playback in the workstation mode moves the playback to the 
latest recording point.
Operation buttons of Player channel►P156 
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Switching playback mode

Outputting currently recorded video with active 
through (E to E mode)
If the E to E mode is set to on in the Player channel, you can output video 
currently recorded in the Recorder channel to the Player channel with 
active through.

NOTE •	The video format of the Player channel set to the E to E mode 
and that of the Recorder channel must be the same.
Recorder – Input Settings►P207 
Player – Video settings►P213 

•	E to E mode is only available while in the [[HD/SD] 1 in 2 out] 
mode.

•	Prior setting is necessary. From the setting screen, go to 
[General] -> [Hardware] tab, and select [Input] for [Reference:].
General – Hardware settings►P189 

1	 Tap the Player channel tab.

2	 Tap the playback mode, and then tap [E to E] from the menu.

[E to E] in the menu is checked and [E to E] in the Player channel tab is 
displayed in white characters.

3	 On the channel selected in step 1, stop the playback of contents 
or unload it.

The video currently recorded is output when the playback of contents has 
been stopped or loading of contents is not executed.
While the video currently recorded is being output, the [E to E] indication 
on the Player’s channel tab is shown in blue text.

TIP •	You can also perform the same operation by tapping [Menu] 
in the 1ch view of Player channel, and then tapping [Playout 
Mode] -> [E to E].
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Loop playback of contents (Loop mode)
If the Loop mode is set to on in the Player channel, you can perform loop 
playback of the contents played on the Player channel.

1	 Tap the Player channel tab.

2	 Tap the playback mode, and then tap [Loop] from the menu.

[Loop] in the menu is checked and [Loop] in the Player channel is displayed 
in white characters.

TIP •	You can also perform the same operation by tapping [Menu] 
in the 1ch view of Player channel, and then tapping [Playout 
Mode] -> [Loop].

3	 Play the contents selected in step 1.

Sync playback of contents (Sync mode)
By pairing two contents and setting sync mode to on, the playback status of 
the two contents can be synchronized.
You can use this function in such cases as when you want to synchronize 
and play the L side and R side of a video.

NOTE •	Sync mode is only enabled when the combination of P1/P2 
channels is used.

•	Media files in the removable media cannot be paired.
•	A combination of playlist and clip cannot be paired.
•	The E to E mode and sync mode cannot be set to on at the same time.
•	In sync mode, only the following operations are available.

-- Normal or variable speed playback
-- Stopping playback
-- Forwarding/rewinding frame by frame
--Moving to an In/Out point
-- Setting markers, moving to markers

1	 Load contents to the P1 channel.

Loading contents to Player channel►P97 
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2	 Load the contents to be synchronized with the contents loaded in 
step 1 to P2 channel.

3	 Tap the P2 channel tab.

4	 Tap the playback mode, and then tap [Sync] from the menu.

[Sync] in the menu is checked and [Sync.] in the P2 channel tab is displayed 
in white characters.

TIP •	You can also perform the same operation by tapping [Menu] in the 
1ch view of P2 channel, and then tapping [Playout Mode] -> [Sync].

•	If the output settings of the P1 channel and P2 channel are 
different, the setting of the P2 channel will be automatically 
changed to be the same as that of the P1 channel.

5	 A message appears. Tap [Yes].

The contents mounted on the P1 and P2 channels are paired.

6	 Select the P1 channel and press the [Play] button.

Contents loaded on the P2 channel is played back, being synchronized with 
the contents loaded on the P1 channel.

TIP •	To release the pairing of contents, operate in the [Bin] tab.
Releasing pairing of contents►P82 
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Playback of contents with alpha channel (Fill/Key 
signal output mode)
You can play contents with transparency information (alpha channel).

NOTE •	Fill/Key signal output mode is only enabled when the 
combination of P1/P2 channels is used.

1	 Load the contents with alpha channel to the Player channel.

Loading contents to Player channel►P97 
The mode switches to the Fill/Key signal output mode. Fill is output to the 
loaded channel, and Key is output to the other channel.
The icons indicating Fill and Key appear on the Player channel tabs respectively.

Fill

Key

2	 Play the contents on the channel where Fill is output.

Playback operations of clips with alpha channel can be performed only on 
the Fill side channel.
When you play a playlist that contains clips with alpha channel, the system 
enters the Fill/Key signal output mode and the Key side channel will output 
a white screen for normal clip playback.

TIP •	If a clip with alpha channel is added to the playlist in the 
normal mode, the mode switches to the Fill/Key output mode 
after unmounting. The video may be disrupted due to the 
output signal loss when the modes are switched, however, this 
is not a system failure.
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TIP •	The following operations are available while a clip with alpha 
channel is loaded.

--Moving to an In/Out point
-- Setting an In/Out point
-- Creating a sub clip (you cannot create a sub clip of a still 
image clip with alpha channel)

--Moving to the first frame, frame reverse, stop, playback, 
frame forward, moving to the last frame, fast forward, 
rewind, and variable speed playback

-- Scrubbing bar operation (workstation mode only)
-- Setting a fade in effect (applied to the Key side)/fade out 
effect (applied to the Key side)/actions (pause, loop) to an 
event in a playlist

-- Setting markers, moving to markers
•	The following operations are not available while a clip with 

alpha channel is loaded.
-- Switching to the TRIM mode in the playlist view

•	You can also play clips with alpha channel using the remote 
control with AMP commands.

Changing on-screen display indication

Showing on-screen display
Additional information (such as timecode and audio level meter) can be 
shown on Player channel preview of the T2 screen or on the output video 
from the SDI terminal.

1	 Press the [P1] button (or [P2] button).

Select a Player channel to show on-screen display.
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2	 Tap [Menu], and then tap [On Screen Display] -> [Both] or [PC 
Preview only].

•	Tapping [Both] shows on-screen display both on the Player channel 
preview of the T2 screen and on the output video from the SDI 
terminal.

•	Tapping [PC Preview only] shows on-screen display only on the Player 
channel preview of the T2 screen.

Configuring display content of on-screen display
1	 Press the [P1] button (or [P2] button).

2	 Tap [Menu], and then tap [On Screen Display] -> [Settings...].
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¾¾On-screen display detailed settings dialog box

[Channel:] Indicates the channel to be configured.

[Display]

Sets items to show.

[Current timecode]
By checking, shows the current timecode.

[Remain timecode]
By checking, shows the timecode by remaining time.

[Level meter]
By checking, shows the audio playback level.

[Background]
By checking, shows background screen for on-
screen display.

[Size and position]

Sets the position to show and text size.

[Size:]
Selects text size.

[Horizontal alignment]
Selects horizontal position for display.

[Vertical alignment]
Selects vertical position for display.

[Margin]
By checking, shows on-screen display slightly 
inside from the screen edge.

3	 Set display indication contents and tap [OK].
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Editing a clip

Setting In and Out points to a clip
You can set In and Out points to a clip.
If In and Out points have been set to a clip, you can move to the set In point 
or Out point, trim between In-Out points, or save it as a sub clip.

1	 Load a clip to the Player channel.

Loading contents to Player channel►P97 

2	 Play a clip and tap [Mark(In)] when you want to set the In point.

Operation buttons of Player channel (clip view)►P90 
The In point is set to the current position. A icon appears in the In point 
position on the scrubbing bar.

3	 Play a clip and tap [Mark(Out)] when you want to set the Out 
point.

The Out point is set to the current position. A icon appears in the Out point 
position on the scrubbing bar.

TIP •	You can also specify In and Out points with the timecode. Tap 
the entry area of [In:] and [Out:], and enter the timecode.
Player channel (clip view) – 1ch view►P88 
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Trimming a clip between the set In-Out points
If set In and Out points are fixed, you can trim a clip between the In/Out 
points.

1	 Set In and Out points to a clip.

Setting In and Out points to a clip►P107 

2	 Tap [Set].

Operation buttons of Player channel (clip view)►P90 
The information of the In-Out points for the clip is updated with the set In 
and Out points. The space between the In-Out points is displayed in a pale 
white bar.

TIP •	To change the trimmed video between In-Out points, set In 
and Out points to the clip again, and then tap [Set].
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Creating a sub clip between In-Out points (highlight)
You can create a sub clip between set In-Out points and save it as a separate 
clip.

1	 Set In and Out points to a clip.

Setting In and Out points to a clip►P107 

2	 Tap [Create Subclip].

Operation buttons of Player channel (clip view)►P90 
A sub clip including video between the set In and Out points is created and 
saved in the same bin as the original clip.

Cutting out a still image clip
You can cut out the current position of the clip that is mounted on the Player 
channel as a still image clip.

1	 Move to the position you wish to cut out as a still image.

2	 Tap [Menu] in the clip view and then tap [Create Still Clip].

3	 A still image clip is saved in the same bin as the clip being 
mounted.

The duration of the still image clip is applied according to the time period 
of seconds set for [Duration (still image)] in the [Common] tab of [Transfer] 
in the setting screen.
Transfer – common settings►P219 

NOTE •	You cannot cut out still image clips from clips mounted 
directly from an external storage, etc.

TIP •	In the workstation mode, right-click on the preview window, 
and click [Create Still Clip].

•	In the workstation mode, still image clips are stored in the 
selected bin.



Checking clip properties
You can check the properties of the clip loaded to the Player channel.

1	 Tap [Menu] in the clip view, and then tap [Properties].

The properties of the clip are displayed.
Clip properties►P80 

Changing a clip name
You can change the name of the clip loaded to the Player channel.

1	 Tap [Menu] in the clip view, and then tap [Rename].

2	 Enter a name and tap [OK].

Software keyboard►P130 

Updating thumbnails of clips
You can update the thumbnail images of the clips displayed on the contents 
list in the bin view to the image of the current position.

1	 Tap [Menu] in the clip view, and then tap [Set Thumbnail Frame].

Editing a playlist

Creating a playlist
You can create a playlist including multiple contents.
To create a playlist, add contents to the playlist view on the Player channel. 
The contents added on the playlist are called event.
The procedure to create a new playlist is described in this part.

TIP •	You can add a playlist to another playlist as an event. The 
added playlist is called playlist event. 
If you add a playlist which contains a playlist event to another 
playlist, a message appears. Select an adding method of a 
playlist event.

•	Playlists includes normal format and timeline format playlists. In a 
playlist in the normal format, each events are added without creating 
spaces. In a playlist in the timeline format, events can be added to a 
desired position on the timeline by specifying the timecode.

•	Creating or editing of a playlist in the timeline format can be 
performed only in the workstation mode.
Changing the playlist type►P122 
Editing playlist in the timeline format►P182 
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1	 Press the [P1] button (or [P2] button).

2	 Switch to the playlist view.

If the clip view is displayed, tap [Playlist View] to switch the display.

3	 Tap [Add Event].

Player channel (playlist view) – 1ch view►P91 
The dialog box to add an event appears.

TIP •	To add contents to an existing playlist, select an event immediately 
before the position to add the contents and tap [Add Event].

4	 Tap [Select Bin].

5	 Select a bin that includes the contents to be added to the playlist 
and tap [OK].

6	 Select contents in the dialog box to add an event and tap [Add].

7	 Repeat steps 4 to 6.

8	 Tap [Close].

The contents are registered as events in the playlist by the added order.
Playlists are saved in the bin selected in step 5 with the name “Play (serial 
number)”.
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Deleting an event from a playlist
You can delete an event from a playlist.
Even after events have been deleted from the playlist, the original contents 
will not be deleted.

1	 Tap and select an event to delete in the playlist view.

The selected event is displayed with a blue frame.

2	 Tap [Delete Event].

Player channel (playlist view) – 1ch view►P91 

Playing back a playlist
You can load a playlist to the Player channel and play it.

1	 Load a playlist to the Player channel.

Loading contents to Player channel►P97 
When you load a playlist to the Player channel, the playback position 
automatically moves to the In point of the first event.
Double-tapping a desired event can move the playback position to the In 
point of the event.

2	 Press the [Play] button.

Playing back video►P97 
The event being played is highlighted in blue.

Icons for events
The icons displayed in the thumbnails are described in this part.

¾¾Event icons
(1) (2)

(3)

(5)

(4)

(1) Fade in Indicates that fade in is set.
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(2) Fade out Indicates that fade out is set.

(3) Pause
Indicates that the playback stop operation 
of the event is set to pause.

(4) Place holder 
Indicates that a place holder is set.
Adding place holder to playlist►P118 

(5) Loop playback Indicates that loop playback is set.

Trimming an event
In the TRIM mode, you can trim an event by setting In and Out points to 
the event.

1	 Double-tap and select an event to trim in the playlist view.

2	 Tap [TRIM].

The mode switches to the TRIM mode.

3	 Play an event and tap [Mark(In)] when you want to set the In 
point.

Operation buttons of Player channel (playlist view)►P93 
The In point is set to the current position. A icon appears on the In point 
position on the scrubbing bar.

4	 Play an event and tap [Mark(Out)] when you want to set the Out 
point.

The Out point is set to the current position. A icon appears on the Out point 
position on the status bar.

5	 Tap [TRIM].

The TRIM mode exits, and the event is trimmed between the set In-Out 
points.
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Setting effects on an event
You can set effects at the event start point (start effect) or the effect at the 
event end point (end effect).

1	 Tap and select an event in the playlist view.

The selected event is displayed with a blue frame.

2	 Tap [Menu], and then tap [Event Effect].

3	 To set a start effect, tap the [Start Effect] tab and set each item.

¾¾Event – [Start Effect] tab

[Fade In]

To set a fade in effect, check [Fade In] and select an 
action from the list.
•	[Fade in (from black)]

Sets a fade in effect from a black screen.
•	[Fade in (from white)]

Sets a fade in effect from a white screen.
Tap the entry area of [Fade Time] and enter the number 
of frames from the start point to the end point.

4	 To set an end effect, tap the [End Effect] tab and set each item.
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¾¾Event – [End Effect] tab

[Fade Out]

To set a fade out effect, check [Fade Out] and select an 
action from the list.
•	[Fade out (to black)]

Sets a fade out effect to a black screen.
•	[Fade out (to white)]

Sets a fade out effect to a white screen.
Tap the entry area of [Fade Time] and enter the number 
of frames from the start point to the end point.

[Action]

To set an end action for playback, check [Action] and 
select an action from the list.
•	[Pause (show black)]

Pauses the playback with a black screen displayed.
•	[Pause (show white)]

Pauses the playback with a white screen displayed.
•	[Pause (show last frame)]

Pauses the playback with the last frame displayed.
•	[Pause (show next event frame)]

Pauses the playback with the first frame of the next event 
displayed.

•	[Pause (show E to E)]
Displays the video currently input to the Recorder 
channel with active-through output.

•	[Loop]
Plays back the event in loop.

5	 Tap [Apply].

TIP •	If you set the effects as an event template of playlist, the 
template setting is applied to newly added events.
General – Miscellaneous settings►P202 
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Updating playlist effect settings
You can collectively set effects for event starting (start effects) and actions 
or effects for event ending (end effects) to all events in the playlist.
You can also collectively delete effects set to the events.

1	 Display the playlist properties.

Checking playlist properties►P120 
Checking the properties of the contents►P80 

2	 Tap the [All Events] tab.

¾¾Playlist – [All Events] tab

[Change start 
effects:]

Check it when you want to update the setting of 
start effects.

[Remove all start effects]
Deletes start effects set to the event.

[Add start effect to every event]
Updates start effects (fade in) set to the event.
To set a fade in effect, check [Fade In] and select 
an action from the list.
•	[Fade in (from black)]

Sets a fade in effect from a black screen.
•	[Fade in (from white)]

Sets a fade in effect from a white screen.
Tap the entry area of [Fade Time] and enter the number 
of frames from the start point to the end point.
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[Change end 
effects:]

Check it when you want to update the setting of 
end effects.

[Remove all end effects]
Deletes end effects set to the event.

[Add end effect to every event]
Updates the end effects (fade out or end action for 
playback) set to the event.
To set a fade out effect, check [Fade Out] and 
select an action from the list.
•	[Fade out (to black)]

Sets a fade out effect to a black screen.
•	[Fade out (to white)]

Sets a fade out effect to a white screen.
Tap the entry area of [Fade Time] and enter the number 
of frames from the start point to the end point.
To set an end action for playback, check [Action] 
and select an action from the list.
•	[Pause (show black)]

Pauses the playback with a black screen displayed.
•	[Pause (show white)]

Pauses the playback with a white screen displayed.
•	[Pause (last frame)]

Pauses the playback with the last frame displayed.
•	[Pause (next event)]

Pauses the playback with the first frame of the 
next event displayed.

•	[Pause (show E to E)]
Displays the video currently input to the 
Recorder channel with active-through output.

•	[Loop]
Plays back the event in loop.

3	 Set each item and tap [OK].
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Adding place holder to playlist
Place holder is the temporary event that can be replaced to a clip event later. 
The length of the event can be set as desired in event properties. 

TIP •	Adding and replacing a place holder event is available only in 
the workstation mode.

1	 Right-click on a desired event and click [Placeholder] -> [Insert 
into] -> [Before] or [After].

A place holder is added before or after the event, and a down arrow icon is 
displayed on the place holder.

TIP •	Alternatively, right-click on the playlist without selecting any 
event, and then click [Placeholder] -> [Insert at the tail], to add 
a place holder.

•	Select [Placeholder] -> [Insert at the tail] from [Playlist Menu] 
to create a new playlist containing a place holder event.
Player channel (playlist view) – 2ch/3ch view►P155 

•	You can make settings for adding a place holder event.
[Playlist Placeholder] dialog box (workstation mode only)►P205 

The properties of the place holder are displayed.
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¾¾Properties of place holder

[Event Info] tab

Displays the information on the place holder.
You can check the event name, event type, In/Out 
points, duration, alpha channel presence, the name of 
the contents being linked, etc.
You can change the event name and duration.

[GPI] tab

When controlling an external device with GPI 
output, allows to check or set the trigger event 
actions. (Only for P1 channel.)
Controlling external devices from T2 with GPI 
output►P241 

[Timecode] tab

Specifies start timecode of an event. (Enabled when 
[According to event setting] is selected on the 
[Timecode] tab in the playlist property.)
To use the start timecode of a media file, select 
[Source].
To specify a start timecode, select [Specify start time], 
tap the entry area, and enter timecode.

[Start Effect] tab
Allows to check or set the effects for event starting 
(start effects).
Setting effects on an event►P114 

[End Effect] tab
Allows to check or set the effects for event ending 
(end effects).
Setting effects on an event►P114 

2	 Set each item and click [OK].
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Replacing place holder on playlist
You can replace a set place holder to a clip.

1	 Click the bin that includes the clip to be replaced with from the 
bin list on the [Bin] tab, and then click the clip to be replaced with 
from the contents list.

[Bin] tab►P76 

2	 Right-click on the place holder, click [Placeholder] -> [Replace], 
and then click the clip to be replaced with.

The place holder is replaced with the clip.

TIP •	Alternatively, drag & drop the clip that is selected on the 
contents list in the bin list to  in a place holder, to replace a 
place holder with a clip. 
Replacing place holder by drag & drop operation►P171 

•	You can make settings for replacing a place holder event.
[Playlist Placeholder] dialog box (workstation mode only)►P205 

Changing a playlist name
You can change the name of the playlist loaded to the Player channel.

1	 Tap [Menu] in the playlist view, and then tap [Rename].

2	 Enter a name and tap [OK].

Software keyboard►P130 

Checking playlist properties
You can check the properties of the playlist loaded to the Player channel.

1	 Tap [Menu] in the playlist view, and then tap [Properties].

The properties of the playlist are displayed.
Playlist properties►P81 

Checking event properties
You can check the properties of events in the playlist loaded to the Player 
channel.

1	 Tap and select an event in the playlist view.

The selected event is displayed with a blue frame.

2	 Tap [Menu], and then tap [Event Properties].
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The properties of the event are displayed.

¾¾Event properties

[Event Info] tab

Displays the information of the event.
You can check the event name, event type (clip or 
playlist), In/Out timecode, length, alpha channel 
presence, the name of the contents being linked, etc.
Tapping the entry area allows to change the event 
name and audio gain. (For still images, the length 
can be changed.)

[GPI] tab

When controlling an external device with GPI 
output, allows to check or set the trigger event 
actions. (Only for P1 channel.)
Controlling external devices from T2 with GPI 
output►P241 

[Timecode] tab

Specifies start timecode of an event. (Enabled 
only when [According to event setting] is selected 
in the [Timecode] tab in the playlist properties.)
To use the start timecode of a media file, select 
[Source].
To specify a start timecode, select [Specify Start 
Time], tap the entry area, and enter timecode.

[Start Effect] tab
Allows to check or set the effects for event 
starting (start effects).
Setting effects on an event►P114 

[End Effect] tab
Allows to check or set the effects for event ending 
(end effects).
Setting effects on an event►P114 

3	 Tap [OK].
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Changing the playlist type
You can select the playlist type (normal or timeline format). The playlist 
type can be changed only in the workstation mode.
Changing the playlist type►P180 

Setting marker
You can set markers with comments on a content being played back or a 
clip being recorded.
If markers are set, you can quickly cue up to a desired timecode position.

NOTE •	To record the marker information that are added after 
recording has stopped to the file with T2, perform one of the 
following operations.

-- Convert or export to Grass Valley HQX AVI or Grass Valley 
HQX MXF

-- Convert to MXF
•	If an MXF (XDCAM format) file with markers has been 

exported to the XDCAM drive (SONY PDW-U1, PDW-U2), the 
marker information will not be recorded in the metadata.

TIP •	T2 marker information will be recorded in the following cases. 
You can use the marker information on EDIUS.

--When markers are added on a clip that is being recorded with 
T2 (including when recording to an external folder or time-shift 
editing with EDIUS using direct access folder is being performed)

--When a clip with markers is converted or exported to Grass 
Valley HQX AVI or Grass Valley HQX MXF

--When a clip with markers is converted to MXF
--When a playlist including a clip event with markers is 
converted to Grass Valley HQX AVI or MXF

•	If a file that contains the following settings in the metadata 
of XDCAM or P2 source is imported, it will be imported as 
markers for T2.

-- Essence marks in the metadata of XAVC or XAVC S
-- Essence marks in the metadata of XDCAM or XDCAM EX
--Memo list in the metadata of P2

Note that the markers set with T2 cannot be reflected in the 
original media file.

•	In the workstation mode, you can assign keyboard shortcuts to 
marker operations or assign commands to mouse operations.
Changing keyboard shortcut assignment►P172 
Assigning commands to mouse operation►P174 
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Showing marker list
You can display the marker list of the contents mounted on the Player 
channel.

1	 Mount contents to the Player channel.

Loading contents to Player channel►P97 

2	 Tap [Menu], [Tools], and then [Show Marker List].

The marker list will be displayed.

¾¾Marker list
(1) (2) (3) (4) (5) (6) (7) (8)

(1) Add marker buttons

Adds a marker to the current position.
After a marker has been added, a triangular 
marker icon appears on the scrubbing bar.
Add marker buttons►P125 

(2) [Delete marker] Deletes markers selected on the marker list.

(3) [Edit marker]

Displays the [Edit Marker] dialog box.
You can edit timecodes and comments of 
markers.
Edit (add) marker dialog box►P126 

(4) [Move to previous 
marker]

Moves to the position of the marker 
previous to that selected in the marker list.

(5) [Move to next marker]
Moves to the position of the marker next to 
that selected in the marker list.

(6) [Setting]
Displays the [Marker] dialog box.
[Marker] dialog box►P124 

(7) Marker list

Displays the No., timecodes, and comments 
of markers.
For markers set in a playlist, the event name 
will be displayed.

(8) [Close] Closes the marker list.
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¾¾ [Marker] dialog box

[Show add marker dialog 
when new marker is 
added]

By checking, displays the add marker 
dialog box when a marker is added.
Edit (add) marker dialog box►P126 

[Show marker icons on the 
scrub bar]

By unchecking, hides the triangular marker 
icon that appears on the scrubbing bar.

[When moving to edit point :]
In the workstation mode, selects whether 
to include markers to the edit points when 
[Move to previous edit point] or [Move 
to next edit point] of the Player channel 
operation buttons is clicked.

[Marker Comment List :]

By tapping [Edit...], displays the dialog box 
to edit marker comment list to allow editing 
of marker comments.
Marker comment list edit dialog box►P127 

Showing marker list of clip being recorded
You can display the marker list of a clip that is being recorded.

1	 Start recording in the Recorder-VTR or Recorder-live mode.

Recording by VTR control (Recorder-VTR mode)►P46  
Recording live video (Recorder-live mode)►P48  

2	 Tap [Menu], [Tools], and then [Show Marker List].

The marker list will be displayed.
Marker list►P123 
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Adding marker
This section shows the procedure to add a marker.
If marker comments are set in advance, you can quickly add a marker with 
comment while recording or playback.
Setting marker comment►P127 

TIP •	Markers can be set to the following files.
-- Clip being recorded with T2
-- Clips on T2
-- Clip event in a playlist on T2 (cannot set as playlist event)
--Media files in the removable media (marker information 
cannot be imported to T2)

1	 Display the marker list.

Showing marker list►P123 
Showing marker list of clip being recorded►P124 

2	 While content is being played back (or while clip is being 
recorded), tap the add marker button at the point when the 
marker is to be added.

¾¾Add marker buttons

(1) (2) (3) (4) (5)

(1) [Add Marker]

Adds a marker (with no comment).
If you want to add a comment at the time 
when a marker is added, check [Show add 
marker dialog when new marker is added] 
in the [Marker] dialog box.
[Marker] dialog box►P124 

(2) [Add Marker with 
Comment (0-9)]

By tapping and selecting [1] to [9], adds a 
marker with a preset marker comment (1 to 
9). (When [0] is selected, a marker without 
comment is added.)

(3) [Add Marker with 
Comment 1]

Adds a marker with a preset marker 
comment 1.

(4) [Add Marker with 
Comment 2]

Adds a marker with a preset marker 
comment 2.

(5) [Add Marker with 
Comment 3]

Adds a marker with a preset marker 
comment 3.
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A triangular marker icon appears on the scrubbing bar.

The markers added will be displayed in the marker list (No., timecodes, 
and comments). For a marker set to a clip event in playlist, the event name 
will be displayed.

Editing marker comment or timecode
1	 Display the marker list.

Showing marker list►P123 
Showing marker list of clip being recorded►P124 

2	 Tap and select a marker to edit on the marker list.

The yellow-green marker icon on the scrubbing bar indicates that the 
marker is selected.

3	 Tap [Edit marker].

Marker list►P123 
The edit (add) marker dialog box appears.

¾¾Edit (add) marker dialog box

[Event Name :]
For markers set in a playlist, displays the event 
name.

[Timecode:]
For a marker set to the contents mounted on the 
Player channel, tapping the entry area allows to 
change the timecode.

[Comment :]

Displays the marker comment that is set.
Tapping the entry area allows to edit the 
comment.
Alternatively, tapping [...] allows to select a preset 
marker comment (1 to 9).
Setting marker comment►P127 
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[OK]
Closes the setting screen with saving the current 
settings.

[Cancel]
Closes the setting screen without saving the 
current settings.

[Apply]
Saves the current settings. You can keep on 
making settings of other items.

4	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.

Setting marker comment
If marker comments are set in advance, you can quickly add a marker with 
comment while recording or playback.
You can set nine marker comments.

1	 Display the marker list.

Showing marker list►P123 
Showing marker list of clip being recorded►P124 

2	 Tap [Setting] in the marker list.

3	 In the [Marker] dialog box, tap [Edit...].

Marker comment list edit dialog box appears.

¾¾Marker comment list edit dialog box

(2)

(1)

(3)

(5)

(4)

(6) (7) (8)

(1) Marker comment list
Displays the list of marker comments (1 to 
9).
(No comment can be set for [0:].)

(2) [Up] Moves up the selected marker comment.
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(3) [Down] Moves down the selected marker comment.

(4) [Comment :]

Displays the comment selected in the 
marker comment list.
Tapping the entry area allows to enter a 
comment.

(5) [Change]
Changes the comment to that you enter in 
the entry area of [Comment :].

(6) [OK]
Saves the current settings and closes the 
setting screen.

(7) [Cancel]
Closes the setting screen without saving the 
current settings.

(8) [Apply]
Saves the current settings. You can keep on 
setting other marker comments.

4	 Tap one of [1:] to [9:] on the marker comment list, and then tap 
the entry area of [Comment :].

5	 Enter a marker comment, and then tap [OK].

Software keyboard►P130 

6	 Tap [Change].

The entered comment is reflected in the marker comment list.

7	 Tap [OK].

Tap [Apply], and then you can keep on setting other marker comments.

Deleting marker
1	 Display the marker list.

Showing marker list►P123 
Showing marker list of clip being recorded►P124 

2	 Tap and select a marker to delete from the marker list.

The yellow-green marker icon on the scrubbing bar indicates that the 
marker is selected.

3	 Tap [Delete marker].

Marker list►P123 

4	 On the message that appears, tap [Yes].
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Moving to marker position
For a marker set to the contents mounted on the Player channel, the current 
playback position can be moved to the marker position.

1	 Display the marker list.

Showing marker list►P123 

2	 Tap and select a desired marker in the marker list, and then tap 
[Move to previous marker] or [Move to next marker].

Marker list►P123 
The current playback position moves to the previous or next marker 
position.
The yellow-green marker icon on the scrubbing bar indicates that the 
marker is selected.

TIP •	In the [Marker] dialog box, check [Show marker icons on the 
scrub bar], click [When moving to edit point :], and select [Cue 
up on Markers], to include marker positions as the moving 
destination when the following operations is performed.
[Marker] dialog box►P124 

-- In the workstation mode, when [Move to previous edit point] 
or [Move to next edit point] of the Player channel operation 
buttons is clicked

-- In the front panel mode, when [Rew] + [Stop] buttons or [FF] 
+ [Stop] buttons are pressed at the same time

•	In the workstation mode, also you can move a marker in the 
marker list by double-clicking on it.
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Entering characters and numerics

Entering characters
The operation to enter characters in each screen is described in this part.

NOTE •	You cannot enter Japanese characters.

1	 Tap the entry area of a screen.

2	 Enter characters with the software keyboard.

¾¾Software keyboard

(2)

(4) (6)(3) (5)

(7)

(8)

(1)

(1) Entry area
Displays the characters entered with the 
software keyboard.

(2) [Shift] Switches upper/lower case of alphabets.

(3) Cursor (left and right) Moves the cursor in the entry area.

(4) [Space] Used as the space key.

(5) [OK]
Fixes the entered characters and closes the 
software keyboard.

(6) [Cancel]
Cancels the entry and closes the software 
keyboard.

(7) [Del]
Deletes currently selected entry or deletes 
the character right after the cursor.

(8) [BackSpace] Deletes the character right before the cursor.

3	 Tap [OK].
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Entering timecode
The operation to enter timecode in each screen is described in this part.

1	 Tap the timecode entry area of a screen.

2	 Enter a timecode with the software keypad.

¾¾Software keypad – Timecode

(2) (4) (6)(3) (5)

(7)
(8)

(1)

(1) Entry area

Displays the timecode entered with the 
software keypad.
According to the entered digits, the number 
will be automatically converted into “hour, 
minute, second, frame”. For example, enter 
“4321” for 43 seconds 21 frames.

(2) Cursor (left and right) Moves the cursor in the entry area.

(3) [=]
Applies the entered value to the set value 
for timecode as it is.

(4) [-]/[+]

Allows to enter reduced or increased value 
(relative value) from the current value.
Reduces the set value by entering after 
tapping [-].
Increases the set value by entering after 
tapping [+].

(5) [OK]
Fixes the entered value and closes the 
software keypad.

(6) [Cancel]
Cancels the entry and closes the software 
keypad.

(7) [Del]
Deletes currently selected entry or deletes 
the character right after the cursor.

(8) [BackSpace] Deletes the character right before the cursor.

3	 Tap [OK].
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Entering numerics
The operation to enter numerics in each screen is described in this part.

1	 Tap the numeric entry area of a screen.

2	 Enter numerics with the software keypad.

¾¾Software keypad – Numeric

(2) (4)

(6)

(3)

(5)

(1)

(1) Entry area
Displays the numerics entered with the 
software keypad.

(2) Cursor (left and 
right)

Moves the cursor in the entry area.

(3) [OK]
Fixes the entered value and closes the 
software keypad.

(4) [Cancel]
Cancels the entry and closes the software 
keypad.

(5) [Del]
Deletes currently selected entry or deletes 
the character right after the cursor.

(6) [BackSpace]
Deletes the character right before the 
cursor.

3	 Tap [OK].



Section 9
Operations in Workstation Mode

This section describes screen elements of the workstation mode and 
functions available only in the workstation mode.

Screen elements

¾¾Full display – 3ch view

(2)

(3)

(1)

(4)

(1) Menu bar
By clicking, displays related menu.
Menu bar►P134 

(2) Channel display 
part

Displays Recorder and Player channels in 3ch 
view.
Recorder channel – 2ch/3ch view►P135 
Player channel – 2ch/3ch view►P151 

(3) Status bar Status bar►P162 

(4)
Bin/transfer 
screen display 
part

Performs contents management, import/export 
of media files, display of the setting screen, etc.
Bin/transfer screen display part►P163 
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¾¾Menu bar

[System]

By clicking, displays the next menu.

[Switch to Front Panel mode]
Switches from the workstation mode to the front panel 
mode.

[Switch to Workstation mode]
Switches from the front panel mode to the workstation 
mode.
Switching from the front panel mode to the workstation 
mode►P37 

[Lock Front Panel]
Lock and unlock front panel. This mode is unlocked 
to push [R1]+[P1]+[P2]+ [SHTL/JOG] buttons same time 
also.

[T2 to T2 Sync backup...]
Makes a backup of all data to another T2.

[Maintenance...]
Switches to the maintenance mode.

[Exit]
Exits T2.
Exiting T2 in workstation mode►P36 

[View]

By clicking, displays the next menu.

[2ch (channel name 1 + channel name 2)]
Displays the two specified channel names in the 
channel display part.

[3ch]
Displays three channel names in the channel display part.

[Option]

By clicking, displays the next menu.

[Log]
Sets the log level and displays logs.
Checking logs of operations and processes►P186 

[Remove media...]
Disconnects a removable drive such as USB removable 
media, XDCAM, P2, etc.

[Customize]
Assigns keyboard shortcuts and sets mouse operations.
Changing keyboard shortcut assignment►P172 
Assigning commands to mouse operation►P174 

134 T2 User Manual	 January 1, 2020

Section 9  ― Operations in Workstation Mode



[Help]

By clicking, displays the next menu.

[About T2]
Displays the version of T2.

¾¾Recorder channel – 2ch/3ch view

(2) (3) (8)(9) (10) (12)(11)

(13)

(4) (6)(5) (7)(1)

(1) Recorder channel 
tab

By clicking, selects and highlights the 
Recorder channel.

(2) Status Indicates the recording progress status.

(3) [Locked]

Locks Recorder channel operations.
While the operations are locked, [Locked] 
and [R1] buttons light in red.
Clicking it again releases the lock.

(4) Preview

Displays the video currently played back.
In full screen mode, right-click on it, and 
then click [Full Screen Mode] or double-
click on it.

(5) [Cur:] Indicates the current timecode.

(6) Scrubbing bar Indicates the recording progress status.

(7) [Elapsed:]
Indicates the elapsed time of recording by 
timecode display.

(8) Audio level display Displays the audio playback level.

(9) [Switch to the detail 
display]

Switches to the detail view.
Audio level detail display (Recorder 
channel)►P147  
Timecode Status display►P148 
Marker list view►P150 
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(10) Recording mode

Switches the recording mode (Recorder-
live mode /Recorder-VTR mode/Recorder-
remote mode).
Recorder-live mode►P136 
Recorder-VTR mode►P142 
Recorder-remote mode►P144 

(11) [Schedule]

In the Recorder-live mode, automatically 
starts recording operation at a specified 
time, and ends it at a specified time.
Recorder-live mode / schedule mode►P137 

(12) [Unload]
Unloads the video loaded to the Recorder 
channel.

(13) Operation buttons
Operation buttons of Recorder 
channel►P146 

¾¾Recorder-live mode

(2)

(9)

(6)
(7)
(8)

(3)(1)

(4)(5)

(10)

(1) [Clip:]
Enter the name of the clip currently 
recorded.

(2) [Tag:]
Enter a tag for search to the clip currently 
recorded.

(3) [Properties]
Displays the properties of the clip currently 
recorded.

(4) [Setting of 
ingesting]

Sets the saving destination and naming 
rule of clips being recorded.
Setting of ingesting dialog box►P145 
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(5) [Set the clip name for 
next ingest file...]

Displays the dialog box to set the name of 
the clip to be recorded next. The set clip 
name is displayed in [Clip:].

(6) [Mark In:]
Indicates the In point timecode of the clip 
currently recorded.

(7) [Mark Out:]
Indicates the Out point timecode of the clip 
currently recorded.

(8) [Dur:]
Indicates the time length (duration) of the 
clip currently recorded.

(9) [Format]
Displays the video size, frame rate, input 
settings, port used for input, source TC (TC 
(LTC)/SDI (VITC)/TC (INT)), etc.

(10) [Live Record 
Settings]

[Fixed Length On]
By clicking to set it on, automatically ends 
recording after the duration from the start 
point specified in [Length:].

TIP •	While recording to an external device, [Setting of ingesting] 
turns green to indicate that the recording to an external device 
is performed.

¾¾Recorder-live mode / schedule mode

(2)
(1) (3)

(4)

  

(1) [Add]
Creates a new schedule.
Schedule Recording dialog box►P139 

(2) [Delete]
Deletes schedules selected on the schedule 
list.

137January 1, 2020	 T2 User Manual

Screen elements



(3) [Edit]

Changes the date and time etc. of a 
schedule selected on the schedule list.
Displays the Schedule Recording dialog 
box.
Schedule Recording dialog box►P139 

(4) Schedule list

Displays information on new schedules and 
schedules that have already been recorded. 
The status, name, start time, end time, and 
type of schedules can be viewed.
Status of Schedule►P138 

TIP •	Select a schedule on the schedule list, right-click on it, and then 
click [Select All], to select all schedules.

¾¾Status of Schedule
Status Details

[Waiting] Schedule recording is waiting for next start time.

[Retrying] Recording is retrying.

[Recording] Recording is in process.

[End] Recording is completed.

[Disabled]
The schedule is disabled. Recording will not be 
executed.

Result Details

[Success] Recording is completed successfully.

[Error] An error is occurred during recording.

[Cancel] Recording is canceled in the middle.
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¾¾Schedule Recording dialog box

(1)

(2)

(3)
(4)
(5)

(6)

(7)

(1) [Schedule Name] Enter the schedule name.

(2)

[Date :]
([Start Date :], [End 
Date :], [Day of 
week :])

Selects [One time], [Every day], or [Every 
week] from the list.
Selecting [Every day] or [Every week] 
repeats recording operation for a fixed 
period of time.

[One time]
By clicking the icon on the calendar, 
allows to set the date to automatically start 
recording.

[Every day]
Changes [Date :] to [Start Date :].
Checking [Set end date] displays [End Date :].
Clicking the icon on the calendar allows to 
set the [Start Date :] and [End Date :].

[Every week]
Changes [Date :] to [Start Date :] and 
displays [Day of week :].
Checking [Set end date] displays [End Date :] 
and [Day of week :].
Clicking the icon on the calendar allows to 
set the [Start Date :] and [End Date :]. Set 
[Day of week :] to the day of the week when 
you wish to record.
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(3) [Start Time :] Sets the time to automatically start recording.

(4) [End Time :] Sets the time to automatically end recording.

(5) [Output]

Selects the saving destination of the clips to 
be recorded.

[Capture Path :]
Select [Internal] to save clips to T2.
The bin that is registered to T2 is displayed 
from the list.
Also clicking [...] allows to set a newly 
created bin to the saving destination.
Select [External] to save clips to a 
destination other than T2.
If <non-registered> is indicated, click [...] 
and set the saving destination.

[Clip Name :]
Sets the naming rule of clips to be saved.
Enter the clip name.
Clicking [...] enters [Date], [Time] and/
or [Schedule Time] after the clip name 
automatically.

(6) [Format]

[Capture Format :]
Sets the format of the clips to be recorded.
Clicking [Settings...] displays the Capture 
Format dialog box.
Capture Format dialog box►P141 

(7) [Other]
[Action]
Selects if the schedule is to be executed or 
not from [Enable] and [Disable].

NOTE •	The following schedules cannot be added or changed.
-- A schedule that overlaps to a registered schedule
-- A schedule whose recording start time is within one minute
-- A schedule that has already been recorded

•	It may take more than one minute to finish recording after 
"recording long time" or "recording in the external storage". 
In this case, next schedule recording is started after the last 
recording is completed.

TIP •	 [Date :] ([Start Date :], [End Date :]), [Start Time :], and [End 
Time :] can also be set by moving the mouse wheel .
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¾¾Capture Format dialog box

[IO Mode]
By clicking [Settings...], selects an IO mode and frame rate.
[IO Mode Setting] dialog box►P142 

[Input 
Capability]

According to the selection for [IO Mode], displays the 
connector to be used for input with green highlight.

[Video]

[Input format :]
Selects the format for video input.

[Aspect :]
For SD input, selects the aspect ratio.

[Compression]

Part of available setting items differ according to the 
codec selected for [File type:].

[File type :]
Selects the compression format.

[Bitrate :]
Selects a bit rate that supports the compression format.

[Audio format :]
Selects an audio format that supports the 
compression format.

[ClosedGOP]
By checking this item when a compatible codec is used, 
all the information will be included within the GOP. 
It increases the data size, but allows re-editing with 
editor software that allows editing of GOP data. 
Uncheck it normally.
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¾¾ [IO Mode Setting] dialog box

[IO Mode:]
Selects an IO mode option.
IO mode list►P263 

[Frame Rate:]

Selects a frame rate for recording.
•	[59.94 / 29.97 fps]: Either of 59.94p, 29.97p, and 

59.94i
•	[50 / 25 fps]: Either of 50p, 25p, and 50i
•	[24 fps]: Either of 24p and 24PsF
•	[23.98 fps]: Either of 23.98p and 23.98PsF

Note •	At the start of recording, if the settings of the IO mode and 
frame rate of the registered schedule differ from those of the 
current settings, an error will result.

TIP •	The IO modes available on your T2 differ depending on the T2 
model type.
IO mode list►P263 

¾¾Recorder-VTR mode
(3)

(7)

(5)(4)(2)(1)

(8)

(6)

(1) [Set the clip name for 
next ingest file...]

Displays the dialog box to set the name of 
the clip to be recorded next. The set clip 
name is displayed in [Clip:].

(2) [Clip:] Enter the name of the clip currently recorded.
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(3) [Tag:]
Enter a tag for search to the clip currently 
recorded.

(4) [Batch]
Switches to the Recorder-VTR batch mode.
Recording sources at once (batch 
capturing)►P176 

(5) [Properties]
Displays the properties of the clip currently 
recorded.

(6) [Setting of 
ingesting]

Sets the saving destination and naming rule 
of clips being recorded.
Setting of ingesting dialog box►P145 

(7) [Format]
Displays the video size, frame rate, input 
settings, port used for input, source TC (TC 
(LTC)/SDI (VITC)/TC (INT)), etc.

(8) [VTR Record 
Settings]

[VTR In:]
Enter the In point timecode of the clip 
currently recorded.

[VTR Out:]
Enter the Out point timecode of the clip 
currently recorded.

[Length:]
Indicates the time length (duration) of the 
clip currently recorded.

[Fixed Length On]
By clicking to set it on, automatically ends 
recording after the duration from the start 
point specified in [Length:].

TIP •	While recording to an external device, [Setting of ingesting] 
turns green to indicate that the recording to an external device 
is performed.

143January 1, 2020	 T2 User Manual

Screen elements



¾¾Recorder-remote mode

(3)

(6)

(4)(2)(1)

(5)

(1) [Set the clip name for 
next ingest file...]

Displays the dialog box to set the name of 
the clip to be recorded next. The set clip 
name is displayed in [Clip:].

(2) [Clip:]
Enter the name of the clip currently 
recorded.

(3) [Tag:]
Enter a tag for search to the clip currently 
recorded.

(4) [Properties]
Displays the properties of the clip currently 
recorded.

(5) [Setting of 
ingesting]

Sets the saving destination and naming rule 
of clips being recorded.
Setting of ingesting dialog box►P145 

(6) [Format]
Displays the video size, frame rate, input 
settings, port used for input, source TC (TC 
(LTC)/SDI (VITC)/TC (INT)), etc.

TIP •	While recording to an external device, [Setting of ingesting] 
turns green to indicate that the recording to an external device 
is performed.
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¾¾Setting of ingesting dialog box

[Destination]

Selects the saving destination of the clips to be 
recorded.
Select [Save to internal storage] to save clips to T2.
Select the bin that is registered to T2 from the list.
Also clicking [...] allows to set a newly created bin to 
the saving destination.
Checking [Ingest to the selected bin] saves clips to 
the bin selected in the bin display area.
To record data to a destination other than T2, select 
[Save to external media / storage], and then select an 
external media/storage from the list.
If <non-registered> is indicated, click [...] and set the 
saving destination.

[Clip naming 
rules]

Sets the naming rule by entering a name of clips to 
be saved.
The data is recorded by a clip name with the 
recorded date and time, according to the items 
selected in [Date] and/or [Time].
If the name of the clip to be recorded next has been 
set in the Recorder channel, the clip name setting for 
the next recorded clip is prioritized.
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¾¾Operation buttons of Recorder channel

(1)
(2)

(3)
(4)

(5)
(6)

(7)
(8)

(9)
(10)

(11)
(12)

(13)

(1) [Cue(In)]*1 Moves the VTR to the In point.

(2) [Cue(Out)]*1 Moves the VTR to the Out point.

(3) [Rewind]*1 Rewinds the VTR.

(4) [Move to the 
previous frame]*1

By every click, moves back the VTR frame 
by frame.

(5) [Stop] Stops playback or recording.

(6) [Record]

Starts recording.
The icon display changes depending on 
the recording mode.

:
Indicates that a recording stop operation is 
necessary.

:
Indicates that it is a fixed length recording.

:
Indicates that In point and Out point are 
set.

(7) [Play]*1 Plays the VTR.

(8) [Move to the next 
frame]*1

By every click, moves forward the VTR 
frame by frame.

(9) [FastFwd]*1 Fast forwards the VTR.

(10) [Mark(In)] Sets In point to the current position.

(11) [Mark(Out)] Sets Out point to the current position.

(12) [Clear (In/Out)] Clears set In/Out points.

(13) [Create Subclip]*2

Creates a sub clip between In-Out points 
set while recording, and saves it as 
highlight.

*1	 Only for Recorder-VTR mode.
*2	 Only for Recorder-live mode. However, if the video being recorded is 

saved to an external media or storage, a sub clip cannot be created.
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¾¾Recorder channel – 1ch view
The display is same as that of Recorder channel – 3ch view.
Recorder channel – 2ch/3ch view►P135 

¾¾Audio level detail display (Recorder channel)

(4)

(7)

(3)

(6)

(5)

(1) (2)

(1) [<]/[>] Switches the detail display

(2) Switching of display 
scale

Selecting [Peak] makes the maximum level 
to 0 dB.
Selecting [Ref] makes the set audio 
reference level as the standard level.
You can set the audio reference level in 
[Audio reference level:] from [General] -> 
[Hardware] tab in the setting screen.
General – Hardware settings►P189 

(3) Input port Indicates the port used for input.
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(4) Gain slider Not available.

(5) Level meter
Displays the audio playback level for each 
track.

(6) Monitor channel

Indicates the channel that monitors the 
audio level.
You can select a channel to monitor with 
the headphone jack on the front panel or 
the audio monitor jack on the rear panel.

(7) [Close]

By clicking, closes the audio level detail 
display.
By clicking the triangular list button on 
the right, you can also switch the screen to 
another detail view.

¾¾Timecode Status display
(3)

(6)(10)

(4)(1) (2)

(9) (8) (7) (5)

(1) [<]/[>] Switches the detail display.

(2) Audio level meter
Displays the audio level meter of the 
channel whose timecode is displayed.

(3) LTC timecode
Displays the timecode input to LTC. When 
the timecode is locked, this is displayed in 
green.

(4) LTC lock status

Lights up in green (lock status) when the 
timecode input to LTC is confirmed to 
progress frame by frame correctly. If the 
timecode has stopped or does not progress 
frame by frame, the status will not be 
locked.
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(5) TC lock status

Lights up in green (lock status) when 
the timecode of the Player channel 
synchronizes with the frame accuracy of 
the LTC timecode. A plus is displayed if it 
is ahead of the LTC timecode, and a minus 
is displayed if it is behind.

(6) Frame deviation 
number

Displays the frame deviation to the LTC 
timecode. A plus is displayed if it is ahead, 
and a minus is displayed if it is behind. The 
number is not displayed when the playback 
is synchronized with the same timecode or 
when it has stopped.
-120 to +120 can be displayed.

(7) Remote status

The remote mode set in the Player channel 
is displayed. Lights up in white when 
remote control is enabled.
Remote Control►P236 

(8) Current timecode

Displays the current timecode of the Player 
channel. When the timecode is locked, it is 
displayed in green.
General – Hardware settings►P189 

(9) Playback speed
Indicates the current playback speed 
(times).

(10) [Close]

By clicking, closes the audio level detail 
display.
By clicking the triangular list button on 
the right, you can also switch the screen to 
another detail view.
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¾¾Marker list view

(13)

(12)

(1) (2)
(11)

(10)
(9)

(8)
(7)

(6)
(5)

(4)
(3)

(1) [<]/[>] Switches the detail view.

(2) [Add Marker]

Adds a marker (with no comment).
If you want to add a comment at the time 
when a marker is added, check [Show add 
marker dialog when new marker is added] 
in the [Marker] dialog box.

(3) [Add Marker with 
Comment (0-9)]

By clicking and selecting [1] to [9], adds a 
marker with a preset marker comment (1 to 
9). (When [0] is selected, a marker without 
comment is added.)

(4) [Add Marker with 
Comment 1]

Adds a marker with a preset marker 
comment 1.

(5) [Add Marker with 
Comment 2]

Adds a marker with a preset marker 
comment 2.

(6) [Add Marker with 
Comment 3]

Adds a marker with a preset marker 
comment 3.

(7) [Delete marker] Deletes markers selected on the marker list.

(8) [Edit marker]
Displays the [Edit Marker] dialog box.
You can edit timecodes and comments of 
markers.

(9) [Move to previous 
marker]*1

Moves to the position of the marker 
previous to that selected in the marker list.

(10) [Move to next marker]*1 Moves to the position of the marker next to 
that selected in the marker list.

(11) [Setting] Displays the [Marker] dialog box.

150 T2 User Manual	 January 1, 2020

Section 9  ― Operations in Workstation Mode



(12) Marker list

Displays the No., timecodes, and comments 
of markers.
For markers set in a playlist, displays the 
event name.

(13) [Close]

By clicking, closes the marker list view.
By clicking the triangular list button on 
the right, you can also switch the screen to 
another detail view.

*1	 Not available for Recorder channel.

¾¾Player channel – 2ch/3ch view

(2) (3) (8)(9) (10) (11)(12) (13) (14) (15)

(16)

(4) (6)(5) (7)(1)

(1) Player channel 
tab

By clicking, selects and highlights the Player 
channel.

(2) [Locked]

Locks Player channel operations.
While the operations are locked, [Locked] and 
[P1] (or [P2] button) buttons light in red.
Tapping it again releases the lock.

(3) Output profile Indicates the output profile of the channel.

(4) Status Indicates the playback progress status.

(5) Playback mode

Switches on and off of the current playback 
mode (sync mode, E to E mode, loop playback 
mode) of the Player channel.
While the Recorder channel is played back in 
E to E mode, the E to E indication is shown in 
blue text. While the Player channel is played 
back, the indication is shown in white text.

151January 1, 2020	 T2 User Manual

Screen elements



(6) Preview

Displays the video currently played back.
To update the thumbnail of the contents with 
the video of the current position, right-click the 
preview and click [Set Thumbnail Frame].
To change to full screen mode, right-click on it, 
and then click [Full Screen Mode] or double-
click on it.
From the menu that appears by right-clicking 
on the preview screen, clicking [On Screen 
Display] allows to set the following items.

[Off]
Does not show on-screen display on the Player 
channel.

[Both]
Shows on-screen display both on the Player 
channel preview of the T2 screen and on the 
output video from the SDI terminal.

[PC Preview only]
Shows on-screen display only on the Player 
channel preview of the T2 screen.
On-screen display is not shown on the output 
video from the SDI terminal.

[Settings...]
Sets the indication contents of on-screen 
display shown on the Player channel.
On-screen display detailed settings dialog 
box►P106 

(7) [Cur:] Indicates the current timecode.

(8) Playback speed Indicates the current playback speed (times).

(9) Scrubbing bar
Indicates the playback progress status and 
icons of set In/Out points.

(10) [Remain:] Indicates the timecode of the remaining time.

(11) Audio level 
display

Displays the audio playback level.

(12) [Switch to the 
detail display]

Switches to the detail view.
Audio level detail display (Player channel)►P160 
VAR speed control (Player channel)►P161 
Timecode Status display►P148 
Marker list view►P150 
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(13) [Clip]/
[Playlist]

Switches to the clip view or playlist view.
Player channel (clip view) – 2ch/3ch view►P154 
Player channel (playlist view) – 2ch/3ch 
view►P155 

(14) [Remote] Switches to the Player-remote mode.

(15) [Unload]
Unloads the contents loaded on the Player 
channel.

(16) [Operation 
Button]

Operation buttons of Player channel►P156 
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¾¾Player channel (clip view) – 2ch/3ch view

(2) (4)(3)

(9)

(1)

(5)
(6)
(7)
(8)

** (1) to (9) are common in P2 channel.

(1) [Zoom]

Switches the display scale of the scrubbing bar.
Clicking it displays [Zoom] in red, and displays 
the In-Out pints of the clip as the whole scale.
Clicking it again returns the display to the 
original scale and displays the whole clip.

(2) [Clip:]
Indicates the name of the loaded clip.
Also allows to edit the clip name.

(3) [Tag:]
Indicates the tag for search of the loaded clip.
Also allows to edit the tag.

(4) [Properties]
Displays the properties of the clip currently 
loaded.

(5) [Mark In:]
Indicates the In point timecode of the clip.
Also allows to enter and edit the In point 
timecode.

(6) [Mark Out:]
Indicates the Out point timecode of the clip.
Also allows to enter and edit the Out point 
timecode.

(7) [Set] Trims the clip between the set In-Out points.

(8) [Dur:]
Indicates the time length (duration) of the clip.
Also allows to enter and edit the timecode of 
the duration.

(9) [Clip Contents]
Displays the In and Out points of the clip, 
duration of the clip, video size of the clip, and 
frame rate.
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¾¾Player channel (playlist view) – 2ch/3ch view

(2) (4)(3)

(5)

(1)

** (1) to (5) are common in P2 channel.

(1) [TRIM]

Switches to the TRIM mode. You can edit the 
In/Out points of the event selected in the event 
list.
Player channel (playlist view) – 1ch view/TRIM 
mode►P158 

(2) [Playlist Menu] Displays the related menu.

(3) [Playlist:]/
[Timeline:]

Indicates the name of the loaded playlist.
Also allows to edit the playlist name.
[Playlist:]
Playlist in the normal format.
[Timeline:]
Playlist in the timeline format.
Changing the playlist type►P180 

(4) [Properties]
Displays the properties of the playlist currently 
loaded.

(5) Event list

Displays the list of events in the playlist.
By right-clicking the event, displays the related 
menu.
The background color of the event indicates the 
current status of the event.
•	Red indicates that the event has the playback 

position on the scrubbing bar.
•	Green indicates the next event of the event 

that has the playback position on the 
scrubbing bar.

•	Blue indicates that the event is selected.
The background color of the event can be 
changed to your preferred color.
[Playlist View Style:] dialog box (workstation 
mode only)►P204 
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¾¾Operation buttons of Player channel

(1)
(2)

(3)
(4)

(5)
(6)

(7)
(8)

(9)
(10)

(11)
(12)

(13)
(14)

(1) [Cue(In)] Moves to the In point of the contents.

(2) [Cue(Out)] Moves to the Out point of the contents.

(3) [Move to previous 
edit point]

In the TRIM mode of clip view or playlist 
view, moves to the previous edit point (top 
of the clip, In/Out point after trimmed) by 
every click.
In the playlist view, moves to the In point 
of the previous event.
It also allows to include markers as edit 
points.
[Marker] dialog box►P124 

(4) [Rewind]
Rewinds the contents. By every click, 
switches the speed to 2 to 32 times (5 
levels) and plays in backward.

(5) [Move to the 
previous frame]

By every click, moves back the contents 
frame by frame.

(6) [Stop] Stops playback.

(7) [Play] Plays the contents.

(8) [Move to the next 
frame]

By every click, moves forward the contents 
frame by frame.

(9) [FastFwd]
Fast forwards the contents. By every click, 
switches the speed to 2 to 32 times (5 
levels) and plays.

(10) [Move to next edit 
point]

In the TRIM mode of the clip view or 
playlist view, moves to the next edit point 
(In/Out point after trimmed, end of the 
clip) by every click.
In the playlist view, moves to the In point 
of the next event.
If you play recording data, move to latest 
recording point.
It also allows to include markers as edit 
points.
[Marker] dialog box►P124 
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(11) [Mark(In)]
Sets In point to the current position. After 
In point has been set, the In point icon 
appears on the scrubbing bar.

(12) [Mark(Out)]
Sets Out point to the current position. 
After Out point has been set, the Out point 
icon appears on the scrubbing bar.

(13) [Clear (In/Out)] Clears set In/Out points.

(14) [Create Subclip]
Creates a sub clip between In-Out points 
set, and saves it as highlight.

¾¾Player channel (clip view) – 1ch view
The display is same as that of Player channel (clip view) – 3ch view.
Player channel – 2ch/3ch view►P151 
Player channel (clip view) – 2ch/3ch view►P154 
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¾¾Player channel (playlist view) – 1ch view/TRIM mode
The preview and operation button parts are same as that of Player channel 
(playlist view) – 3ch view.
Player channel – 2ch/3ch view►P151 
Player channel (playlist view) – 2ch/3ch view►P155 
The elements which differ from that of Player channel (playlist view) – 3ch 
view are described here.

(3) (4)

(6)

(5)

(1) (2)

(7)

** (1) to (7) are common in P2 channel.

(1) [TRIM]

Switches on and off of the TRIM mode.
Displayed in red during in the TRIM mode.
By clicking when in the TRIM mode, exits the 
TRIM mode.

(2) [Playlist:]/
[Timeline:]

Indicates the name of the loaded playlist.
Also allows to edit the playlist name.
[Playlist:]
Playlist in the normal format.
[Timeline:]
Playlist in the timeline format.
Changing the playlist type►P180 
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(3) [Tag:]
Indicates the tag for search of the loaded 
playlist.
Also allows to edit the tag.

(4) [Properties]
Displays the properties of the playlist currently 
loaded.

(5) [Current Event]

Displays the information of the event being 
played.

[Event:]
Indicates the name of the event.
Also allows to edit the event name in the TRIM 
mode.

[In:]
Indicates the timecode of the In point.
Also allows to edit the In point timecode in the 
TRIM mode.

[Out:]
Indicates the timecode of the Out point.
Also allows to edit the Out point timecode in 
the TRIM mode.

[Dur:]
Indicates the timecode of the length of the 
event (duration).
Also allows to edit the timecode of the duration 
in the TRIM mode.

[Set]
Displays only in the TRIM mode.
Trims between the set In-Out points.

(6) [Playlist Menu] Displays the related menu.
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(7) Event list

Displays the list of events in the playlist.
By right-clicking the event, displays the related 
menu.
The background color of the event indicates the 
current status of the event.
•	Red indicates that the event has the playback 

position on the scrubbing bar.
•	Green indicates the next event of the event 

that has the playback position on the 
scrubbing bar.

•	Blue indicates that the event is selected.
The background color of the event can be 
changed to your preferred color.
[Playlist View Style:] dialog box (workstation 
mode only)►P204 

¾¾Audio level detail display (Player channel)

(3)

(6) (5)

(4)

(1) (2)

(1) [<]/[>] Switches the detail display.

(2) Switching of display 
scale

Selecting [Peak] makes the maximum level 
to 0 dB.
Selecting [Ref] makes the set audio 
reference level as the standard level.
You can set the audio reference level in 
[Audio reference level:] from [General] -> 
[Hardware] tab in the setting screen.
General – Hardware settings►P189 

(3) Gain slider
Adjusts the gain of each channel by moving 
the slider.

(4) Level meter
Displays the input audio level for each 
track.
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(5) Output channel
Allows to select a channel to output from 
the headphone jack on the front panel or 
the audio monitor jack on the rear panel.

(6) [Close]

By clicking, closes the audio level detail 
display.
By clicking the triangular list button on 
the right, you can also switch the screen to 
another detail view.

¾¾VAR speed control (Player channel)

(2)

(4)(5)

(3)(1)

(1) [<]/[>] Switches the detail display.

(2) [<]/[>]
By every click, increases or decreases the 
playback speed by 0.01 time.

(3) Speed specifying bar

By clicking on the speed specifying bar or 
the value indicating the speed, specifies the 
playback speed within the range of -2 to +2 
times.

(4) [<<]/[>>]
By every click, increases or decreases the 
playback speed by 0.1 time.

(5) [Close]

By clicking, closes the VAR speed control.
By clicking the triangular list button on 
the right, you can also switch the screen to 
another detail view.

TIP •	The timecode status display is the same as that of Recorder 
channel.
Timecode Status display►P148 
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¾¾Status bar

(2) (9)(4) (6)(3)
(5) (7)

(1) (8)

(1) [3ch(2ch) Disp.]/
[1ch Disp.] switching

Switches 3ch(2ch) view and 1ch view.

(2) Operation mode
Displays the current operation mode 
(workstation mode/front panel mode).

(3) IO mode

Displays the current IO mode.
By clicking, displays the [IO Mode Setting] 
dialog box where you can change the IO 
mode.
[IO Mode Setting] dialog box►P142 

(4) Log notification icon

Notifies a warning or error log with an icon 
when it occurs. Clicking the icon displays 
the [Log] dialog box and allows to check 
the details.

(5) [FTP] Indicates that the FTP server of T2 is in use.

(6) Transfer process 
icon

Indicates an icon that notifies import, 
export, or file conversion is in process.

(7) [CPU] Indicates the CPU load status of T2.

(8) Remaining HDD 
(remaining time)

Displays the estimated recording time 
available on HDD.
When the remaining capacity reduces, the 
icon is displayed in red.

(9) Time

Displays the current time. Clicking this 
part displays the date and time setting 
dialog box that enables to change the set 
time.
Date and time setting dialog box►P206 

NOTE •	If the  icon appears on the status bar, there is a problem 
with the data drive. Consult the support.
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¾¾Bin/transfer screen display part
(1) (2) (4) (5)

(6) (7)

(3)

(1) [Folder]
Displays the bin view ([Bin] tab, [Browse] 
tab, [Recycle Bin] tab, and [Search] tab).

(2) [Transfer]
Displays the transfer screen.
Transfer screen►P168 

(3) View switching tab

Switches to [Bin] tab/[Browse] tab/[Recycle 
Bin] tab/[Search] tab.
[Bin] tab►P164 
[Browse] tab►P165 
[Recycle Bin] tab►P166 
[Search] tab►P167 

(4) [Config.] Displays the setting screen.

(5) [X] Exits or restarts T2.

(6) [Import]
Displays the menu related to import.
The display switches to the [Browse] tab.
Import menu►P168 
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(7) [Export]
Displays the menu related to export.
The display switches to the [Bin] tab.
Export menu►P169 

¾¾ [Bin] tab

(3)

(4)

(5)

(1)(2)

(1) [New Bin] Creates a new bin.

(2) [Search Contents]
You can search contents in the bin.
Searching for contents►P179 

(3) Bin list

Displays the list of bins.
The selected bin is highlighted in blue.
Right-clicking the selected bin displays the 
related menu.

(4) Contents list

Displays the list of contents selected in the 
bin list.
The selected item is highlighted in blue.
Right-clicking the selected contents 
displays the related menu.

(5) [Detail]
Displays the details of the contents selected 
in the contents list.
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¾¾ [Browse] tab

(3)

(2)

(4)

(1)

(1) [...]
When a removable media is connected to 
T2, you can select a folder to display in the 
[Browse] tab.

(2) Removable media 
list

Displays the removable media's media or 
folders in the drive connected to T2.
The selected folder is highlighted in blue.
Right-clicking the selected folder displays 
the related menu.

(3) Media file list

Displays the list of media files in the drive 
selected from the removable media list.
The selected media file is highlighted in 
blue.
Right-clicking the selected media file 
displays the related menu.

(4) [Detail]
Displays the details of the media file 
selected in the media file list.
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¾¾ [Recycle Bin] tab

(2)

(3)

(4)

(1)

(1) [Empty Recycle Bin]
Deletes all files in the recycle bin.
Note that the deleted contents cannot be 
restored.

(2) Recycle bin folder 
list

Displays the list of folders in the recycle 
bin.
The selected folder is highlighted in blue.
Right-clicking the selected folder displays 
the related menu.

(3) Contents list

Displays the list of contents in the folder 
selected in the recycle bin folder list.
The selected item is highlighted in blue.
Right-clicking the selected contents 
displays the related menu.

(4) [Detail]
Displays the details of the contents selected 
in the contents list.
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¾¾ [Search] tab

(2)

(3)

(4)

(1)

(1) [Search Contents]
You can search contents in the bin.
Searching for contents►P179 

(2) Search result folder 
list

Displays the list of folders of the search 
result.
The selected folder is highlighted in blue.
Right-clicking the selected folder displays 
the related menu.

(3) Contents list

Displays the list of contents in the folder 
selected in the search result folder list.
The selected item is highlighted in blue.
Right-clicking the selected contents 
displays the related menu.

(4) [Detail]
Displays the details of the contents selected 
in the contents list.
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¾¾Transfer screen

(1) (2)

(3)

(1) [Delete]
Deletes selected jobs. If you click [Delete] 
while executing a job, the job will be 
canceled.

(2) [Clear] Deletes all jobs from the job list.

(3) Job list

Displays the list of jobs.

[Clip]
Indicates the name of the clip.

[Status]
Indicates the job progress status.

[Bin]
Indicates the bin name.

[Path]
Indicates media file path and file name.

¾¾ Import menu

[Add a new 
connection...]

When a removable media is connected to T2, you 
can select a folder to display in the [Browse] tab 
by clicking it.

[Import the selected 
items...]

Imports the media file selected in the media file 
list to T2 as a clip.
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[Import all items...]
Imports all the media files in the folder selected 
from the removable media list.

[Import selected 
items as a sequence 
file...]

Imports still images with numbers that are serial 
to the selected still image as a single sequence clip 
(in Grass Valley HQX AVI).

¾¾Export menu

[Export the selected 
items...]

Exports the selected contents as media files or T2 
format (TWF) files.

[Export all items...]
Exports the all items in the selected folder as 
media files or T2 format (TWF) files.

Keyboard and mouse operations in workstation mode

Multiple selection of contents
You can select multiple contents in the media file list, contents list, event 
list, and marker list in the same way as PC operations.
Use the [Ctrl] key or [Shift] key on the keyboard or drag the mouse to 
select multiple contents and perform operations from the right-click 
menu.
In the event list, you can change the event order by the drag & drop 
operation with a mouse. You can also sort the multiple events you 
selected.
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Loading contents to Player channel by drag & drop 
operation
You can quickly load contents in the media file list and contents list to the 
Player channel by drag & drop operation with a mouse.

1	 Select contents and drag & drop it to the display area of the 
Player channel.

Adding events to playlist by drag & drop operation
You can quickly add events to the playlist by drag & drop operation with 
a mouse.
You can also add the playlist to another playlist as an event without 
spreading it out.

1	 Select contents and drag & drop to the event list.

The contents are added to the dropped position as an event.
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Sorting events in playlist by drag & drop operation
You can quickly sort events in the playlist by drag & drop operation with 
a mouse.

1	 Select an event in the event list and drag & drop to the 
destination.

Replacing place holder by drag & drop operation
You can quickly replace place holders by drag & drop operation with a 
mouse. You can replace a place holder when  is highlighted in red.

1	 Select an event from the event list, and drag & drop it on the 
place holder.

TIP •	If the playlist view is set to the detail view, a place holder 
cannot be replaced by drag & drop.
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Major keyboard shortcuts
The following illustration shows the allocation of frequently used 
keyboard shortcut keys (default).

Changing keyboard shortcut assignment
You can customize the shortcuts assigned to the keyboard.
The procedure to make a new keyboard shortcut setting based on the 
default keyboard shortcut to change the shortcut key assignment is 
described in this part.

1	 Click [Option] on the menu bar, and then click [Customize] -> 
[Keyboard Shortcuts...].

¾¾ [Keyboard Shortcuts] dialog box

(2)

(4)

(3)
(5)

(1)

(6)
(7)

(8)

(1) [Keyboard 
Shortcuts:]

Selects a keyboard shortcut to use.
The default name is “default”.

(2) [Edit List]
Displays the [Edit List] dialog box and allows 
to change the keyboard shortcut settings in the 
items of new creation/copy/delete/name.
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(3) Action category 
switching tab

Switches the action category ([General] tab/
[Contents List] tab/[Playlist] tab/[Marker List] 
tab).

(4) [Command:]
Displays the list of actions of the selected 
category.

(5) [Enter the new 
key:]

Enter a new shortcut key to assign to the 
selected command.

(6) [Set assign]
Assigns the shortcut key entered in [Enter the 
new key:].

(7) [Current keys:]
Displays the shortcut key assigned to the 
selected command.

(8) [Delete]
Deletes the shortcut key selected in [Current 
keys:].

2	 Click [Edit List].

3	 In the [Edit List] dialog box, click [New...].

4	 Enter a name of a keyboard shortcut and click [OK].

5	 In the [Edit List] dialog box, click [Close].

6	 Select the added shortcut setting from the list of [Keyboard 
Shortcuts:] in the [Keyboard Shortcuts] dialog box.

7	 Select a category from the action category switching tab.

8	 Select an action with [Command:].

9	 Enter the shortcut key to assign in the entry area of [Enter the 
new key:] and click [Set assign].

The entered shortcut key is displayed in [Current keys:].

10	Click [OK].

Click [Apply] to keep on making settings of other items.
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Assigning commands to mouse operation
You can assign commands so that certain mouse operations performs 
certain actions, such as loading a clip on the Player channel and playing it.
The procedure to create a new setting for mouse and assign the command 
to the mouse is described in this part.

1	 Click [Option] on the menu bar, and then click [Customize] -> 
[Mouse...].

¾¾ [Mouse Customize] dialog box

(2)

(4)

(6)

(3)

(5)

(1)

(1) [Mouse 
settings:]

Selects a mouse setting to use.

(2) [Edit List]
Displays the [Edit List] dialog box and allows to 
change the mouse settings in the items of new 
creation/copy/delete/name.

(3) Action category 
switching tab

Switches the action category ([Contents List] 
tab/[Playlist] tab/[Marker List] tab).

(4) [Mouse 
operation:]

Displays the list of mouse operations of the 
operation mode selected in [Setting].
Select a mouse operation to assign a command.

(5) [Command:]

Displays the list of actions of the selected 
category.
Select a command to assign to the mouse 
operation selected in [Mouse operation:].
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(6) [Setting]

Selects the operation mode of mouse from 
[Single Click Mode], [Double Click Mode], and 
[Single Click + Double Click].
Checking [Allow multiple selection] allows 
multiple selections of contents by the mouse 
operation.

2	 Click [Edit List].

3	 In the [Edit List] dialog box, click [New...].

4	 Enter the name of the mouse setting and click [OK].

5	 In the [Edit List] dialog box, click [Close].

6	 Select the added mouse setting from the list of [Mouse settings:] 
in the [Mouse Customize] dialog box.

7	 Select the operation mode of mouse in [Setting].

8	 Select a mouse operation to assign a command in [Mouse 
operation:].

9	 Select an action with [Command:].

10	Click [OK].

Click [Apply] to keep on making settings of other items.
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Recording sources at once (batch capturing)
You can import the batch capture list to your T2 and record sources from 
VTR at once.
The batch capture lists in the following file formats can be imported.

•	CSV file (Mode1/Mode2) (*.csv): Batch capture list created with EDIUS
•	ALE file (*.ale): File corresponding to Avid Log Exchange batch capture 

list
•	FCL file (*.fcl): File corresponding to Apple Final Cut Pro batch capture 

list

NOTE •	After importing the batch capture list to your T2, you cannot 
change In/Out points, duration, or reel name, and you cannot 
add batch capture items.

Set the connection information of the VTR used for action setting of 
batch capturing and for recording, or the video format for capturing 
beforehand.
General – Hardware settings►P189 
Recorder settings►P207 
Transfer – common settings►P219 
Make settings in the setting screen according to the environment in use.
Settings►P188 
The procedure to import a batch capture list and start recording is 
described in this part.

1	 Click the Recorder channel tab.

Recorder channel is selected.
Recorder channel – 2ch/3ch view►P135 

2	 Click [VTR].

The mode switches to the Recorder-VTR mode.

3	 Click [Batch].

The mode switches to the Recorder-VTR batch mode.

4	 Click [Load Batch Capture List].

5	 Select the batch capture list and click [OK].

The batch capture list appears.
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¾¾Recorder-VTR batch mode
(2)

(4)

(6)

(3)

(5)

(1)

(1) [Load Batch 
Capture List]

Imports the batch capture list (CSV, ALE, FCL 
files).

(2) [Delete Batch 
Capture Item]

Deletes a batch capture item.
You can also perform the same operation by 
selecting and right-clicking an item, and then 
clicking [Delete].

(3) [Move Up]/
[Move Down]

Sorts the batch capture items.
Selecting an item and clicking [Move Up] or 
[Move Down] moves an item up or down by 
one line.
You can also perform the same operation by 
selecting and right-clicking an item, and then 
clicking [Move Up] or [Move Down].

(4) Batch capture 
list

[Status]
Displays the recording progress. When an error 
occurs, displays the error detail.

[No]
Displays the serial number corresponding to 
the suffix of the clip name generated after the 
batch capture.

[Reel]
Displays the reel name.
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(4) Batch capture 
list

[In TC]/[Out TC]/[Dur TC]
Displays the timecode of In point/Out point/
duration.
The timecode to be prioritized when recording 
is underlined. To change the prioritized 
timecode, select and right-click an item, and 
then click [Change to "In/Out Capture"] or 
[Change to "In/Dur Capture"].

(5) [Count:]
Displays the total number of the batch capture 
items.

(6) [Duration:]
Displays the total duration in the batch capture 
list.

TIP •	Select and right-click an batch capture item, and then click 
[Select All] to select all items.

6	 Press the [Rec] button.

If batch capture items with different reel names set exist in the batch 
capture list, a message appears. Insert a tape corresponding to the reel 
name into the VTR and click [OK]. (If the same reel names are set in all 
batch capture items, or if no reel name is set, the message will not appear 
and recording starts.)
Recording starts and the progress is displayed in [Status].
If you stop the batch capture in the middle, click [Stop].
Clips that have been completed recording are stored in the specified bin.

Displaying media files in network drive
You can display media files in the network drive at the [Browse] tab by 
making settings of the network drive connected to T2 in the workstation 
mode.

1	 Click [Config.], and click the [General] -> [Network-3] tab.

General – Network-3 settings►P196 

2	 Click [Add...].

The [Map Network Drive] dialog box appears.

3	 Assign a drive letter to [Drive:].

4	 In the [Folder:] entry area, enter the “server name and shared 
folder” or “IP address and shared folder”, and then click [OK].

You can click [Browse...] to specify the path of the network drive.
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5	 Click [OK].

6	 Display the [Browse] tab.

[Browse] tab►P165 
The drive letter assigned in step 3 is displayed in the removable media list.

7	 Click […] at the right of the drive letter, and select a folder in the 
network drive, and then click [OK].

The contents in the network drive are displayed in the media file 
list.

TIP •	To save the specified recording destination on the external 
media/storage after restarting T2, click [Config.], click [General] 
-> [Miscellaneous] tab, and then check [Keep the connections 
on the browse tab]. 

Searching for contents
You can specify search conditions and search for contents in the bin.

1	 Click [Search Contents].

This operation is available in the [Bin] tab or [Search] tab.

¾¾ [Search] dialog box

[Bin:] Select the search target bin from the list.
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[Search condition]

Specify search conditions. If multiple 
conditions are specified, AND search will be 
performed.

[Name:]
Enter the contents name to search.

[Date:]
Select [Modified] or [Created], click the icon on 
the calendar, and set the date.

[Type:]
Select [all], [SD], [HD] or [4K] from the list.

[Tag:]
Enter the tag added to the contents.

2	 Select a search target bin from the list of [Bin:].

3	 Specify search conditions and click [OK].

The search starts.
The contents that matches the search conditions are displayed in the 
contents list in the search result folder of the [Search] tab.
[Search] tab►P167 

TIP •	To change the search conditions, right-click the search result 
folder and click [Change Search Criteria...].

•	To delete the search result folder, right-click the search result 
folder and click [Clear].

•	To change the name of the search result folder, right-click the 
search result folder and click [Rename].

Changing the playlist type
You can change the playlist type. In a playlist in the normal format, each 
events are added without creating spaces. In a playlist in the timeline 
format, events can be added to a desired position on the timeline by 
specifying the timecode.

1	 Right-click on the playlist in the bin and click [Properties].
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2	 Click [Change...]

¾¾ [Playlist type] dialog box

(1) [Playlist:] Indicates the name of the loaded playlist.

(2) [Type:]

Selects the playlist type from the list.

[Playlist]
Playlist in the normal format. You can add 
clips, playlists, and placeholders.
Added events can be placed without spaces 
between other events.
Editing a playlist►P110 

[Timeline]
Playlist in the timeline format. You can set the 
start timecode or duration of playlists and place 
clips at desired positions by specifying the 
timecode. Events that can be added are clips 
only. The spaces between events are registered 
as gap events, and a black screen is output 
during gap event playback.
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(3) Timeline 
Settings

Set the timeline settings.

[Start time:]
Set start time of playlist.

[Duration:]
Set duration of playlist. A duration cannot be 
set when the duration is shorter than the total 
duration of all events. 

3	 Select a playlist type in list of [Type:].

TIP •	Playlist which are added place holder or playlist event cannot 
be changed to timeline.

•	Playlist duration cannot be set when the duration is shorter 
than the total duration of all events. 

•	When timeline playlist change to playlist, the gap events are 
change to the place holders.

4	 Click [OK].

The playlist type is confirmed on the playlist view or properties.
Player channel (playlist view) – 2ch/3ch view►P155 

Editing playlist in the timeline format
Adding, deleting, and moving events on the playlist in the timeline 
format can be performed only in the workstation mode. Performing 
playback and applying effects can be operated also on the front panel.
Editing a playlist►P110 
Adding events to playlist by drag & drop operation►P170 
Sorting events in playlist by drag & drop operation►P171 

Creating playlist in the timeline format
After creating a playlist in the normal format, the playlist type can be 
changed to the timeline format.
Changing the playlist type►P180 
A playlist that includes clip events and gap events added before changing the 
format will be created. The duration of the gap event is determined automatically 
by the difference between the duration of the playlist and clip event.
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Adding event to playlist in the timeline format
1	 Show the playlist view of timeline playlist.

2	 Select events in the bin and then load contents to the playlist by 
drag & drop operation.

Adding events to playlist by drag & drop operation►P170 

¾¾ [Set start Timecode of Event] dialog box

(1) [Event:] Indicates the name of the loaded event.

(2) [Timeline 
settings]

Sets the position and length of an event to be 
added.

[Start time]
Enter the start timecode where an event is to 
be added. You cannot add an event if this is 
indicated in red.

[To fit into the interval, the Out point of the event 

will automatically be adjusted]
By checking this item, adds an event by 
automatically trimming at the Out point if the 
Out point of the clip to be added comes later 
than the playlist duration.

TIP •	A gap event is added automatically on the timecode where an 
event is not placed.

•	An event cannot be added if In and Out points of the event to 
be added do not exist within the playlist timeline.

•	An event cannot be added if it overlaps with an event other 
than a gap event that has already been added.
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3	 Specify the starting timecode of an event and click [OK].

The event is added. A gap event is added automatically on the timecode 
where an event is not placed.

Changing starting timecode of an event
You can change the start timecode of an event that is added to a playlist in 
the timeline format.

1	 On the playlist view, right-click on the event whose start 
timecode is to be changed, and click [Set Start Timecode...].

2	 Set the start timecode in [Set start Timecode of Event] dialog box.

[Set start Timecode of Event] dialog box►P183 

TIP •	An event cannot be added if it overlaps with an event other 
than a gap event that has already been added.

3	 Click [OK].

Deleting event from playlist in the timeline format
You can delete events from playlists in the timeline format.
Gap events cannot be deleted.

1	 Right-click on the event in the playlist view and click [Delete].

2	 Click [OK].
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Changing the display of playlist view

Changing the display of event list
You can switch the display of event list to the icon view or list view 
without thumbnail.

1	 Right-click on the event list and click [View] -> the display option 
([Icons]/[Tiles]/[List]/[Details]).

TIP •	If keyboard shortcuts are assigned to events and one of [Icons]/
[Tiles]/[List] is selected for the view, an icon is displayed on the 
thumbnail.

-- A red icon indicates the shortcut assigned to the event of the 
selected channel.

-- A black icon indicates the shortcut assigned to the event of 
the specified channel.

•	If one of [Icons]/[Tiles]/[List] is selected for the view, you can 
change the display size of the thumbnail. Right-click on the 
event list and click [View] -> [Thumbnail Size] -> the display 
size ([Large]/[Middle]/[Small]).

Changing the display or background color of events
You can change the settings of the event view style and background color.

1	 Right-click on the event list and click [View] -> [Customize...].

The [Playlist View Style:] dialog box appears.
[Playlist View Style:] dialog box (workstation mode only)►P204 

2	 Configure the settings, and then click [OK].
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Checking logs of operations and processes

Displaying a log
You can output logs of operations and processes. Use it to find out the 
cause of troubles.

1	 Click [Option] on the menu bar, and then click [Log] -> [Show 
log...].

¾¾ [Log] dialog box

(2)

(6)

(4)

(3)

(5)

(1)

(1) Output log 
switching

Selects [Operation Log] to display operation 
logs, and select [Process Log] to display process 
logs.

(2) Group list
Displays the list of groups for operations or 
processes. A group is created daily (or when 
the log data exceeds 10 MB).

(3) Log list
Displays the log list of the group selected in the 
group list.

(4) [Description:]
Displays the explanation for the log selected in 
the log list.

(5) [Close] Closes the dialog box.

(6) [Export]
Export the logs to external folder which is 
selected.

TIP •	When an error occurs, you can also display the [Log] dialog 
box by clicking the notification icon on the status bar.
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Changing log level settings
You can change the output log levels of operations and processes.
By the default setting, information, warning, and error will be output.

1	 Click [Option] on the menu bar, and then click [Log] -> [Logging 
level...].

¾¾ [Log Level Setting] dialog box

[Operation Log]

Selects the type of operation log to output.

[Error]
Outputs only error logs.

[Warning + Error]
Outputs warning and error logs.

[Information + Warning + Error]
Outputs information, warning, and error logs.

[All]
Outputs all logs including debug information.

[Process Log]

Selects the type of process log to output.

[Error]
Outputs only error logs.

[Warning + Error]
Outputs warning and error logs.

[Information + Warning + Error]
Outputs information, warning, and error logs.

[All]
Outputs all logs including debug information.

2	 Configure the settings, and then click [OK].
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Section 10
Settings

This section describes items that you can set in the setting screen.

Displaying the setting screen
You can make settings in the setting screen.

1	 Tap [Config.].

The configuration screen appears.

¾¾Settings

(2)

(4) (6)(3) (5)

(1)

(1) Main category
Switches the main category of each setting.
By tapping, displays the sub category tabs 
included in the main category.

(2) Sub category tab
By tapping, displays the detailed settings of 
the sub category.

(3) [Default...]

Restores all the settings made in the setting 
screen to the default.
To enable the settings, you must restart 
your T2.

(4) [OK]
Saves the current settings and closes the 
setting screen.
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(5) [Cancel]
Closes the setting screen without saving the 
current settings.

(6) [Apply]
Saves the current settings. You can keep on 
making settings of other items.

General settings

General – Hardware settings
You can set synchronization or audio level between an external device 
connected to your T2.

1	 Tap [General], and then tap the [Hardware] tab in the setting screen.

¾¾ [Hardware] tab

[Reference:]

Selects a sync signal from [External], [Input], 
and [Internal].
The signal status (NO SIGNAL/SYNC OK) will 
be displayed in the lower line.

[P1:]
If the sync signal has been synchronized with 
the P1 channel, displays [SYNC OK].

[P2:]
If the sync signal has been synchronized with 
the P2 channel, displays [SYNC OK].

[P3:]*1

If the sync signal has been synchronized with 
the P3 channel, displays [SYNC OK].

[IO Mode]
By clicking [Settings...], selects an IO mode and 
frame rate.
[IO Mode Setting] dialog box►P191 
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[Audio / LTC Output 
(CH1/CH2):]

Sets the output details from the AUDIO / LTC 
OUT connector on the rear panel.

[P1:Audio Output]
Outputs the audio signal L of P1 channel from 
CH1, and the audio signal R from CH2.

[P2:Audio Output]
Outputs the audio signal L of P2 channel from 
CH1, and the audio signal R from CH2.

[P3:Audio Output]*1

Outputs the audio signal L of P3 channel from 
CH1, and the audio signal R from CH2.

[R1:Audio Output]
Outputs the audio signal L of R1 channel from 
CH1, and the audio signal R from CH2.

[P1/P2:LTC Output]
Outputs the LTC of P1 channel from CH1, and 
the LTC of P2 channel from CH2.

[P1/P3:LTC Output]*1

Outputs the LTC of P1 channel from CH1, and 
the LTC of P3 channel from CH2.

[P2/P3:LTC Output]*1

Outputs the LTC of P2 channel from CH1, and 
the LTC of P3 channel from CH2.
Audio level detail display (Recorder 
channel)►P147  
Audio level detail display (Player 
channel)►P160 

[Audio reference 
level:]

Selects the audio reference level (Headroom)
from the list.

[ASIO audio device:]*2

Click [Settings...], and configure the settings for 
the ASIO audio device.
[ASIO audio device] dialog box (workstation mode 
only)►P194 
Utilizing ASIO audio device►P243 

** 1  �Settings for P3 channel are only available on a model that can use P3 
channel.

** 2  �This setting is only available in the workstation mode.
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¾¾ [IO Mode Setting] dialog box

[IO Mode:]
Selects an IO mode option.
IO mode list►P263 

[Frame Rate:]

Selects a frame rate.
•	[59.94/29.97 fps]: Either of 59.94p, 29.97p, and 

59.94i
•	[50/25 fps]: Either of 50p, 25p, and 50i
•	[24 fps]: Either of 24p and 24PsF
•	[23.98 fps]: Either of 23.98p and 23.98PsF

[Settings...]

By tapping, displays the dialog box for IO mode 
detailed settings to enable advanced settings 
regarding the selected IO mode.
IO mode detailed settings dialog box►P191 

¾¾ IO mode detailed settings dialog box

(1)

(2)

(3)

(1) [IO Mode:] Indicates the IO mode to be configured.
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(2)
List of SDI 
terminal 
setting

Displays a list of settings assigned to the SDI 
terminals on the video I/O board.

[Terminal]
Indicates the terminal name.

[Type]
Indicates the type.
•	[Recorder] indicates a terminal assigned to 

Recorder.
•	[Player] indicates a terminal assigned to Player.
•	[Monitor output] indicates a terminal that can 

be used for monitor output.
•	[(Not Available)] indicates a terminal that 

cannot be used.

[Channel]
Indicates the channel assigned to the SDI 
terminal or the channel set for monitor output.

[OSD]
Displays the settings for on-screen display.
If [Player] is indicated for [Type], tapping [...] 
allows to set the contents shown on the on-screen 
display.
On-screen display detailed settings dialog 
box►P106 

(3) [Channel:]/
[OSD:]

Allows to change the setting of a terminal 
selected from the list of SDI terminal setting. The 
items that can be configured differ depending on 
the terminal type or channel.
Terminal types and available settings►P192 

¾¾Terminal types and available settings

Terminal 

type

Settings available for 

[Channel:]
Settings available for [OSD:]

Recorder The channel setting for 
the Recorder terminal 
cannot be changed.
The preset Recorder 
channel will be 
displayed.

On-screen display is not 
available on Recorder channel.
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Terminal 

type

Settings available for 

[Channel:]
Settings available for [OSD:]

Player The channel setting 
for the Player terminal 
cannot be changed.
The preset Player 
channel will be 
displayed.

Select the setting of indication 
for on-screen display on the 
Player channel.

[Off]
Does not show on-screen 
display on the Player channel.

[Both]
Shows on-screen display both 
on the Player channel preview 
of the T2 screen and on the 
output video from the SDI 
terminal.

[PC Preview only]
Shows on-screen display only 
on the Player channel preview 
of the T2 screen.
On-screen display is not shown 
on the output video from the 
SDI terminal.

Monitor 
output

Select Recorder 
channel*1 or Player 
channel as an output 
channel from the 
monitor output 
terminal.

[Off]
Does not show on-screen 
display on the output video 
from the SDI terminal.

[On]
Shows on-screen display on 
the output video from the SDI 
terminal.
Displays the same contents as 
those of the on-screen display 
detailed settings for the Player 
channel that has been set for 
[Channel:].

*1	 For monitor output of Recorder channel, prior setting is necessary. Go 
to the setting screen, [General] -> [Hardware] tab, and select [Input] for 
[Reference:]. If [External] or [Internal] has been selected, output video 
cannot be displayed properly.
General – Hardware settings►P189 
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¾¾ [ASIO audio device] dialog box (workstation mode only)

[Device:] Selects the ASIO audio device to use.

Audio terminal list
Displays a list that includes audio device 
terminals and the audio channels assigned to 
each of the terminals.

[Channel:]
Sets the channel of the Recorder or Player to be 
assigned.

[Audio:] Sets the audio channel to be assigned.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.

General – Network-1/Network-2 settings
You can make network settings of your T2.

1	 Tap [General], and then tap the [Network-1] tab or [Network-2] 
tab in the setting screen.
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¾¾ [Network-1]/[Network-2] tab

[Obtain an IP address 
automatically]

Uses DHCP and sets an IP address 
automatically.

[Use the following IP 
address:]

Used to connect to the local area network by 
specifying the IP address, subnet mask, and 
default gateway.

[IP address:]
Specifies an IP address.

[Subnet mask:]
Specifies a subnet mask.

[Default gateway:]
Specifies a default gateway.

[Obtain a DNS server 
address automatically]

Uses DHCP and sets a DNS server address 
automatically.

[Use the following DNS 
server addresses:]

Used to connect to the local area network by 
specifying the address of the preferred DNS 
server and an alternate DNS server.

[Preferred DNS server:]
Specifies the address of the preferred DNS 
server.

[Alternate DNS server:]
Specifies the address of an alternate DNS 
server.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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General – Network-3 settings
You can set the network drive to connect with your T2.

1	 Tap [General], and then tap the [Network-3] tab in the setting screen.

¾¾ [Network-3] tab

Network drive list Displays the list of currently set network drives.

[Add...]*

By clicking, displays the [Map Network Drive] 
dialog box and adds a network drive.
[Map Network Drive] dialog box (workstation 
mode only)►P196 

[Disconnect]* Disconnects the network drive.

[Reconnect]
Reconnects the network drive that is in 
disconnected status.

** Only available in the workstation mode.

¾¾ [Map Network Drive] dialog box (workstation mode only)

[Drive:] Assigns a drive letter to a network drive.

[Folder:]

Enter the “server name and shared folder” or 
“IP address and shared folder” in the entry area.
You can click [Browse...] to specify the path of 
the network drive.

[Reconnect on next 
bootup]

By checking, restores the network drive 
allocations on the next start-up of T2.
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2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.

General – FTP settings
You can configure FTP settings when T2 is used as FTP server, or the 
destination when external FTP server is used for a file transfer destination.

1	 Tap [General], and then tap the [FTP] tab in the setting screen.

¾¾ [FTP] tab

[FTP Server]

Displays the FTP settings when T2 is used as FTP server.

[Settings...]
By tapping, configures FTP settings for T2.
Tapping it displays the FTP setting dialog box for 
T2 to configure the settings.
FTP setting dialog box for T2►P198 

[Start]
Sets and uses T2 as FTP server.

[Stop]
Releases the setting and stops using T2 as FTP server.

[Limit the FTP transfer rate while recording or playing.]
By checking, automatically restricts FTP transfer 
rate while recording or playing. Tapping the entry 
area allows to change the limit value of the transfer 
rate. Different limit values can be specified for 
uploading and downloading, and when uploading 
and downloading are performed simultaneously, 
the transfer rate will be the double of the set value.
If this option is unchecked, the recording/
playback operations may not be performed 
normally, therefore, we recommend that you use 
the system with this option checked.
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[FTP Export List]

Displays the list of the FTP servers set as file 
transfer destinations.

[Add...]
Tapping it displays the FTP destination setting 
dialog box to configure the destination server.
FTP destination setting dialog box►P198 

[Delete]
Deletes a server from [FTP Export List].

[Change...]
Changes the server settings.

¾¾FTP setting dialog box for T2

[User Name:]/
[Password:]

Enter a user name and password.

[Max Clients:]
Specifies the maximum number of users allowed 
to access the FTP server of T2.

[Bin(root directory):]
Specifies the bin to store media files uploaded to 
the root directory.

¾¾FTP destination setting dialog box

[Setting Name:] Enter the server setting name.

[Host Name/IP 
Address:]

Enter the IP address or host name of the FTP 
server.
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[Port Number:] Enter a port number (1 to 65535).

[Directory:]
Enter the address of file transfer destination 
folder (bin).

[User Name:]/
[Password:]

Enter a user name and password.

[Connection Test]
By tapping, tests the FTP connection with the 
entered user name and password.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.

General – Share Folder settings
You can make settings for the user account of T2 and shared folders such 
as WatchFolder, direct access folder, etc.

TIP •	If you copy media files to the WatchFolder of the internal 
storage, recording or playback may be affected.

•	Direct access folder is read only.

1	 Tap [General], and then tap the [Share Folder] tab in the setting screen.

¾¾ [Share Folder] tab

[User Accounts :]

Sets the user account of T2. A user account is 
required when you access the WatchFolder or 
direct access folder in the internal storage.

[Settings...]
By tapping this, the dialog box to configure the 
user account settings of T2 will be displayed. To 
enable the settings, you must restart your T2.
User Accounts setting dialog box►P201 
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[Watch Folder]

Monitors the specified WatchFolder and imports 
media files automatically. To enable the settings, 
you must restart your T2.
Importing a media file on WatchFolder►P61 

[Destination :]
Selects the saving destination bin for the media 
files to be imported.

[Set folder in local storage as watch folder]
By checking, monitors the shared folder of the 
internal storage as WatchFolder.
Indicates the WatchFolder name, and user name 
and password to access the WatchFolder. To 
enable the settings, you must restart your T2.

[Set external folder in external media / storage as 

watch folder]
By checking, allows to set a folder on an external 
media or storage as WatchFolder. To enable the 
settings, you must restart your T2.

[Path :]
Specifies the folder to monitor as WatchFolder.

[Direct access 
folder] 
(T2 4K Elite/T2 4K 
Elite Plus only)

Directly accesses a media file in the internal 
storage via Windows common internet file 
system (CIFS). To enable the settings, you must 
restart your T2.
Directly loading a clip recorded or being recorded 
(T2 4K Elite/T2 4K Elite Plus only)►P74 

[Share a T2 media storage as share folder]
By checking this, the internal storage will be set 
as a shared folder to share the saved media files, 
which can be accessed from clients. Media files 
that can be accessed are AVI and MXF only.

[Limit the operation(delete, rename) on T2 when 

using media file]
By unchecking this, deleting or renaming of the 
media files accessed from clients will be enabled 
on T2.
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¾¾User Accounts setting dialog box

[User Name:]/
[Password:]

Sets the user account. A user account is required 
when a client access the WatchFolder or direct 
access folder in the internal storage. You can 
access all folders in the internal storage using any 
account.
The default user name and password are as 
follows.
(User Name) GVadmin (Password) adminGV!
(User Name) watchuser (Password) 
watchpassword

[Add...] Add user account.

[Delete] Deletes a selected user account.

[Change...] Edit a selected user account.

TIP •	The user account setting is enabled after T2 is restarted. 

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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General – Miscellaneous settings
You can configure display language for T2 software, restart status, or 
other settings.

1	 Tap [General], and then tap the [Miscellaneous] tab in the setting 
screen.

¾¾ [Miscellaneous] tab

[Language:]
Selects the display language for T2 software from 
the list.
To enable the settings, you must restart your T2.

[DF mode:]
Select [DF] to set drop frame display to timecode, 
or select [NDF] to set non-drop frame display.

[Playlist auto scroll:]
Sets whether to scroll the event list automatically 
when playing a playlist.

[Playlist event 
template:]

By tapping [Settings...], sets the effect as the event 
template of the playlist. The template setting is 
applied to newly added events.
The event template setting dialog box►P204 

[Playlist View 
Style:]*1

By clicking [Settings...], changes the settings for 
event display or event background color in the 
workstation mode.
[Playlist View Style:] dialog box (workstation mode 
only)►P204 

[Playlist 
Placeholder]*1

By clicking [Settings...], configures the settings 
to secure the space for events to be added to 
playlists before actually adding an event to a 
playlist.
[Playlist Placeholder] dialog box (workstation mode 
only)►P205 
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[Marker :]
By clicking [Settings...], changes the settings for 
markers.
[Marker] dialog box►P124 

[Allow mounting of 
non paired contents 
to player, in P1/P2 
synchronized mode]

By checking, allows to mount non paired 
contents while in synchronized mode. When 
a non paired content is mounted while in 
synchronized mode, channels that are not 
mounted are output as black screen.
Sync playback of contents (Sync mode)►P101 

[Preview update 
interval:]*1

By clicking [Settings...], sets the update interval 
of preview of the Recorder channel or the Player 
channel.
[Preview update interval:] dialog box (workstation 
mode only)►P206 

[Date and Time :]
By tapping [Settings...], sets the date and time.
Date and time setting dialog box►P206 

[Status at the next 
startup]

Sets whether to restore the status of the time 
when exiting T2 at the next start-up.

[Keep the connections on the browse tab]
By checking, restores the removable media 
connection status displayed in the [Browse] tab. 
The removable media state displayed in the 
[Browse] tab will be updated at the next start-up.

[Automatically playback the mounted contents on Px]
By checking, restores the contents status loaded 
to the Player channel.
By checking [Keep the playback frame positions on 
Px], restores the scrubbing bar playing position.
Checking [Automatically playback the mounted 
contents on Px] plays the contents loaded to the 
Player channel automatically at the next start-up.
*	 The names or In/Out points of media files loaded 

directly from the [Browse] tab cannot be restored.

*1	 Only available in the workstation mode.
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¾¾The event template setting dialog box

[Start Effect] tab
Sets the effects for event starting (start effects).
Event – [Start Effect] tab►P114 

[End Effect] tab
Sets the effects for event ending (end effects).
Event – [End Effect] tab►P115 

[Default] Deletes event template settings.

¾¾ [Playlist View Style:] dialog box (workstation mode only)

[Current Event 
Background Color:]

Sets to show/hide the background color 
indicating that the event has the playback 
position on the scrubbing bar.
To change the background color, check this 
item and specify the value for R, G, and B. The 
specified color is displayed on the right.

[Next Event 
Background Color]

Sets to show/hide the background color 
indicating the next event of the event that has the 
playback position on the scrubbing bar.
To change the background color, check this 
item and specify the value for R, G, and B. The 
specified color is displayed on the right.
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[Selected Event 
Background Color]

Sets to show/hide the background color 
indicating the selected event.
To change the background color, check this 
item and specify the value for R, G, and B. The 
specified color is displayed on the right.

[Show keyboard 
shortcuts(A-Z, 
Function, 0-9 Key 
only)]

Sets to show/hide the keyboard shortcut icon 
assigned to the event.
*	 Icons can be shown only when the [A] to [Z] 

keys, function keys, and [0] to [9] keys on the 
keyboard are assigned.

[Show progress bar]
Sets to show/hide the progress bar of the 
playback.

¾¾ [Playlist Placeholder] dialog box (workstation mode only)

[Duration:]
Sets the duration of the place holder (hour/
minute/second).

[Replace mode (the 
content duration 
is longer than the 
placeholder's):]

Allows to select the replace mode from the list if 
the duration of the source is longer than that of 
the set place holder.

[Replace]
Replaces with a place holder maintaining the 
length of the source.

[Replace from start]
Replaces only the duration of the place holder 
from the In point.

[Replace from end]
Replaces only the duration of the place holder 
from the Out point.

[Show event 
property when 
adding]

By checking, displays the property screen of the 
place holder.

205January 1, 2020	 T2 User Manual

General settings



¾¾ [Preview update interval:] dialog box (workstation mode only)

 

[Update mode:]
To set the update interval of preview 
automatically, select [Auto], and to set it manually, 
select [Manual].

[R1:]/
[P1, P2, P3: Update 
every]*1

Set when [Manual] is selected in [Update mode].
Enter the number of frames in [frames] of [R1:] or 
[P1, P2 ,P3: Update every]. If the value is larger, 
the preview update interval becomes longer. 
(By default, the preview is updated every two 
frames.)
If you do not want to update the preview, 
uncheck [Update preview].

*1	 Settings for P3 channel are only available on a model that can use P3 
channel.

¾¾Date and time setting dialog box

[Date :] By clicking the icon on the calendar, sets the date.

[Time :] Sets the time.
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[Time zone :]

Displays the current time zone setting. This 
setting can be changed in the maintenance mode. 
For more information about the maintenance 
mode, refer to the T2 Service Manual.

[Internet Time]

Checking [Synchronize with an Internet time 
server], and then restarting or clicking [Update 
now] synchronizes with the Internet time server.
Synchronization of time can be set from 1 to 24 
hours. (Workstation mode only)

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.

Recorder settings

Recorder – Input Settings
You can make settings for input format to record in the Recorder channel.

1	 Tap [R1], and then tap the [Input Settings] tab in the setting screen.

¾¾ [Input Settings] tab

[Input Capability]

According to the selection for [IO Mode] in 
[General] -> the [Hardware] tab, displays the 
connector to be used for input with green highlight.
[IO Mode Setting] dialog box►P191 

[Quad Link 3G-SDI:]*1

Selects the input format of Quad Link 
3G-SDI between [Square Division (SQD)] and 
[2-Sample Interleave (2SI)].
This option is available only when the input 
format is “3840×2160 50/59.94p” or “4096×2160 
50/59.94p”.

207January 1, 2020	 T2 User Manual

Recorder settings



[Video]

[Input format:]
Selects the format for video input.

[Aspect:]
For SD input, selects the aspect ratio.

[Compression]

[File type :]
Selects the compression format.

[Bitrate :]
Selects a bit rate that supports the compression 
format.

[Audio format :]
Selects an audio format that supports the 
compression format.

[ClosedGOP]
By check this item when a compatible codec 
is used, all the information will be included 
within the GOP. It increases the data size, but 
allows re-editing with editor software that can 
handle GOP. Uncheck it normally.

*1	 This setting is not available for T2 4K Express/T2 4K Express Plus.

TIP •	You can load a file being recorded to an external media/storage 
to editing software, and operate time-shift editing.
Loading and editing T2 contents to editing software►P71 

•	Chasing playback during recording data is available.
Loading and playing back video currently recorded (chasing 
playback)►P99 

NOTE •	While recording in the MXF (XDCAM HD422/HD/IMX/DV, 
Apple ProRes 422 HQ/422/422 LT/422 Proxy, Avid DNxHD 
220/145/100/36) format is being performed, some sources 
(such as clips with restricted playback counts) cannot be 
played back. If this is the case, playback will be stopped. 
While recording in the MXF (XDCAM HD422/HD/IMX/DV, 
Apple ProRes 422 HQ/422/422 LT/422 Proxy, Avid DNxHD 
220/145/100/36) format is being performed,  format conversion 
is not available.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Recorder – Timecode & Remote settings
You can make settings for the timecode or Recorder channel remote 
control when recording in the Recorder channel.

1	 Tap [R1], and then tap the [Timecode & Remote] tab in the 
setting screen.

¾¾ [Timecode & Remote] tab

[Select Timecode]
Selects the timecode type from [TC(LTC)] and 
[SDI (VITC)].

[Recorded Timecode]

Selects the timecode to use for recording.
To use the timecode of an external device, 
select [External].
To use the time of T2, select [Internal - System 
time].
If [Internal - Specified start TC] is selected, tap 
the entry area and specify the timecode.
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[Record ancillary data]

Sets whether to include VANC data while 
recording.
If [ON] is selected, ancillary data is added on 
recorded video, which can be played back on T2.
If video is recorded in the MXF format of 
XDCAM HD or HD422, store the ancillary 
data according to SMPTE 436M. In this case, 
the ancillary data can be exported to a device 
compatible with SMPTE 436M.
Chase playback of the video with ancillary 
data is also available. Only one playback 
channel can be used while chase playback is 
being performed.
Loading and playing back video currently recorded 
(chasing playback)►P99 

[Remote Protocol(VTR 
Mode):]

When controlling a VTR from T2 in the 
Recorder-VTR mode, selects remote protocol 
(AMP/BVW).
If [AMP] is selected, set the IP address and 
channel of the VTR in [AMP Connection].

[Remote 
Protocol(Remote 
Mode):]

When controlling a T2 from an external 
controller in the Recorder-remote mode, selects 
a remote protocol (AMP/BVW).
Check [Enable local operations while being 
remote controlled.] to operate T2 locally even in 
the remote mode.

TIP •	If [Enable local operations while being remote controlled.] is 
checked, the operations available in the Recorder-remote mode 
are as follows.

-- Recording and stop
-- Entering a clip name
-- Editing tags (workstation mode only)
-- Displaying properties
-- Unloading clips
-- Setting markers, moving to markers

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Recorder – Capture settings
You can set whether to automatically export files being recorded in the 
Recorder channel.

1	 Tap [R1], and then tap the [Capture] tab in the setting screen.

¾¾ [Capture] tab

[Destination 
settings :]

Indicates the saving destination of the clips to be 
recorded and other information.
Tapping [Settings...] allows to set the saving 
destination.
Saving destination dialog box►P212 

[Split clip when 
time code has 
discontinued.]*1

By checking, divides clips when saving if the 
timecode being recorded is not continuous.

[Automatically 
export a clip 
being recorded.]

By checking, exports the file being recorded in 
the Recorder channel to the specified location 
automatically.

[Export path:] By tapping, allows to specify the export destination.

[VTR Capture]*2

Sets operations for the Recorder-VTR mode.

[Preroll :]
Sets the preliminary operation time (preroll) when 
recording is started.

[Margin :]
Sets the length of the margin added at In and Out 
points at recording operation.
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[VTR Batch 
Capture]*2

Sets the operations for batch capturing.

[Clip:]
Allows to change the clip name generated after the 
batch capture.

[When an error occurs, continue to capture the 

following items.]
By unchecking, recording of the next items and later 
to be batch captured will be stopped when an error 
occurs.

[Completed items are not captured.]
By unchecking, includes items whose batch 
capturing has completed as the target in the next 
capturing operation.

*1	 Disabled if the compression codec is Avid DNxHD.
*2	 Only available in the workstation mode.

¾¾Saving destination dialog box

[Destination]

Selects the saving destination of the clips to be 
recorded.
To save the clips to T2, select [Save to internal 
storage.], and then select the bin that is registered 
to T2 from the list.
Checking [Ingest to the selected bin] saves clips to 
the bin selected in the bin display area.
To save the clips to a destination other than T2, 
select [Save to external media / storage.].*1

If <non-registered> is indicated, set the external 
storage in advance.
Displaying media file in removable media►P52 
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[Clip naming rules]

Sets the naming rule of clips to be saved.
Tapping the entry area allows to enter the clip 
name.
Clicking [...] enters [Date] and/or [Time] after the 
clip name automatically.
If the name of the clip to be recorded next has 
been set in the Recorder channel, the clip name 
setting for the next recorded clip is prioritized.
Displaying Recorder channel in 1ch view►P41 

*1	 Only available in the workstation mode.

TIP •	If the data cannot be saved to an external storage at the time 
when recording starts, it is saved to the internal storage.

•	If writing does not catch up, the recording will be stopped.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.

Player settings

Player – Video settings
You can make settings for output format to load video to the Player 
channel and play it.

1	 Tap [P1] (or [P2]), and then tap the [Video] tab in the setting 
screen.

¾¾ [Video] tab
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[Output capability]

According to the selection for [IO Mode] in [General] 
-> the [Hardware] tab, displays the connector 
available for output with green highlights.
[IO Mode Setting] dialog box►P191 

[Format:] Selects the format for video output.

[Quad Link 3G-SDI:]*1

Selects the output format of Quad Link 
3G-SDI between [Square Division (SQD)] and 
[2-Sample Interleave (2SI)].
This option is available only when the output 
format is “3840×2160 50/59.94p” or “4096×2160 
50/59.94p”.

[3G SDI Level:]*1 Selects the signal for 3G SDI output between 
Level A and Level B.

[Aspect:] For SD, selects the aspect ratio from [4:3] and [16:9].

[Still image:]

Selects the display mode when playback has paused.
Selecting [Field] performs field corrections 
between still images. The video is displayed in 
a smooth still image.
Selecting [Frame] displays the top field and 
bottom field alternately. The video is displayed 
to be shaking.
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[Aspect Ratio 
Conversion:]

Selects how conversion is to be performed 
when the aspect ratio of the source loaded to 
the Player channel differs from the channel 
settings.
Selecting [Bars] displays black bars in the 
upper and lower or in the right and left.

Selecting [Crop] cuts the upper and lower parts 
or the right and left parts.

Selecting [Stretch] enlarges or reduces the 
whole image to fit the frame size of the screen.

[Auto play mode:]
Checking [Auto Play] automatically plays the 
video when a source is loaded to the Player 
channel.

[Automatically mount 
a clip being recorded 
on the player, when it's 
ready for playback.]

By checking, automatically loads a source 
being recorded in the Recorder channel to 
the Player channel when the source become 
transmittable.

[When a subclip 
is created in R1, 
automatically mount 
it in the playlist of the 
player.]

By checking, automatically adds a sub clip 
created in the Recorder channel to a playlist 
loaded to the Player channel.

*1	 This setting is not available for T2 4K Express/T2 4K Express Plus.
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NOTE •	Even when [Automatically mount a clip being recorded on 
the player, when it's ready for playback.] or [When a subclip 
is created in R1, automatically mount it in the playlist of the 
player.] was checked, they do not work in the following cases.

-- The specified channel is locked or the sync mode is set to on
-- The specified channel is in the Fill/Key signal output mode
-- The specified channel is in the remote mode (except when 
the local operations are enabled in the remote mode)

-- Being in the IO mode with no playback channel

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.

Player – Timecode & Remote settings
You can make settings for the timecode & remote control of Player 
channel.

1	 Tap [P1] (or [P2]), and then tap the [Timecode & Remote] tab in 
the setting screen.

¾¾ [Timecode & Remote] tab

[Playlist Remain TC:]

Selects the display style for the remaining time 
of playlist for on-screen display.
Selecting [Event] displays the remaining time 
of the event.
Selecting [Total] displays the remaining time of 
the whole playlist.
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[Remote protocol:]

When controlling T2 from an external 
controller in the Player-remote mode, selects a 
remote protocol (AMP/BVW/TC Chase).
Overview of AMP control►P236 
Overview of BVW control►P237 
Overview of TC Chase control►P237 

[Settings...]
Can be selected when TC Chase is selected for 
the remote protocol.
TC Chase setting dialog box►P218 

[Enable local 
operations while being 
remote controlled.]

By checking, allows to operate T2 locally even 
in the remote mode.

[Preroll :]
Rewinds a short duration of time before the In 
point and starts playback from the point.

[Postroll :]
Allows to set the playback duration by the 
seconds in order to play back video later than 
the Out point.

TIP •	If [Enable local operations while being remote controlled.] is 
checked, the operations available in Player-remote mode are as 
follows.

-- Scrubbing bar operations (workstation mode only)
-- Playback control operations (move to the first frame, rewind, 
frame reverse, stop, playback, frame forward, fast forward, 
and move to the last frame)

--Moving to In/Out points, setting In/Out points, deleting In/
Out points, creating sub clips

-- Switching display scale of the scrubbing bar
-- Switching audio level display
-- Creating thumbnail
-- Entering names of clips/playlists
-- Editing tags (workstation mode only)
-- Entering values for In point/Out point/duration, setting In 
point/Out point/duration

-- Editing playlist events list (add, delete, sort, copy, paste, and 
change names)

-- Displaying properties
-- Loading and unloading clips/playlists
-- Switching on/off for the sync mode, E to E mode, Loop mode
-- Operations with buttons on the lower part of the LCD
-- Setting markers, moving to markers
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¾¾TC Chase setting dialog box

[Internet Time]

Configures settings regarding the TC Chase 
control.

[When the input LTC is lost :]
Sets the operation when the input LTC is lost.
Select [Continue playback] to continue playback 
along the input timecode. Select [Stop playback] 
to stop playback.

[Offset :]
Sets the offset for the input LTC.
Select [Off] not to be set for the offset and to play 
back with the same timecode as the input LTC.
Select [On] to set the offset with a desired number 
of frames (-15 to 15 frames).
This is locked with the offset value set for the 
input LTC.

[Relock Threshold :]
Sets the threshold of timecode difference 
between input LTC and Player channel where the 
relocking function is to be activated to perform 
chasing.
Selecting [Off] disables the relocking function.
By selecting [On], you can set a desired frame 
number (between -15 and +15) for the difference 
that activates the relocking function.
If [Relock to sync with the input LTC when the 
remote mode turns on.] is checked, the timecode 
of input LTC and Player channel will be relocked 
in the accurate frames regardless of the set 
relocking threshold value, when the remote mode 
is switched from off to on.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Transfer settings

Transfer – common settings
You can make settings for file transfer.

1	 Tap [Transfer], and then tap the [Common] tab in the setting 
screen.

¾¾ [Common] tab

[Pause file transfers 
while recording or 
playing out.]

By unchecking, enables transfer and conversion 
even during a recording or playback. However, 
if this option is unchecked, the recording/
playback operations may not be performed 
normally, therefore, we recommend that you 
use the system with this option checked.

[Clip import 
configuration]

Selects the field order when importing 
Windows Media Audio and H.264 (QuickTime 
Video  (avc1)). Selecting [Auto] automatically 
selects and sets the appropriate field order.
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[Configure clip import 
(for not supported 
profile)]

Sets the frame size and scaling method when 
importing media files that do not match the 
profile supported by T2.

[Size:]
Selects the frame size for import.

[Scaling:]
Selects the scaling method when the frame size of 
the imported source differs from that set in [Size:].
Selecting [Bars] displays black bars in the upper 
and lower or in the right and left, to fit the long 
sides of the frame of the source to that set in [Size:].

Selecting [Crop] cuts the upper and lower parts 
or the right and left parts, to fit the short sides 
of the frame of the source to that set in [Size:].

Selecting [Stretch] stretches or reduces the 
whole image, to fit the frame size of the source 
to that set in [Size:].
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[Configure import of 
image and images in a 
sequence format]

Makes settings for import of still images or 
sequence still images.

[Format:]
Selects the format for import.

[Aspect:]
For SD, selects the aspect ratio from [4:3] and [16:9].

[Scaling:]
Selects the scaling method when the frame size 
of the imported source differs from that of the 
format set in [Format:].
Selecting [Bars] displays black bars in the upper 
and lower or in the right and left, to fit the long 
sides of the frame of the source to that of [Format:].

Selecting [Crop] cuts the upper and lower parts 
or the right and left parts, to fit the short sides 
of the frame of the source to that of [Format:].

Selecting [Stretch] stretches or reduces the 
whole image, to fit the frame size of the source 
to that of [Format:].

[Duration(still image):]
Sets the playback duration of the imported still 
images by seconds.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Transfer – AVCHD settings
You can make settings for the format to import AVCHD sources.

1	 Tap [Transfer], and then tap the [AVCHD] tab in the setting screen.

¾¾ [AVCHD] tab

[AVCHD Import 
Settings]

[File format after import:]
Selects whether to import the file in the native 
format or in a converted format at the time of 
import.
Selecting [AVI (HQX)] converts the files to 
Grass Valley HQX AVI format.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Transfer – AVI settings
You can make settings for the format when converting contents in Grass 
Valley HQX AVI format to MXF or MOV format to export.
Format supported for conversion►P259 

1	 Tap [Transfer], and then tap the [AVI] tab in the setting screen.

¾¾ [AVI] tab

[AVI Export 
Settings]

[Execute transcoding when exporting AVI file.]
By checking, converts files to the format set in 
[Advanced AVI transcoding settings] to export.

[Advanced AVI 
transcoding 
settings]

Part of available setting items differ according to the 
codec selected for [File type:].

[File type:]
Selects the file type.

[Format:]
Selects the format.

[Quality/Speed:]
Selects the quality.
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[Advanced AVI 
transcoding 
settings]

[Scaling:]
Selects the scaling method when the frame size of 
the exported contents differs from that of the format 
set in [Format:].
Selecting [Bars] displays black bars in the upper and 
lower or in the right and left, to fit the long sides of 
the frame of the contents to that of [Format:].

Selecting [Crop] cuts the upper and lower parts or 
the right and left parts, to fit the short sides of the 
frame of the contents to that of [Format:].

Selecting [Stretch] stretches or reduces the whole image, 
to fit the frame size of the contents to that of [Format:].

[Audio format:]
Selects the audio format.

[ClosedGOP]
By checking, the information are closed within 
GOP. It increases the data size, but allows re-editing 
with editor software. Uncheck it normally.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Transfer – MXF settings
You can make settings for the format to import MXF sources.

1	 Tap [Transfer], and then tap the [MXF] tab in the setting screen.

¾¾ [MXF] tab

[MXF Import Settings]

[File format after import:]
Selects whether to import the file in the native 
format or in a converted format at the time of 
import.
Selecting [AVI (HQX)] converts the files to 
Grass Valley HQX AVI format.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Transfer – XDCAM settings
You can make settings for the format to import XAVC, XDCAM, and 
XDCAM EX sources.

1	 Tap [Transfer], and then tap the [XDCAM] tab in the setting screen.

¾¾ [XDCAM] tab

[XDCAM Import 
Settings]

[File format after import:]
Selects whether to import the file in the native 
format or in a converted format at the time of 
import.
Selecting [AVI (HQX)] converts the files to 
Grass Valley HQX AVI format.

[XDCAM EX Import 
Settings]

[File format after import:]
Selects whether to import the file in the native 
format or in a converted format at the time of 
import.
Selecting [AVI (HQX)] converts the files to 
Grass Valley HQX AVI format.

[XAVC Import Settings]

[File format after import:]
Selects whether to import the file in the native 
format or in a converted format at the time of 
import.
Selecting [XAVC] imports the source in the 
native format. If the format of the file does not 
support the native format import, it is converted 
to Grass Valley HQX AVI automatically.
Selecting [AVI (HQX)] converts the files to 
Grass Valley HQX AVI format.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Transfer – P2 settings
You can make settings for the format to import P2 sources.

1	 Tap [Transfer], and then tap the [P2] tab in the setting screen.

¾¾ [P2] tab

[P2 Import Settings]

[File format after import:]
Selects whether to import the file in the native 
format or in a converted format at the time of 
import.
Selecting [P2] imports the source in the 
native format. If the format of the file does 
not support the native format import, it 
is converted to Grass Valley HQX AVI 
automatically.
Selecting [MXF (OP-1a)] converts the files to 
MXF (OP-1a).
Selecting [AVI (HQX)] converts the files to 
Grass Valley HQX AVI format.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Transfer – QT settings
You can make settings for the format to import QuickTime sources.

1	 Tap [Transfer], and then tap the [QT] tab in the setting screen.

¾¾ [QT] tab

[QuickTime Import 
Settings]

[File format after import:]
Selects whether to import the file in the native 
format or in a converted format at the time of 
import.
Selecting [QuickTime] imports the source 
in the native format. If the format of the file 
does not support the native format import, 
it is converted to Grass Valley HQX AVI 
automatically.
Selecting [AVI (HQX)] converts the files to 
Grass Valley HQX AVI format.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Transfer – Playlist settings
You can make settings for the format to export playlists.

1	 Tap [Transfer], and then tap the [Playlist] tab in the setting 
screen.

¾¾ [Playlist] tab

[Playlist Export 
Settings]

[File format after export:]
Selects the format for export.
Selecting [Use AVI transcode settings] converts 
the files with a codec selected for [Advanced 
AVI transcoding settings] in the [AVI] tab and 
exports it.
Selecting [AVI (HQX)] converts the files to 
Grass Valley HQX AVI and exports it.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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GPI settings

GPI – Input settings
You can make settings to control T2 with GPI input.

1	 Tap [GPI], and then tap the [Input] tab in the setting screen.

¾¾ [Input] tab

[GPI-Input]
Displays the number of the selected GPIO input pin.
Tap [Previous] or [Next] and select a GPIO 
input pin to set.

[Trigger settings]

Sets the GPI input trigger.

[Channel:]
Selects the channel to control with GPI input.

[Active:]
Selects the GPI signal to activate from [High] 
and [Low].

[Action:]
Selects the action when the GPIO input pin 
selected in [GPI-Input] is input.
List of actions for trigger setting►P230 

¾¾List of actions for trigger setting
[Stop] Stops playback or recording.

[Play] Plays the contents loaded to the channel.

[Record] Starts recording.

[Rewind]
Rewinds contents. When it comes to the 
beginning of the loaded contents or when 
performing another operation, rewinding stops.
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[FastFwd]
Fast forwards contents. When it comes to the 
end of the loaded contents or when performing 
another operation, fast forwarding stops.

[CueStart] Moves to the In point of the loaded contents.

[CueEnd] Moves to the Out point of the loaded contents.

[Eject] Unloads the loaded contents.

[Preview]
Loads the clip that is loaded to the R1 channel 
to the P1 channel.

[CueNextEvent]

When loading a playlist, moves to the next 
event of the selected event.
It allows to include the position of the next 
marker as a moving destination. In the 
[Marker] dialog box, check [Show marker icons 
on the scrub bar], click [When moving to edit 
point :] list and select [Cue up on Markers].
[Marker] dialog box►P124 

[CuePrevEvent]

When loading a playlist, moves to the previous 
event of the selected event.
It allows to include the position of the previous 
marker as a moving destination. In the 
[Marker] dialog box, check [Show marker icons 
on the scrub bar], click [When moving to edit 
point :] list and select [Cue up on Markers].
[Marker] dialog box►P124 

[VARPlayback]
Performs variable playback of the loaded 
contents in the speed specified in [VAR setting:].
Miscellaneous – Jog/Shuttle settings►P233 

[VARPlay+0.1] Increase playback speed by  x0.1.

[VARPlay-0.1] Decrease playback speed by -x0.1.

[VARPlay+0.01] Increase playback speed by x0.01.

[VARPlay-0.01] Decrease playback speed by -x0.01.

[Keyboard Shortcut]

Assign GPI Input 1 - 8 to a key on the 
keyboard. When GPI input is active, the 
keyboard shortcuts will be active.
Major keyboard shortcuts►P172 

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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GPI – Output settings
You can make settings to control external devices by T2 with GPI output.

1	 Tap [GPI], and then tap the [Output] tab in the setting screen.

¾¾ [Output] tab

[GPI-Output]
Displays the number of the selected GPIO output pin.
Tap [Previous] or [Next] and select a GPIO output 
pin to set.

[Settings]

Sets the GPI output trigger.

[Name:]
Sets the name of the GPI output trigger.

[Active:]
Selects the GPI signal to activate from [High] and [Low].

[Mode:]
Sets the GPI output trigger mode.
Selecting [Trigger] controls an external device with 
GPI output by specifying a trigger for an event in the 
playlist loaded to the P1 channel of T2.
Selecting [Tally - R1] outputs tally signal from GPI 
and lights up the tally lamp of the external monitor 
while recording in the R1 channel.
Selecting [Tally - P1] (or [Tally - P2] or Tally - P3]*1) 
outputs tally signal from the GPI and makes 
the tally lamp on the external monitor lit while 
playback (including single or variable speed, 
fast-forward, and rewind) is performed on the P1 
channel (or P2 or P3 channel).

*1	 Settings for P3 channel are only available on a model that can use P3 channel.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Other settings

Miscellaneous – Jog/Shuttle settings
You can make settings for operations of the jog/shuttle.

1	 Tap [Miscellaneous], and then tap the [Jog/Shuttle] tab in the 
setting screen.

¾¾ [Jog/Shuttle] tab

[Shuttle speed:]
Selects the maximum speed for playback when 
playing with the jog/shuttle.

[VAR setting:]
Selects the playback speed when 
[VARPlayback] is selected in [Trigger settings] 
in the [GPI] -> [Input] tab of the setting screen.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Miscellaneous – AMP settings
You can make settings for the AMP command actions when you control 
T2 from an external device with the AMP command.

1	 Tap [Miscellaneous], and then tap the [AMP] tab in the setting 
screen.

¾¾ [AMP] tab

[Command behavior]

[EraseID:]
Makes settings for the actions of Erase ID 
command of AMP.
Selecting [Recycle] moves the contents to the 
recycle bin.
Selecting [Delete] deletes the contents 
completely.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Miscellaneous – Remote settings
You can make settings for the remote actions when you control T2 from an 
external device with the GPI/RS422 command.

1	 Tap [Miscellaneous], and then tap the [Remote] tab in the setting 
screen.

¾¾ [Remote] tab

[Remote(GPI/RS422) 
Start/Stop Delay:]

Sets delay to be applied when the playback 
start or stop command is executed while GPI 
control is performed.
Selecting [No (Minimum)] doesn't set delay. 
Select this option when it is not necessary to 
synchronize multiple T2s.
Selecting [Yes (Sync Multiple T2s)] sets delay. 
When multiple T2s are used, this is selected.
Selecting [Custom] sets delay. You can set 
custom delay frames.

2	 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Section 11
Remote Control

This section describes the remote control using GPI input/output, AMP 
command, BVW, and TC Chase command.

Remote control using AMP/BVW/TC Chase

Overview of AMP control
For T2, the following AMP control are available via Ethernet.
Controlling an external device from T2 with AMP/BVW (Recorder-VTR 
mode)►P238 
Controlling T2 from an external controller with AMP/BVW (Recorder-remote 
mode)►P238 
Controlling T2 from an external controller with AMP/BVW (Player-remote 
mode)►P239 

TIP •	For the AMP commands list, see “Appendix”.
AMP command list►P265 

•	For AMP specifications and settings, refer to the Grass Valley 
AMP protocol documents on our website or the following 
URL.
http://www.gvgdevelopers.com/concrete/apis/amp_protocol/
documentation/

•	For sample source codes of AMP protocol, refer to our website 
or the following URL.
http://www.gvgdevelopers.com/concrete/apis/amp_protocol/
amp-socket-connection-example/

•	The port number of T2 for connecting AMP is 3811.
•	The strings for channel names are as follows: “vtr1” for R1, 

“vtr2” for P1, “vtr3” for P2, and “vtr4” for P3.

NOTE •	The AMP commands for T2 do not support controlling via 
RS422.

•	AMP control sample program software is not eligible for 
product support.
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Overview of BVW control
For T2, the following BVW control are available via RS422.
Controlling an external device from T2 with AMP/BVW (Recorder-VTR 
mode)►P238 
Controlling T2 from an external controller with AMP/BVW (Recorder-remote 
mode)►P238 
Controlling T2 from an external controller with AMP/BVW (Player-remote 
mode)►P239 

TIP •	For the BVW list of commands used in the Recorder-VTR 
mode, see “Appendix”.
BVW command list►P278 

•	For the availability of BVW commands used in the remote 
mode, see “Appendix”.
BVW list supporting remote mode►P279 

•	For the input/output pin assignment of RS422, see “Appendix”.
RS422 input/output pin►P280 

•	For synchronized mode or Fill/Key signal output mode, BVW 
commands can only control the P1 channel.
Sync playback of contents (Sync mode)►P101 
Playback of contents with alpha channel (Fill/Key signal output 
mode)►P103 

Overview of TC Chase control
T2 supports playback of Player channel whose frame accuracy 
synchronizes with SMPTE-compliant LTC.
Controlling T2 with TC Chase (Player-remote mode)►P240 

TIP •	For synchronized mode or Fill/Key signal output mode, TC 
Chase commands can only control the P1 channel.
Sync playback of contents (Sync mode)►P101 
Playback of contents with alpha channel (Fill/Key signal output 
mode)►P103 
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Controlling an external device from T2 with AMP/BVW 
(Recorder-VTR mode)
The operation of T2 to control an external device (VTR) with the AMP 
command (via Ethernet) or BVW command (via RS422), using T2 as a 
controller (master) is described in this part.
When you use the BVW command, you do not need to perform steps 1 to 3.

1	 Tap [Config.] on the touch screen LCD of T2.

2	 Tap [General], and then tap the [Network-1] tab or [Network-2] tab.

3	 Set the IP address of T2.

General – Network-1/Network-2 settings►P194 

4	 Tap [R1], and then tap [Timecode & Remote].

5	 Select a remote protocol from the list of [Remote Protocol(VTR 
Mode):].

If [BVW] is selected, proceed to step 7.

6	 If [AMP] is selected in step 5, set the IP address and channel of 
the VTR.

7	 Tap [OK].

8	 Press the [R1] button, and then tap [VTR].

Controlling of an external device from T2 with AMP command or BVW 
command will be enabled.

Controlling T2 from an external controller with AMP/
BVW (Recorder-remote mode)
The settings of T2 to control the Recorder channel of T2 from an external 
controller with the AMP command (via Ethernet) or BVW command (via 
RS422) is described in this part.
T2 accepts commands from the external controller as a device (slave).

1	 Tap [Config.] on the touch screen LCD of T2.

2	 Tap [R1], and then tap the [Timecode & Remote] tab.

3	 Select a remote protocol from the list of [Remote Protocol(Remote 
Mode):].
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TIP •	Check [Enable local operations while being remote controlled.] 
to operate T2 locally even in the remote mode.
Recorder – Timecode & Remote settings►P209 

4	 Tap [OK].

5	 Press the [R1] button, and then tap [Remote].

Controlling of Recorder channel from an external controller with AMP or 
BVW command will be enabled.

Controlling T2 from an external controller with AMP/
BVW (Player-remote mode)
The settings of T2 to control the Player channel of T2 from an external 
controller with the AMP command (via Ethernet) or BVW command (via 
RS422) is described in this part.
T2 accepts commands from the external controller as a device (slave).

1	 Tap [Config.] on the touch screen LCD of T2.

2	 Tap [P1] or [P2], and then tap the [Remote] tab.

Player – Timecode & Remote settings►P216 

3	 Select a remote protocol from the list of [Remote protocol:].

TIP •	Check [Enable local operations while being remote controlled.] 
to operate T2 locally even in the remote mode.
Player – Timecode & Remote settings►P216 

4	 Tap [OK].

5	 Press the [P1] button.

6	 Tap [Menu], and then tap [Remote].

[Remote] will be checked.
Controlling of Player channel from an external controller with AMP or 
BVW command will be enabled.

TIP •	For Erase ID command of AMP, you can set whether or not to 
delete clips completely.
Miscellaneous – AMP settings►P234 
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Controlling T2 with TC Chase (Player-remote mode)
This section describes the settings for TC Chase control to perform 
playback where the LTC input and the timecode of Player channel are 
synchronized.
TC Chase control requires reference signal input, in addition to the LTC input.

1	 Tap [Config.] on the touch screen LCD of T2.

2	 Tap [General], and then tap the [Hardware] tab.

General – Hardware settings►P189 

3	 Select a [External] from the list of [Reference :].

Confirm that it is synchronized with the input reference signal correctly.

4	 Tap [P1] or [P2], and then tap the [Video] tab.

Player – Video settings►P213 

5	 Select the format to playback.

6	 Tap the [Remote] tab of [P1] or [P2].

Player – Timecode & Remote settings►P216 

7	 Select a [TC Chase] from the list of [Remote protocol:].

TIP •	Check [Enable local operations while being remote controlled.] 
to operate T2 locally even in the remote mode.
Player – Timecode & Remote settings►P216 

8	 Tap [OK].

9	 Press the [P1] or [P2] button.

10	Tap [Menu], and then tap [Remote].

[Remote] will be checked.
Player channel will be played back, being synchronized with the input 
LTC.

TIP •	In the workstation mode, you can check the timecode and 
timecode chase status of input LTC and Player channel.
Timecode Status display►P148 
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Remote control using GPI

Overview of GPI control
For T2, the following GPI control are available.

¾¾Controlling T2 with GPI input
You can control T2 by assigning actions to the GPIO input port (8 pins).
GPI input will be accepted regardless whether T2 is in the remote mode or 
the channel is locked.
On T2, configure the settings in [GPI] -> [Input] tab of the setting screen.
GPI – Input settings►P230 

NOTE •	When controlling T2 with GPI input, do not use RS422 at the 
same time. Controlling with RS422 may become disabled.

¾¾Controlling external devices from T2 with GPI output
Controlling external devices from T2 with GPI output►P241 

¾¾Tally output from GPI
You can configure your T2 to output tally signal from GPI and turn on the 
tally lamp of an external monitor while playing back or recording video.
On T2, configure the settings in [GPI] -> [Output] tab of the setting screen.
GPI – Output settings►P232 

TIP •	For GPI input/output pin, see “Appendix”.
GPI settings►P230 

Controlling external devices from T2 with GPI output
You can control an external device with GPI output by specifying a trigger 
for an event in the playlist loaded to the P1 channel of T2.

1	 Tap [Config.] on the touch screen LCD of T2.

2	 Tap [GPI], and then tap [Output].

GPI – Output settings►P232 

3	 Tap [Previous] or [Next] and select a GPIO output pin.

The number of the selected pin is displayed on the right of [GPI-Output].

4	 Set [Name:] and [Active:] in the trigger setting, and select 
[Trigger] from the list of [Mode].

5	 Tap [OK].
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6	 Load the playlist including the event to specify a trigger to the 
P1 channel.

7	 Press the [P1] button.

8	 Tap an event to set the trigger from the event list to select it.

The selected event is displayed with a blue frame.

9	 Tap [Menu], and then tap [Event Properties].

10	Tap the [GPI] tab.

11	Check [Trigger GPI] and select the name of the trigger setting set 
in step 4 from the list.

12	Select an action of the event to be the trigger.

•	Select [Start of Event] to set the playback start of an event to be the 
trigger.

•	Select [End of Event] to set the playback end of an event to be the 
trigger.

•	Select [Start plus] to add a specified time to the time of playback start 
of an event and set it to be the trigger. Tap the timecode and enter the 
time to add.

•	Select [End Minus] to subtract a specified time from the time of 
playback end of an event and set it to be the trigger. Tap the timecode 
and enter the time to subtract.

13	Tap [OK].
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Section 12
Utilizing ASIO audio device

This section describes how to use ASIO audio devices.

Using USB audio interface

Overview
The following data can be output from T2 via the output terminal of the 
USB audio interface.

•	Audio being played back on the Player channel (Ch1 - Ch8)
•	Audio currently in input preview on the Recorder channel (Ch1 - Ch8)

TIP •	T2 software needs to be updated to Version 3.2.1 or later.
Checking the model name and software version►P40 

•	The USB audio interface compatible with ASIO needs to satisfy 
the following conditions.

-- Compatibility with ASIO 2.0 (Output in 48 kHz sampling 
rate format is supported. Also, it is recommended that at 
least 24 bit in the bit depth is supported.)

-- The USB audio interface and driver software are compatible 
with Windows 10 (1607 Anniversary Update).
Operation-ensured products and versions for network audio 
(ASIO audio)►P256 

NOTE •	Even when all the conditions above are satisfied, performance 
is not guaranteed on all USB audio interface.

Step 1: Installing the driver software on T2
Follow the instruction manual supplied by the manufacturer of your USB 
audio interface, and install the driver software on T2.
The following procedure shows an example for a general USB audio interface.

1	 Connect a keyboard, mouse, and display to T2.

2	 Connect the USB audio interface to the USB terminal of T2.

Rear panel►P30 
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3	 Start up T2 in the maintenance mode.

TIP •	For details on the maintenance mode, see the T2 service 
manual.

4	 Install the driver software provided by the manufacturer of your 
USB audio interface.

5	 Configure the audio interface settings (as necessary).

6	 Start up T2 in the CommandCenter mode.

TIP •	For details on the CommandCenter mode, see the T2 service 
manual.

Step 2: Configuring the ASIO audio device on T2
Make settings for audio output on the T2 side.

1	 Start up T2 and switch to the workstation mode.

Starting up T2►P35 
Switching from the front panel mode to the workstation mode►P37 

2	 Click [Settings], and click [General] -> [Hardware].

General – Hardware settings►P189 

3	 Click [Settings...] of [ASIO audio device:].
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4	 In the [ASIO audio device] dialog box, select an ASIO audio 
device to use from the list of [Device:].

In the list of [Device:], the audio channels are listed according to the 
specifications of the ASIO audio device.

5	 For each audio output channel displayed in the audio terminal 
list, set the Player channel to be assigned in [Channel:], and set 
the audio channel to be assigned in [Audio:] (Ch1 - Ch8).

6	 Click [OK].

Using network audio (Dante Virtual Soundcard)

Overview
By installing Dante Virtual Soundcard (software) on T2, digital audio 
output can be performed via network.
Dante network audio feature enables the following output from T2.

•	Audio being played back on the Player channel (Ch1 - Ch8) can be 
output to the Dante network

•	Audio currently in input preview on the Recorder channel (Ch1 - Ch8) 
can be output to the Dante network

•	(By combining with a device that supports Dante) Audio signal can be 
output from T2 while being played back via the Dante network, using 
a Dante compatible device in a remote location

TIP •	For details on Dante, Dante Virtual Soundcard, and Dante 
Controller, see the following URL of Audinate.
https://www.audinate.com/

•	For technical documentation on Dante, see the following URL.
https://www.audinate.com/resources/technical-documentation
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Step 1: Installing Dante Virtual Soundcard software
1	 Obtain Dante Virtual Soundcard software and a license (charged).

TIP •	Dante Virtual Soundcard software and license are available 
from the following URL.
https://www.audinate.com/products/software/dante-virtual-
soundcard

2	 Connect a keyboard, mouse, and display to T2.

3	 Start up T2 in the maintenance mode.

TIP •	For details on the maintenance mode, see the T2 service 
manual.

4	 On T2 in the maintenance mode, install Dante Virtual Soundcard 
software, and then activate the license.

Step 2: Configuring Dante Virtual Soundcard on T2
1	 On T2 in the maintenance mode, go to the start menu, and click 

[Audinate] -> [Dante Virtual Soundcard].

The setting application of Dante Virtual Soundcard will start up.

2	 In the [Settings] tab, select [ASIO] for [Audio Interface:].
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3	 For [Audio Channels:], set the maximum number of audio 
channels to be output from T2 to the Dante network.

“The number of input audio channels x The number of output audio 
channels” is indicated in the field.
In the example of the following screen, a total of eight channels of audio 
will be output to the Dante network.

NOTE •	T2 does not use input audio channels from the Dante network.

4	 For [Network Interface:], select the network port for the Dante 
network.

[Ethernet] corresponds to the left LAN terminal on the T2 rear panel, and 
[Ethernet 2] corresponds to the right LAN terminal.
Rear panel►P30 

5	 Click [Start].

Dante Virtual Soundcard service will be started.
On T2, Dante Virtual Soundcard service is recognized as ASIO audio device. 

6	 Start up T2 in the CommandCenter mode.

TIP •	For details on the CommandCenter mode, see the T2 service 
manual.
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Step 3: Configuring the ASIO audio device on T2
Make audio output settings on T2.

1	 Start up T2 and switch to the workstation mode.

Starting up T2►P35 
Switching from the front panel mode to the workstation mode►P37 

2	 Click [Settings], and click [General] -> [Hardware].

General – Hardware settings►P189 

3	 Click [Settings...] of [ASIO audio device:].

4	 In the [ASIO audio device] dialog box, select the Dante Virtual 
Soundcard from the list of [Device:].

In the list of [Device:], the audio channels are listed according to the 
specifications of the Dante Virtual Soundcard service.
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5	 For each audio output channel displayed in the audio terminal 
list, set the Player channel to be assigned in [Channel:], and set 
the audio channel to be assigned in [Audio:] (Ch1 - Ch8).

6	 Click [OK].

Step 4: Connecting T2 to the Dante network
1	 Connect T2 to the Dante network.

Connect either one of the LAN terminals on the rear panel of T2 to the 
Dante network.
Rear panel►P30 

TIP •	The IP address of T2 can be set by tapping [Settings] on T2, 
and then selecting [General] -> [Network 1] or [Network 2]. 
[Network 1] corresponds to the LAN terminal on the left, and 
[Network 2] corresponds to the LAN terminal on the right.
General – Network-1/Network-2 settings►P194 

2	 Use the Dante Controller of the PC on the Dante network to map 
audio output.

The following screen shows an example in which output of top two 
channels of the 16 output channels set on T2 are mapped to the L/R audio 
output terminal of Focusrite RedNet AM2, using the Dante controller.

Once the setting has been mapped, it will be applied automatically even 

when the T2 main unit is restarted.

TIP •	For details on Dante Controller, see the following URL.
https://www.audinate.com/products/software/dante-controller
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Section 13
Appendix
This section includes the list of the keyboard shortcut in the workstation mode, input/output format, 
operation-ensured drivers for each device, AMP command, and BVW command.

Keyboard shortcut list in workstation mode
The following list shows the keyboard shortcuts.

TIP •	In the workstation mode, you can change keyboard shortcut assignments.
Changing keyboard shortcut assignment►P172 

Category Action Shortcut

[General] [Select R1 channel] [1]
[Select P1 channel] [2]
[Select P2 channel] [3]
[Select P3 channel]*7 [4]
[Change focus to the folder list]
[Change focus to the content list]
[Change focus to the playlist of the selected channel]

[Change focus to the marker list of the selected channel]
[Switch between 1ch View and 2ch/3ch View]
[Change the content’s tab]
[Show the Configuration screen]
[Show the content search screen]
[Lock/Unlock the selected channel]
[Turn On/Off the Loop in the selected channel (P1/P2/P3)]*7

[Turn On/Off the EtoE in the selected channel (P1/P2)]
[Turn On/Off the Remote of the selected channel (P1/P2/P3)]*7

[Turn the sync play mode On/Off]

[Show / Hide the expand setting in the selected channel]
[Show the audio setting in the selected channel]
[Show the VAR setting in the selected channel]
[Show the timecode status in the selected channel]
[Show the marker list in the selected channel]
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Category Action Shortcut

[General] [Eject the selected channel]
[Start Recording the selected channel (R1)] [M]
[Start playback in the selected channel] [L]
[Play reverse in the selected channel] [J]
[Play or pause the selected channel] [Space]
[Stop playing/recording in the selected channel] [K]
[Fast Forward (skip) in the selected channel] [;]
[Rewind (1 step back) in the selected channel] [H]
[Increase (1 step forward) the VAR speed in the selected 
channel] [.]

[Slower (1 step back) the VAR speed in the selected channel] [,]
[Increase (0.1 forward) the VAR speed in the selected 
channel]
[Slower (0.1 back) the VAR speed in the selected channel]
[Increase (0.01 forward) the VAR speed in the selected 
channel]
[Slower (0.01 back) the VAR speed in the selected channel]
[Move to top frame(previous event) of the selected channel] [A]
[Move to last frame(next event) of the selected channel] [S]
[Move to In point of the selected channel] [Shift+I]
[Move to Out point of the selected channel] [Shift+O]
[Move to the previous frame in the selected channel] [<-]
[Move to the next frame in the selected channel] [->]
[Move to the previous frame in the selected channel(JOG 
Mode)]*1

[Move to the next frame in the selected channel(JOG 
Mode)]*1

[Set the In point of the selected channel] [I]
[Set the Out point of the selected channel] [O]

[Clear the In/Out points of the selected channel]
[Ctrl]+[I]
[Ctrl]+[O]

[Fast forward (0.01 forward) the current speed in the 
selected channel]
[Fast forward (0.1 forward) the current speed in the selected 
channel]
[Slow (0.01 back) the current speed in the selected channel]
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Category Action Shortcut

[General] [Slow (0.1 back) the current speed in the selected channel]

[Add the marker to the selected channel]*2 [V]*3

[Add the marker to R1]*2

[Add the marker to P1]*2

[Add the marker to P2]*2

[Add the marker to P3]*2*7

[Load the content(s) to the selected channel]*4

[Load the content(s) to P1]*4

[Load the content(s) to P2]*4

[Load the content(s) to P3]*4*7

[Cue up to the event within the playlist in the selected 
channel]*5

[Cue up to the event within the playlist in the selected 
channel and pause]*5

[Cue up to the event within the playlist in the selected 
channel and play]*5

[Cue up to the event within the playlist P1]*5

[Cue up to the event within the playlist in P1 and pause]*5

[Cue up to the event within the playlist in P1 and play]*5

[Cue up to the event within the playlist P2]*5

[Cue up to the event within the playlist in P2 and pause]*5

[Cue up to the event within the playlist in P2 and play]*5

[Cue up to the event within the playlist P3]*5*7

[Cue up to the event within the playlist in P3 and pause]*5*7

[Cue up to the event within the playlist in P3 and play]*5*7

[Cue up to the marker in the selected channel]*6

[Cue up to the marker in the selected channel and pause]*6

[Cue up to the marker in the selected channel and play]*6

[Cue up to the marker in P1]*6

[Cue up to the marker in P1 and pause]*6

[Cue up to the marker in P1 and play]*6

[Cue up to the marker in P2]*6

[Cue up to the marker in P2 and pause]*6

[Cue up to the marker in P2 and play]*6
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Category Action Shortcut

[General] [Cue up to the marker in P3]*6*7

[Cue up to the marker in P3 and pause]*6*7

[Cue up to the marker in P3 and play]*6*7

[Contents List] [Mount the selected item on the selected channel] [Return]
[Mount the selected item on the selected channel (with 
shifting the focus)]
[Mount the selected item on the selected channel and 
pause]
[Mount the selected item on the selected channel and pause 
(with shifting the focus)]
[Mount the selected item on the selected channel and play]
[Mount the selected item on the selected channel and play 
(with shifting the focus)]
[Mount the selected item on P1]
[Mount the selected item on P1 (with shifting the focus)]
[Mount and pause the selected item on P1]
[Mount and pause the selected item on P1 (with shifting the 
focus)]
[Mount and play the selected item on P1]
[Mount and play the selected item on P1 (with shifting the 
focus)]
[Mount the selected item on P2]
[Mount the selected item on P2 (with shifting the focus)]
[Mount and pause the selected item on P2]
[Mount and pause the selected item on P2 (with shifting the 
focus)]
[Mount and play the selected item on P2]
[Mount and play the selected item on P2 (with shifting the 
focus)]
[Mount the selected item on P3]*7

[Mount the selected item on P3 (with shifting the focus)]*7

[Mount and pause the selected item on P3]*7

[Mount and pause the selected item on P3 (with shifting the 
focus)]*7

[Mount and play the selected item on P3]*7
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Category Action Shortcut

[Contents List] [Mount and play the selected item on P3 (with shifting the 
focus)]*7

[Scroll to top of selected item] [Home]
[Scroll to last selected item] [End]
[Delete selected item] [Delete]
[Copy selected item] [Ctrl]+[C]
[Cut selected item] [Ctrl]+[X]
[Paste item from the clipboard] [Ctrl]+[V]
[Show the rename dialog box for the selected item]
[Change the thumbnail frame color of the selected item to 
the default color]
[Change the thumbnail frame color of the selected item to 
the color 1]
[Change the thumbnail frame color of the selected item to 
the color 2]
[Change the thumbnail frame color of the selected item to 
the color 3]
[Change the thumbnail frame color of the selected item to 
the color 4]
[Change the thumbnail frame color of the selected item to 
the color 5]
[Show the film strip for the selected item]
[Show the properties for the selected item]

[Playlist] [Cue up to the selected event] [Return]
[Cue up and pause to the selected event]
[Cue up and play to the selected event]
[Delete the selected event] [Delete]
[Copy the selected event] [Ctrl]+[C]
[Paste the selected event] [Ctrl]+[V]
[Show the rename dialog box of the selected event]
[Set the fade in of the selected event to “none”]
[Set the fade in of the selected event to “from black”]
[Set the fade in of the selected event to “from white”]
[Set the fade out of the selected event to “none”]
[Set the fade out of the selected event to “from black”]
[Set the fade out of the selected event to “from white”]
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Category Action Shortcut

[Playlist] [Set the end effect action to “none” in the selected event]
[Set the end effect action to “Pause (Show black frame)” in 
the selected event]
[Set the end effect action to “Pause (Show white frame)” in 
the selected event]
[Set the end effect action to “Pause (Show last frame)” in the 
selected event]
[Set the end effect action to “Pause (Show next event frame)” 
in the selected event]
[Set the end effect action to “Pause (Show EtoE)”
in the selected event]
[Set the end effect action to “loop” in the selected event]
[Show the properties of selected event]

[Marker List] [Cue up to the selected marker] [Return]
[Cue up and pause to the selected marker]
[Cue up and play to the selected marker]
[Delete the selected marker] [Delete]
[Show the edit dialog box of the selected marker]
[Add comment to the selected marker(s)]*2

*1	 Using the shortcut for controlling from an external controller JOG, you can move frames 
smoothly when consecutive commands are received. It is most suitable when assigned to the 
JOG of Shuttle Pro, etc.

*2	 Can be assigned to marker comments (1 to 9).
*3	 A marker without comment is added.
*4	 Can mount clips and playlists that start with 00_ to 99_.
*5	 Can be set to the maximum of 100 events.
*6	 Can be set to the maximum of 100 markers.
*7	 Settings for P3 channel are only available on a model that can use P3 channel.
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Operation-ensured drivers for each device

Operation-ensured driver versions for XDCAM/XDCAM EX/XAVC/XAVC S
The operations of the following version of driver have been ensured on this product.

Product name Version

XDCAM Drive Software Ver. 5.0.9

Operation-ensured driver version for P2
The operations of the following version of driver have been ensured on this product.

Product name Version

Memory Card Drive “P2 drive”  AJ-PCD20 P2 Driver Ver. 2.29

Operation-ensured products and versions for USB audio interface (ASIO audio)
The operation of the following products and versions have been ensured on this product.

Product name Version

steinberg UR824 TOOLS for UR824 V2.1.6

TASCAM US-16x08 Settings Panel V3.00

NOTE •	Performance is not guaranteed for all operation.

Operation-ensured products and versions for network audio (ASIO audio)
The operation of the following products and versions have been ensured on this product.

Product name Version

Audinate Dante Virtual Soundcard v4.0.4.4

NOTE •	Performance is not guaranteed for all operation.
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Supported Formats

Supported formats of captured file (4K DCI/4K UHD)

Container Codec

AVI Grass Valley HQX

MXF Grass Valley HQX

Supported formats of captured file (HD/SD)

Container Codec

AVI Grass Valley HQX

MXF

Grass Valley HQX, XDCAM HD422, XDCAM HD, IMX, DVCAM,  
Apple ProRes 422 HQ, Apple ProRes 422, Apple ProRes 422 LT,  
Apple ProRes 422 Proxy, Avid DNxHD 220, Avid DNxHD 145,  
Avid DNxHD 100, Avid DNxHD 36

Supported formats of imported file (4K DCI/4K UHD)

Container Codec

AVI Grass Valley HQX, Grass Valley Lossless*1, Grass Valley Uncompressed*1

MXF H.264/AVC*1, Grass Valley HQX,  
Apple ProRes (422 HQ/422/422 LT/422 Proxy), Apple ProRes 4444*1

QuickTime
Apple ProRes (422 HQ/422/422 LT/422 Proxy), Apple ProRes 4444*1, 
Grass Valley HQX

MP4 H.264/AVC

XAVC 4K Intra (480*1/300*1), QFHD Intra (480*1/300*1), QFHD Long422 
(200*1/140*1/100*1), QFHD Long (150/100/60)

XAVC S H.264/AVC

P2 AVC-Intra 4K (422*1)

Windows Media Windows Media Video*1

Still Image Targa*1, Windows Bitmap*1, JPEG*1, TIFF*1, PNG*1, GIF*1, DPX*1,  
YUV Bitmap*1

*1	 Transcode to AVI (Grass Valley HQX) when importing.
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Supported formats of imported file (HD/SD)

Container Codec

AVI Grass Valley HQX, Grass Valley HQ, Grass Valley Lossless*1,  
Grass Valley Uncompressed*1, DVCPRO HD, DVCPRO50, DVCPRO25, DV

MXF
MPEG-2, H.264/AVC, Avid DNxHD (220x/220/145/100/36), Grass Valley HQX, 
Grass Valley HQ, DVCPRO HD, DVCPRO50, DVCPRO25, DV, D10/IMX, 
JPEG2000, Apple ProRes (422 HQ/422/422 LT/422 Proxy)

QuickTime

Apple ProRes (422 HQ/422/422 LT/422 Proxy), Apple ProRes 4444*1,  
XDCAM (HD422/HD), XDCAM EX, H.264*1, MPEG-4*1, Grass Valley HQX, 
Grass Valley HQ, DVCPRO HD*1,DVCPRO50*1, DVCPRO25*1, DV*1,  
Motion JPEG*1, Uncompressed*1

MP4 H.264/AVC

XDCAM XDCAM HD422, XDCAM HD, XDCAM IMX, XDCAM DV, XDCAM EX

XAVC HD Intra (200/100/50), HD Long422 (50/35/25)

XAVC S H.264/AVC

P2 AVC-LongG (50/25/12), AVC-Intra (200/100/50), DVCPRO HD, DVCPRO50, 
DVCPRO, DV

AVCHD H.264/AVC

MPEG-2 PS*1, TS*1

Windows Media Windows Media Video*1

GXF Grass Valley HQ*2, MPEG-2 (Intra Frame)*2, H.264/AVC (Intra Frame)*2, 
DVCPRO HD*2, DVCPRO50*2, DVCPRO*2, DV*2

Still Image Targa*1, Windows Bitmap*1, JPEG*1, TIFF*1, PNG*1, GIF*1, DPX*1, YUV 
Bitmap*1

*1	 Transcode to AVI (Grass Valley HQX) when importing.
*2	 Rewrap to MXF when importing.

NOTE •	Some codecs are able to output in one channel only.
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Format supported for conversion

Format before conversion
Format after conversion

Container Codec

Grass Valley HQX AVI or Playlist

MXF

Grass Valley HQX, XDCAM HD 422, XDCAM HD, XDCAM IMX, 
XDCAM DV, Apple ProRes 422 HQ, Apple ProRes 422,  
Apple ProRes 422 LT, Apple ProRes 422 Proxy, Avid DNxHD 220x,  
Avid DNxHD 220, Avid DNxHD 145, Avid DNxHD 100, Avid DNxHD 36

MOV
Apple ProRes 422 HQ, Apple ProRes 422, Apple ProRes 422 LT,  
Apple ProRes 422 Proxy

Other format supported by T2 AVI Grass Valley HQX

Video input and video output formats
T2 4K Elite/T2 4K Elite Plus/T2 4K Pro/T2 4K Pro Plus

Resolution Video Input Format Video Output Format

4K 4096 x 2160p (59.94p, 50p, 29.97p, 25p, 24p, 23.98p) 4096 x 2160p (59.94p, 50p, 29.97p, 25p, 24p, 23.98p)

UHD 3840 x 2160p (59.94p, 50p, 29.97p, 25p, 24p, 23.98p) 3840 x 2160p (59.94p, 50p, 29.97p, 25p, 24p, 23.98p)

HD

1920 x 1080p (59.94p, 50p, 29.97p, 25p, 24p, 23.98p),
1920 x 1080i (59.94i, 50i),
1920 x 1080PsF (24PsF, 23.98PsF)
1440 x 1080p (29.97p, 25p, 24p, 23.98p),
1440 x 1080i (59.94i, 50i),
1440 x 1080PsF (24PsF, 23.98PsF)
1280 x 720p (59.94p, 50p)

1920 x 1080p (59.94p, 50p, 29.97p, 25p, 24p, 23.98p),
1920 x 1080i (59.94i, 50i),
1920 x 1080PsF (24PsF, 23.98PsF)
1280 x 720p (59.94p, 50p)

SD
720 x 486i (59.94i),  
720 x 576i (50i)

720 x 486i (59.94i),  
720 x 576i (50i)

T2 4K Express/T2 4K Express Plus

Resolution Video Input Format Video Output Format

4K 4096 x 2160p (29.97p, 25p, 24p, 23.98p) 4096 x 2160p (29.97p, 25p, 24p, 23.98p)

UHD 3840 x 2160p (29.97p, 25p, 24p, 23.98p) 3840 x 2160p (29.97p, 25p, 24p, 23.98p)

HD

1920 x 1080p (29.97p, 25p, 24p, 23.98p),
1920 x 1080i (59.94i, 50i),
1920 x 1080PsF (24PsF, 23.98PsF)
1440 x 1080p (29.97p, 25p, 24p, 23.98p),
1440 x 1080i (59.94i, 50i),
1440 x 1080PsF (24PsF, 23.98PsF)
1280 x 720p (59.94p, 50p)

1920 x 1080p (29.97p, 25p, 24p, 23.98p),
1920 x 1080i (59.94i, 50i),
1920 x 1080PsF (24PsF, 23.98PsF)
1280 x 720p (59.94p, 50p)

SD
720 x 486i (59.94i),  
720 x 576i (50i)

720 x 486i (59.94i),  
720 x 576i (50i)
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Notes on export and growing clip editing
: Supported, : Not supported

Clip media type State

Export FTP export

Export
Growing clip 

editing on EDIUS
FTP export

Growing clip 
editing on EDIUS

Grass Valley HQX 
AVI

Recording  *3 *2 —

Finished 
recording  *3  

Grass Valley HQX 
AVI to MXF*1

Recording  *3  

Finished 
recording  *3  *4,5

Grass Valley HQX 
AVI to MOV*6

Recording    

Finished 
recording    

Grass Valley HQX 
MXF

Recording  *3  *4,5

Finished 
recording  *3  *4,5

XDCAM
Recording  *3  *4,5

Finished 
recording    *4,5

*1	 Transcode to MXF when exporting
*2	 Export starts after finishing record
*3	 Import to EDIUS bin to edit
*4	 Must be on K2 server to edit
*5	 Import to EDIUS Source Browser to edit
*6	 Transcode to MOV when exporting
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Notes on record of external device and growing clip editing
: Supported

Clip media type State
Record of external device

Record Growing clip editing on EDIUS

Grass Valley HQX AVI Recording  *1

Grass Valley HQX MXF Recording  *1

XDCAM Recording  *1

Apple ProRes MXF Recording  *1

Avid DNxHD MXF Recording  *1

*1	 Import to EDIUS bin to edit

Notes on FTP download and growing clip editing
: Supported, : Not supported

Clip media type State
Record of external device

Record Growing clip editing on EDIUS

Grass Valley HQX AVI
Recording *1 —

Finished recording  

Grass Valley HQX MXF
Recording  *2

Finished recording  *2

XDCAM
Recording  *2

Finished recording  *2

Apple ProRes MXF
Recording  *2

Finished recording  *2

Avid DNxHD MXF
Recording  *2

Finished recording  *2

*1	 Not show the list of FTP client while recording
*2	 Import to EDIUS Source Browser to edit
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Notes on Direct Access Folder and growing clip editing (T2 4K Elite/T2 4K 
Elite Plus only)

: Supported

Clip media type State Growing clip editing on EDIUS

Grass Valley HQX AVI
Recording *1

Finished recording *1

Grass Valley HQX MXF
Recording *1

Finished recording *1

XDCAM
Recording *1

Finished recording *1

Apple ProRes MXF
Recording *1

Finished recording *1

Avid DNxHD MXF
Recording *1

Finished recording *1

*1	 Import to EDIUS Bin Window to edit

NOTE •	Time-shift editing is supported by EDIUS Workgroup 8 and EDIUS Workgroup 9. It is 
not available on EDIUS Pro/Neo series and EDIUS Express.
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IO mode list
The following list shows the IO modes you can use on T2 4K Series. The available IO modes differ 
depending on the T2 model type.

TIP •	When the IO mode is switched, the assignment to the terminals on the video I/O board 
and remote interface board are also switched.
Switching IO mode►P38 
Video I/O board (Elite/Pro/Express)►P32 
Video I/O board (Elite Plus/Pro Plus/Express Plus)►P32 
Remote interface board►P33 

NOTE •	In each IO mode, the number of input or output may be restricted for some format types.

IO mode list - T2 4K Series (Elite/Pro/Express)

: Supported, : Not supported

IO mode Description
Availability by model

Elite Pro Express

[4K] 1 in 0 out This mode inputs 4K format video to the 
Recorder channel R1 (1ch). R1 (Quad SDI 1/2/3/4)

[4K] 0 in 1 out This mode outputs 4K format video to the 
Player channel P1 (1ch). P1 (Quad SDI 1/2/3/4)

[HD/SD] 1 in 2 
out

This mode inputs HD or SD format video 
to the Recorder channel R1 (1ch), and 
outputs it to the Player channels P1/P2 
(2ch).
Sync mode and Fill/Key signal output 
mode can be enabled when the 
combination of P1/P2 channels is used.

R1 (SDI 1)
P1 (SDI 3)
P2 (SDI 4)

Video monitor output (SDI 2)

[HD/SD] 0 in 3 
out

This mode outputs HD or SD format video 
to the Player channels P1/P2/P3 (3ch). Sync 
mode and Fill/Key signal output mode can 
be enabled when the combination of P1/P2 
channels is used.

P1 (SDI 2)
P2 (SDI 3)
P3 (SDI 4)

Video monitor output 
(SDI 1)


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IO mode list - T2 4K Series (Elite Plus/Pro Plus/Express Plus)

: Supported, : Not supported

IO mode Description

Availability by model

Elite Plus Pro Plus
Express 

Plus

[4K] 1 in 0 out This mode inputs 4K format video to the 
Recorder channel R1 (1ch).

R1 (Quad SDI 1/2/3/4)
Video monitor output  

(Quad SDI 5/6/7/8)

[4K] 0 in 1 out This mode outputs 4K format video to the 
Player channel P1 (1ch).

P1 (Quad SDI 5/6/7/8)
Video monitor output 

(Quad SDI 1/2/3/4)

[HD/SD] 1 in 2 
out

This mode inputs HD or SD format video 
to the Recorder channel R1 (1ch), and 
outputs it to the Player channels P1/P2 
(2ch).
Sync mode and Fill/Key signal output 
mode can be enabled when the 
combination of P1/P2 channels is used.

R1 (SDI 1)
P1 (SDI 5)
P2 (SDI 6)

Video monitor output  
(SDI 2, SDI 3, SDI 4)

[HD/SD] 0 in 3 
out

This mode outputs HD or SD format video 
to the Player channels P1/P2/P3 (3ch). Sync 
mode and Fill/Key signal output mode can 
be enabled when the combination of P1/P2 
channels is used.

P1 (SDI 5)
P2 (SDI 6)
P3 (SDI 7)

Video monitor output 
(SDI 1, SDI 2, SDI 3)


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AMP command list
The AMP commands available in T2 are listed in the following tables. The commands with gray-
colored cells in the list are not supported by T2.

NOTE •	The latency in the number of frames from the time the command such as Play or Stop is 
issued to the time the operation actually starts is not fixed. The video loaded on multiple 
T2 cannot be synchronized in the accurate frames by AMP commands.

Device management

Command
Channel-

less mode
Recorder Player

Sync 
mode

Fill/Key 
signal 
output 
mode

Supplementary note on T2 
operation

01.06 Set Drop 
Frame Mode     

[DF mode:] setting that is in 
[Miscellaneous] of [General] 
in the setting screen will be 
changed.
Since [DF mode:] is a common 
setting for R1/P1/P2, the 
setting change will be applied 
to the other channels.

00.0C Local Disable No    
Enabling and disabling of 
local control or remote control 
can be set for each channel.

0X.1D Local Enable No    
Enabling and disabling of 
local control or remote control 
can be set for each channel.

00.11 Device Type 
Request     

0x20 and 0x50 are returned 
corresponding to the device 
category and the model 
number, respectively.

20.04 Standby Off No No No No No

20.05 Standby On No No No No No

20.60 EE Off No No  No No

20.61 EE On No No  No No

21.62 Set Mute 
Mode No No   

It takes several seconds from 
the time the command has 
been issued until the time the 
setting is applied.
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Command
Channel-

less mode
Recorder Player

Sync 
mode

Fill/Key 
signal 
output 
mode

Supplementary note on T2 
operation

A8.20 Set Device ID     

A0.21 Device ID 
Request     

A0.2C Device Name 
Request     

Transport controls

Command
Channel-

less mode
Recorder Player

Sync 
mode

Fill/Key 
signal 
output 
mode

Supplementary note on T2 
operation

2X.00 Stop No    

Specifying the timecode value 
on the command execution 
(event schedule) is not 
supported.

2X.01 Play No No   

Specifying the timecode value 
on the command execution 
(event schedule) is not 
supported.

2X.02 Record No  No No No

Specifying the timecode value 
on the command execution 
(event schedule) is supported 
only when the input type is 
LTC or VITC (SDI).

20.0F Eject No    

20.10 Fast Forward No No  No No Plays back the video in 32 
times the normal play speed.

2X.11 Jog Forward No No  No No*1

2X.12 Variable 
Forward No No  No No*1

2X.13 Shuttle 
Forward No No  No No*1
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Command
Channel-

less mode
Recorder Player

Sync 
mode

Fill/Key 
signal 
output 
mode

Supplementary note on T2 
operation

20.20 Rewind No No  No No
Plays back in reverse the 
video in 32 times the normal 
play speed.

2X.21 Jog Reverse No No  No No*1

2X.22 Variable 
Reverse No No  No No*1

2X.23 Shuttle 
Reverse No No  No No*1

2X.31 Cue Up With 
Data No No   

A pseudo clip “<BLACK>” is 
not supported.

20.52 Tension 
Release No No No No No

44.05 User Bits 
Preset No No No No No Not supported on T2.

40.20 In Reset No No   

41.36 Timecode 
Mode Preset No  No No No

For the Recorder channel, the 
setting will be applied on the 
timecode that is saved when 
video is recorded.
For LTC, the timecode of TC 
input is recorded, and for 
VITC, the timecode of SDI 
input is recorded.

40.40 Auto Mode 
Off No No   

40.41 Auto Mode 
On No No   

41.42
Set Loop 
Playback 
Mode

No No   

If you want to change 
the setting during the 
playback, send the command 
approximately four or more 
seconds before it comes to the 
position to set loop.
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Command
Channel-

less mode
Recorder Player

Sync 
mode

Fill/Key 
signal 
output 
mode

Supplementary note on T2 
operation

41.43
Set 
Widescreen 
Mode

No  No No No

41.44 Set Stop 
Mode No No   

If you want to change 
the setting during the 
playback, send the command 
approximately four or more 
seconds before it comes to the 
position to set stop.

40.45 Get Stop 
Mode No No   

60.0B
State Change 
Latency 
Request

No No No No No Not supported on T2.

61.0C Current Time 
Sense     

Since obtaining User Bits is 
not supported, 00000000 will 
always be returned.
The response is always the 
same value regardless of the 
type of LTC or VITC.
If LTC source or VITC source 
has been specified, Recorder 
input timecode is returned.
Only 1:LTC, 4:Timer, 
8:WindowsTime, and 40:LTC 
(Src) (Recorder LTC input) are 
supported.

61.20
Status Sense*2

    

AX.02
Record Cue 
Up With 
Data

No  No No No Only specifying the clip name 
is available.

*1	 Operates only when the specified speed is 0 (Stop).
*2	 Supported status flag

Data0 Busy, Remote+Local/ Local

Data1 Play, Record, FFW, REW, Stop
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Data2 Still, TapeDirection, Var, Shuttle

Data3 InPreset, OutPreset, AutoMode, FolderalreadyExist, 
InvalidFolderName, FolderDeletionFail, SourceMissing

Data4 EEOn, LoopPlayBack

Data9 FolderNotFound, OutPresetFail, PreviewInPreset, PreviewOutPreset

DataA IDNotFound, MovieDeleteComplete, MovieDeleteFail

DataD TapeTop, TapeEnd, LTC, Timer, VITC, TimeOfDay, DropFrame

Managing clips on the timeline

Command
Channel-

less mode
Recorder Player

Sync 
mode

Fill/Key 
signal 
output 
mode

Supplementary note on T2 
operation

4X.14 In Preset No No   
A pseudo clip “<BLACK>” is 
not supported.

4X.15 Out Preset No No   

If you want to set an Out 
point during the playback, 
send the command 
approximately four or more 
seconds before it comes to the 
position to set the Out point.

4F.16 Append 
Preset No No   

If you want to execute 
the command during the 
playback, send the command 
approximately four or more 
seconds before it comes to the 
end point of Preset Timeline.

4X.21 Out Reset No No   

If you want to set an Out 
point during the playback, 
send the command 
approximately four or more 
seconds before it comes to the 
position to set the Out point.

A0.06 Preview In 
Reset No No   
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Command
Channel-

less mode
Recorder Player

Sync 
mode

Fill/Key 
signal 
output 
mode

Supplementary note on T2 
operation

AX.07 Preview Out 
Reset No No   

If you want to set an Out 
point during the playback, 
send the command 
approximately four or more 
seconds before it comes to the 
position to set the Out point.

44.31 Pre-roll No No No No No Not supported on T2.

AX.04 Preview In 
Preset No No   

If you want to execute 
the command during the 
playback, send the command 
approximately four or more 
seconds before it comes to the 
end point of Preset Timeline.
A pseudo clip “<BLACK>” is 
not supported.

AX.05 Preview Out 
Preset No No   

If you want to set an Out 
point during the playback, 
send the command 
approximately four or more 
seconds before it comes to the 
position to set the Out point.

AF.0A
Append 
Preview 
Preset

No No   

If you want to execute 
the command during the 
playback, send the command 
approximately four or more 
seconds before it comes to the 
end point of Preset Timeline.

A1.32 Set Ganging No No   No

Only switching on/off of sync 
mode by Instant Ganging is 
available on T2. (P1 only)
Send Data 1:
0 Sync Off
6 Sync On (Channel 2 (bit 1) 
and Channel 3 (bit 2) ganged)

A0.33 Get Ganging No No   No

AX.34 Set Ganging 
Information No No No No No Not supported on T2.
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Command
Channel-

less mode
Recorder Player

Sync 
mode

Fill/Key 
signal 
output 
mode

Supplementary note on T2 
operation

A0.35 Get Ganging 
Information No No No No No Not supported on T2.

AX.11 Erase 
Segment No No No No No Not supported on T2.

A0.16 ID Loaded 
Request No    

AX.01 Auto Skip No No   

Managing stored clips

Command
Channel-

less mode
Recorder Player

Sync 
mode

Fill/Key 
signal 
output 
mode

Supplementary note on T2 
operation

A0.26 ID Count 
Request     

AX.14 List First ID     

AX.15 List Next ID     

AX.18 ID Status 
Request     

A2.0E
Set Working 
Folder 
Request

    

A0.0F
Get Working 
Folder 
Request

    

A0.12 IDs Changed 
List Request     

In and Out points are 
changed simultaneously, and 
you can not recognize which 
point has been changed.

AX.10 Erase ID     

A0.2A List First 
Folder     
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Command
Channel-

less mode
Recorder Player

Sync 
mode

Fill/Key 
signal 
output 
mode

Supplementary note on T2 
operation

A0.2B List Next 
Folder     

AX.1C

Total/
Available 
Storage 
Request

    

A4.1D Set Record 
Duration No  No No No

Recording duration cannot be 
changed during the recording 
operation.

A2.31 Create Folder     

A2.28 Rename 
Folder     

A2.29 Delete Folder     

A2.25 ID Start Time 
Request     

A2.17 ID Duration 
Request     

AE.30 Replace Edit No No No No No Not supported on T2.

AX.2D Stripe 
Timecode     

In the properties for the 
clip and playlist, [Replace 
timecode media:] will be set 
to [Specify Start Time].

AX.2E Set Mark In     
This setting cannot be applied 
to playlists.

AX.2F Set Mark Out     

If you want to set an Out 
point during the playback, 
send the command 
approximately four or more 
seconds before it comes to the 
position to set the Out point.
This setting cannot be applied 
to playlists.
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Command
Channel-

less mode
Recorder Player

Sync 
mode

Fill/Key 
signal 
output 
mode

Supplementary note on T2 
operation

AX.1A

Get Aspect 
Ratio 
Conversion 
Override

No No No No No Not supported on T2.

A2.1B

Set Aspect 
Ratio 
Conversion 
Override

No No No No No Not supported on T2.

AE.1E Set Audio 
Gain     

It takes several seconds from 
the time the command has 
been issued until the time the 
setting is applied on a loaded 
clip.

AA.1F Get Audio 
Gain     

C0.28 Abort 
Transfer ID     

CX.27
Transfer 
ID Status 
Request

    

This setting will be applied 
only on the transfer that 
has started when Extended 
Transfer ID command is 
issued. (Not applied to the 
transfer that has started in the 
workstation mode/front panel 
mode of T2.)
type 2 (data containing 
number of bytes transferred), 
3 (data containing number 
of fields transferred) are not 
supported.

C2.26 Transfer ID No No No No No Not supported on T2.
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Command
Channel-

less mode
Recorder Player

Sync 
mode

Fill/Key 
signal 
output 
mode

Supplementary note on T2 
operation

C2.25 Extended 
Transfer ID     

Setting of In and Out points is 
only supported for FFFFFFFF. 
(The range for the transfer 
cannot be set.)
The setting for the transfer type 
will be disabled. The transfer 
type follows the settings in 
[Transfer] -> [AVI] or [Playlist] 
on the setting screen.

The recommended transfer 
type is 0x03 (Profile), which 
is described in “K2_Protocol_
developers_Guide” as a sample of 
transfer via Grass Valley server.
Set the clip/playlist name for 
the transfer source of export.

Set the transfer destination as 
follows.
•	Network Drive:localhost/[n]:/

[dir]/[file name] 
For “n”, specify the network 
drive allocated by [General] -> 
[Network-3] on the setting screen 
or the drive connected via USB.
Example)localhost/z:/Export/Clip1
•	FTP server:[address]/v:/[bin 

name]/[file name] 
For address, specify the 
address registered in [Hose 
Name/IP Address] in [FTP 
Export List] of [General] -> 
[FTP] on the setting screen.
Example)169.254.138.3/v:/
Default/Clip1
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Command
Channel-

less mode
Recorder Player

Sync 
mode

Fill/Key 
signal 
output 
mode

Supplementary note on T2 
operation

C2.25 Extended 
Transfer ID     

Set the transfer source of 
import as follows.
•	[n]:/[dir]/[file name] 

For “n”, specify the network 
drive allocated by [General] 
-> [Network-3] or the drive 
connected via USB.

Set the transfer destination as 
follows.
V:/[bin name]/[clip name]

C2.29 Network 
Delete No No No No No Not supported on T2.

AX.19 New Copy     

Deep copy is not supported.
Setting In and Out points to 
playlists is not available.
Only Shallow and Move  are 
supported.

AX.22 Get Audio 
Track Labels No No No No No Not supported on T2.

AX.23 Set Audio 
Track Labels No No No No No Not supported on T2.

A0.36 Get Audio 
Input Tags No No No No No Not supported on T2.

AA.37 Set Audio 
Input Tags No No No No No Not supported on T2.

A0.38 Get Audio 
Output Tags No No No No No Not supported on T2.

AA.39 Set Audio 
Output Tags No No No No No Not supported on T2.

A2.3A Get AFD 
Setting No No No No No Not supported on T2.

A2.3B Set AFD 
Setting No No No No No Not supported on T2.
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Clip data information

Command
Channel-

less mode
Recorder Player

Sync 
mode

Fill/Key 
signal 
output 
mode

Supplementary note on T2 
operation

AA.08 Set Clip Data No No No No No Not supported on T2.

AA.13 Clip Data 
Request     

If Send Data 1 is 'C', 
Compression Type and Video 
Format are not supported.
If Send Data 1 is 'E', this 
setting is not available.

A2.09 Get 
Thumbnail     

A JPEG data with the size of 
160 x 90 will be returned.
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Flags Command Availability Note

Status byte 4
bit0: Preroll 

bit1: Event Schedule Failed 

bit2: —
bit3: —
bit4: Mute 

bit5: Loop Playback Mode 

bit6: EE On 

bit7: —
Status byte 9

bit0: Preview In Preset 

bit1: Preview Out Preset 

bit2: Folder Not Found 

bit3: Disk Overflow 

bit4: Metadata Not Found No
bit5: Clips Dropped 

bit6: Out Preset Failed 

bit7:
Overwrite Clip 
Name



Status byte A
bit0: ID Not Found 

bit1: Timecode Not Found 

bit2: Transfer ID Complete 

bit3:
Transfer ID Abort 
Complete



bit4: Movie Delete Complete 

bit5: Transfer ID Failed 

bit6:
Transfer ID Abort 
Failed



bit7: movie Delete Failed 

Status byte D
bit0: Time Of Day 

bit1: Widescreen Mode 

bit2: Drop Frame 

bit3: VITC 

bit4: Timer 

bit5: LTC 

bit6: Tape End 

bit7: Tape Top 

Flags

Flags Command Availability Note

Status byte 0
bit0: Local 

bit1: Remote+Local 

bit2: Hard Error 

bit3: General Error 

bit4: —
bit5: Cassette Out  Always 0
bit6: —
bit7: Busy 

Status byte 1
bit0: Play 

bit1: Record 

bit2: Fast Forward 

bit3: Rewind 

bit4: Eject  Always 0
bit5: Stop 

bit6: Tension Release  Always 0
bit7: Standby On  Always 1

Status byte 2
bit0: Cue Complete 

bit1: Still 

bit2: Direction 

bit3: Variable Play 

bit4: Jog 

bit5: Shuttle 

bit6: —
bit7: Servo Lock 

Status byte 3
bit0: In Preset 

bit1: Out Preset 

bit2:
Specified Folder 
Exist



bit3:
Invalid Folder 
Name



bit4:
Folder Deletion 
Failed



bit5: Jog Reject 

bit6: Source Missing 

bit7: Auto Mode 
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BVW command list
The BVW commands available when controlling an external controller from T2 in the Recorder-VTR 
mode are listed in the following tables.
The commands with the “” mark are available on the optional action as DEVICE, and if mentioned 
in the RETURN column, RETURN + DATA is returned, and if not mentioned, 10 01 ACK is returned.
The commands with the “” mark return ACK or return RETURN as STATUS, but the action will 
not be performed.

Command RETURN

00 11 DEVICE TYPE REQUEST 12 11 DEVICE TYPE RETURN 

20 00 STOP 

20 01 PLAY 

20 02 RECORD 

20 04 STANDBY OFF 

20 05 STANDBY ON 

20 10 FAST FWD 

2X 11 JOG FWD 

2X 12 VAR FWD 

2X 13 SHUTTLE FWD 

2X 20 REWIND 

2X 21 JOG REV 

2X 22 VAR REV 

2X 23 SHUTTLE REV 

24 31 CUE UP WITH DATA 

20 54 ANTI-CLOG TIMER DISABLE 

20 55 ANTI-CLOG TIMER ENABLE 

44 00 TIMER-1 PRESET 

40 08 TIMER-1 RESET 

41 36 TIMER MODE SELECT 

61 0C CURRENT TIME SENSE

74 00 TIMER-1 DATA 

74 04 LTC TIME DATA 

78 04 LTC TIME & UB DATA 

74 05 LTC UB DATA 

74 06 VITC TIME DATA 

78 06 VITC TIME & UB DATA 

74 07 VITC UB DATA 

70 0D REQUEST TIME MISSING 

61 20 STATUS SENSE 7X 20 STATUS DATA 

60 2E COMMAND SPEED SENSE 71 2E COMMAND SPEED DATA 

60 36 TIMER MODE SENSE 71 36 TIMER MODE DATA 

*	 Start Delay value = 10 (*16 hexadecimal)
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BVW list supporting remote mode
The BVW commands available when controlling T2 from an external controller in the Recorder-
remote mode and Player-remote mode are listed in the following table.

: Supported, : Not all supported, : Not supported

Command R1 Px

DEVICE TYPE REQUEST  

STOP  

PLAY, SYNC PLAY  

RECORD  

STANDBY OFF  

STANDBY ON  

FAST FWD  

JOG FWD  

VAR FWD  

SHUTTLE FWD  

REWIND  

JOG REV  

VAR REV  

SHUTTLE REV  

CUE UP WITH DATA  

ANTI-CLOG TIMER DISABLE  

ANTI-CLOG TIMER ENABLE  

TIMER-1 PRESET  

TIMER-1 RESET  

TIMER MODE SELECT  

CURRENT TIME SENSE *1 

TIMER-1 DATA  

LTC TIME DATA  

LTC TIME & UB DATA  

LTC UB DATA  

VITC TIME DATA  

VITC TIME & UB DATA  

VITC UB DATA  

REQUEST TIME MISSING  

STATUS SENSE  

COMMAND SPEED SENSE  

TIMER MODE SENSE  

REC  

*1	 If you query the timecode, Recorder returns the timecode currently being input. For CURRENT 
TIME SENSE, the type of timecode to query can be specified (LTC/VITC). Whichever is 
specified, the timecode type set in T2 (the timecode type selected in [Select Timecode] in [R1] -> 
[Timecode & Remote] on the setting screen) is returned.
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RS422 input/output pin
RS422 input/output pins are as follows.

5 1

9 6

R1 (Recorder-VTR mode)
D-Sub 9pin

R1/Px (remote mode)
D-Sub 9pin

Pin Signal Pin Signal
1 GND 1 GND
2 RECEIVE− 2 TRANSMIT−
3 TRANSMIT+ 3 RECEIVE+
4 GND 4 GND
5 NC 5 NC
6 GND 6 GND
7 RECEIVE+ 7 TRANSMIT+
8 TRANSMIT− 8 RECEIVE−
9 GND 9 GND

GPIO input/output pin
GPIO input/output pins are as follows.

14 25

1 13

Pin Signal Pin Signal
1 NC 14 NC
2 NC 15 GND
3 Output 1 16 Input 1
4 Output 2 17 Input 2
5 Output 3 18 Input 3
6 Output 4 19 Input 4
7 Output 5 20 Input 5
8 Output 6 21 Input 6
9 Output 7 22 Input 7
10 Output 8 23 Input 8
11 GND 24 NC
12 NC 25 NC
13 NC Frame GND

NOTE •	Only GPI Output 1 to 8 and Input 1 to 8 are available on T2. The pins for which “NC” is 
indicated in the “Signal” column are not used.
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